Reference Guide

Special notice
Before using this information and the product it supports, read the information in Notices on page 310.

Chapter 1. Reference Guide
This guide describes, additional topics to gain more knowledge about Rational® Performance Tester.

Accessibility features
Users who have a physical disability, such as limited vision, can review the available accessibility features
to use their information technology products successfully.
Accessibility features are product dependent and might include one or more of the following aspects:
• Keyboard-only operation
• Screen reader usage
• Color and typeface preferences
Note: The accessibility features mentioned here apply to the Windows operating system. Some of
these features might also work on Linux, but are not officially supported.

Keyboard shortcuts for performance and service testing
The keyboard shortcuts for performance and service testing are available when you record or edit a test
or a schedule.
Key combination

Description

Ctrl+S

Save the test or schedule.

Alt+Shift+T, G

Generate a test from the selected recording (.recmodel) file.

Alt+Shift+T, R

Create a report (the test must be selected in the Test Navigator).

Alt+Shift+T, T

Test connection (a location must be selected in the Test Naviga
tor).

Alt+Shift+X, B

Run the test (a test must be selected in the Test Navigator).

Alt+Shift+X, C

Run the schedule (a schedule must be selected in the Test Naviga
tor).

Del

Delete the selection

Ctrl+Del

Delete the selection
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Key combination

Description

Insert

Insert a new element (same as the Insert push button).

Ctrl+Insert

Add a new element (same as the Add push button).

Ctrl+Up Arrow

Move the element up.

Ctrl+Down Arrow

Move the element down.

Ctrl+Alt+<, Ctrl+Alt+>

Resize the test editor and schedule editor windows. The new size
is retained when you reopen the window.

Ctrl+Shift+F1

During HTTP recording, insert a comment.

Ctrl+Shift+F2

During HTTP recording, insert a screen capture.

Ctrl+Shift+F3

During HTTP recording, insert a synchronization point.

Ctrl+Shift+F4

During HTTP recording, start a transaction.

Ctrl+Shift+F5

During HTTP recording, end a transaction.

Ctrl+Shift+F6

During HTTP recording, insert a split point.

Ctrl+Shift+F7

During HTTP recording, set the name of the current page.

The following keyboard shortcuts are available when you record Citrix performance tests:
Key combination

Description

Tab or Shift+Tab

Cycle the focus through the UI elements

Arrows

Select a push button

Space

Click a push button or toggle between selections

When you record Citrix performance tests and you work in image synchronization mode, you can use
these keys:
Key

Description

Space

Set the origin of selection area

Arrows

Move the cursor

Enter

Select the image synchronization area and set
the synchronization area (press twice)

Esc
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General reference for performance testing
See these performance testing topics for general reference.

Data correlation rules
You can customize how data is correlated by using data correlation rules.

Rules that create elements
Create a built in data source
Inserts a built-in data source in the test.
Create a custom code
Inserts a custom code element in the test.
Create a dataset column
Creates a dataset column that can be used by substitution sites.
Create a reference
Creates a reference in data that matches a specified regular expression.
Create a substitution
Creates a substitution site in data that matches a specified regular expression.
Create a variable assignment
Inserts a variable assignment in the test.
Create a variable declaration
Creates a variable that can be used by substitution sites.

Rules that change elements
Encode a substitution
Specifies whether substitution fields are encoded or decoded.
Rename a data source site
Changes the name of a data source that matches a regular expression.
Rename a substitution site
Changes the name of a substitution site that matches a regular expression.
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Replace reference regular expression
Changes the regular expressions that are used by references.
Unlink a substitution
Removes the links between substitution sites and references and other data sources.

Rules that find elements
Find a reference
Returns a reference. Add child conditions to specify the reference to find.
Find a substitution
Returns a substitution site. Add child conditions to specify the substitution site to find.
Find a variable
Returns a variable. Add child conditions to specify the variable to find.

Rules that remove elements
Remove a built in data source
Deletes data sources from the test. Add child conditions to specify the data sources to
delete. If you do not add child conditions, this rule deletes all data sources in the test.
Remove a custom code
Deletes custom code elements from the test. Add child conditions to specify the custom
code elements to delete. If you do not add child conditions, this rule deletes all custom code
elements in the test.
Remove a reference
Deletes references from the test. Add child conditions to specify the references to delete. If
you do not add child conditions, this rule deletes all references in the test.
Remove a substitution
Deletes substitution sites from the test. Add child conditions to specify the substitution
sites to delete. If you do not add child conditions, this rule deletes all substitution sites in the
test.
Remove a variable assignment
Deletes variable assignments from the test. Add child conditions to specify the variable
assignments to delete. If you do not add child conditions, this rule deletes all variable
assignments in the test.
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Remove a variable declaration
Deletes variables from the test. Add child conditions to specify the variables to delete. If you
do not add child conditions, this rule deletes all variables in the test.

Error conditions
Error conditions include verification point failures, connection failures, server timeouts, custom code
alerts, custom code exceptions, and problems with data correlation. You can specify an action to take
when the error condition occurs. The Errors report displays the error conditions and error behavior that
occurred in a test or schedule.

Page Title Verification Point Failure [HTTP]
The returned title for the primary request for an HTTP page does not match the expected title. The default
value of the expected page title is what is returned between the <title></title> tags during recording. See
Specifying the expected page title on page

for more information.

Response Code Verification Failure [HTTP]
The returned response code does not match the expected response code. You can specify an exact
match or a relaxed match. See Specifying the expected response code on page

for more

information.

Response Size Verification Failure [HTTP]
The number of bytes returned does not match the expected number of bytes. You can control how
closely the returned response size must match the recorded response size. See Specifying the expected
response size on page

for more information.

Content Verification Point Failure
The received data does not match the expected data. Content verification point controls are protocolspecific.

Connection Failure
The workbench or agent computers cannot connect to the server under test.

Authentication Failure
An attempt to log in to the server under test failed.

End of Dataset reached
The last row of the dataset is reached. See Dataset overview on page

for more information.
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Reference Extraction Failure
The response received during playback is different from the response received when the test was
recorded. Data correlation failed because the regular expression that is associated with the reference did
not match the expected value.

Substitution Failure
A reference for an expected data substitution is a null reference.

Server Timeout
The server under test does not respond before the timeout interval elapses.

Custom Verification Point Failure
A custom verification point did not return a Pass status after performing a verification written in Java™
code. See Reporting custom verification point failures on page

for more information.

Custom Code Alert
Custom code reported an RPTCondition.CustomCodeAlert condition. The following code reports a
custom code alert:
tes.getTestLogManager().reportErrorCondition(RPTCondition.CustomCodeAlert);

See the ITestLogManager Javadoc for more information.
The Javadoc for the test execution services interfaces and classes can be accessed from the product by
clicking Help > Help Contents > IBM® Rational® Performance Tester API Reference.

Custom Code Exception
The custom code in a test has an exception. By default, Rational® Performance Tester exits the user
whenever there is an exception in custom code. For information on setting different actions, see Errorhandling behavior on page

Related information
Specifying error-handling behavior on page

Resource monitoring data sources
Resource monitoring data can be captured or imported from a number of sources.
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IBM® Tivoli® Monitoring
IBM Tivoli® Monitoring monitors and manages system and network applications on a variety of platforms
and keeps track of the availability and performance of all parts of your enterprise network. IBM® Tivoli®
Monitoring provides reports that you can use to track trends and troubleshoot problems.
Not all IBM® Tivoli® Monitoring agents are supported. Over 100 IBM® Tivoli® Monitoring agents are
available from IBM® and non-IBM vendors. The following IBM® Tivoli® Monitoring agents are supported
for resource monitoring data collection:
• Operating system agents
◦ Monitoring Agent for Linux™ OS
◦ Monitoring Agent for UNIX™ OS
◦ Monitoring Agent for Windows™ OS
◦ Monitoring Agent for z/OS®
• Application agents
◦ Monitoring Agent for Citrix
◦ Monitoring Agent for IBM® DB2®
◦ Monitoring Agent for IBM® Tivoli® Composite Application Manager for WebSphere®
◦ Monitoring Agent for IBM® WebSphere® Application Server
◦ Monitoring Agent for IBM® WebSphere® MQ
◦ Monitoring Agent for Oracle Database
◦ Monitoring Agent for SNMP-MIB2 (only)

IBM® DB2® Monitoring
IBM DB2® collects information from the database manager, its databases, and any connected
applications. The snapshot monitor captures the state of database activity at a particular point in time.

IBM® WebSphere® Performance Monitoring Infrastructure
IBM WebSphere® Application Server collects performance data and provides interfaces so that
external applications can monitor that performance data. To help identify performance problems
and help tune an environment that runs web applications, data is collected through the Performance
Monitoring Infrastructure (PMI). The Performance Monitoring Infrastructure is the underlying framework
in WebSphere® Application Server that gathers performance data from various runtime resources, such
as Java™ Virtual Machine (JVM) and Thread Pools, and application components, such as servlets and
Enterprise JavaBeans™ (EJB) components.

9

Reference Guide

Java™ Management Extensions
Java Management Extensions (JMX) can monitor performance characteristics of application servers
and applications that are run on application servers. The following application servers support JMX
monitoring:
• Apache HTTP Server
• Apache Tomcat
• JBoss Application Server
• Oracle WebLogic Server
• SAP NetWeaver
Java™ Virtual Machines also support JMX monitoring.

Oracle Database Metrics
Oracle Database collects metrics that are related to database health and workload.

UNIX™ rstatd
With the rstatd daemon, users can collect performance statistics remotely from networked UNIX™ (or
Linux™) computers. The rstatd daemon collects statistics that are related to network, virtual memory,
interrupt, disk, and processor usage.

Simple Network Management Protocol (SNMP) agents
The Simple Network Management Protocol (SNMP) is typically used to monitor network health,
performance, and hardware. SNMP agents are software components that are installed on managed
devices and collect management information.

Windows™ Performance Monitor
Windows Performance Monitor (PerfMon) collects data from performance objects. The Microsoft™
Windows™ operating system provides performance objects for the major hardware components: memory,
processors, and so on. Each performance object provides specific performance counters. For example,
the Memory object provides a Pages/sec counter that tracks the rate of memory paging. Other programs
on the computer, including Internet Information Services (IIS) and Microsoft™ SQL Server, can install their
own performance objects. For example, a mail server program might install a mail performance object.
The specific counters depend on the version of the Windows™ operating system and on the additional
programs that are installed on the computer.
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Related information
Viewing resource monitoring data - Legacy Reports on page
Adding Microsoft Windows Performance Monitor sources on page
Adding IBM WebSphere Performance Monitoring Infrastructure sources on page
Adding UNIX rstatd sources on page
Adding IBM Tivoli Monitoring sources on page

Response time breakdown data sources
Response time breakdown data can be imported from a number of sources.

IBM® Tivoli® Composite Application Manager for Application Diagnostics
IBM Tivoli® Composite Application Manager for Application Diagnostics enables users to view the
health of web applications and servers, then drill down to diagnostic information for specific application
requests to identify the root cause of problems.

IBM® Tivoli® Composite Application Manager for Response Time Tracking
IBM Tivoli® Composite Application Manager for Response Time Tracking measures the level of service
that the application delivers to users. It does this by monitoring the availability and response time
that users experience at the client desktop. It works with a wide range of web-based, e-business, and
Microsoft™ Windows™ applications that run in many different environments.

IBM® Tivoli® Composite Application Manager for WebSphere®
IBM Tivoli® Composite Application Manager for WebSphere® provides immediate problem
determination, availability monitoring, and performance analysis for enterprise WebSphere® applications
running on Windows™, UNIX™, OS/400®, and z/OS® environments. IBM® Tivoli® Composite Application
Manager for WebSphere® monitors heterogeneous environments consisting of both mainframes and
distributed systems.

IBM® Tivoli® Monitoring for Transaction Performance
IBM Tivoli® Monitoring for Transaction Performance is a centrally managed suite of software
components that monitor the availability and performance of web-based services and Windows™
applications.
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Related information
IBM Tivoli Composite Application Manager for Applications

Reports and counters
See the description of the counters for all of the performance reports.

Requirements report
From version 9.2.0.1, the Performance Requirements report is renamed to Requirements report. The
Requirements report validates the performance and functional requirements that you set in a test or in a
schedule.
Validation is accomplished by comparing the data in the run to the requirements that you set on the data.

Status Summary page
With the Status Summary page, you can quickly analyze the requirements that are defined in a test result.
The page contains two tables.
• The first table provides the overall status of the run and the percentage of performance
requirements that passed.
• The second table lists all of the standard requirements that you defined.
Each requirement has a row in the table that explains the target of the performance requirement (for
example, an HTTP page), specification, and status.

Overall Summary page
The Overall Summary page provides a high-level, graphical analysis of requirements, both standard and
supplemental. The Overall Summary page contains two tables and two pie charts.
The first table presents the pass/fail status and percentage pass data for requirements and supplemental
requirements.
Both requirements and supplemental requirements are represented in the center of the report by a pie
chart. In both cases, failures are shown in red and passes are shown in green.
The final graphic on this page presents numeric details for each requirement type and for the union of
both types.
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Details page
The Details page provides a detailed analysis of standard requirements. It contains two tables and a bar
chart.
As with the Status Summary page, the overall status of the run and percent passed value for the run are
presented in a table at the top of the page. The bar chart at the center of the report displays the margin of
each performance requirement. The margin is a percentage value that allows improvement or regression
analysis with regards to a requirement. When a performance requirement is in the passed state, it will
have a margin >= 0. The margin is calculated as follows:
% Margin = abs(specification – observed)/specification
When a performance requirement is in the “failed�? state, it will have a value <=0. The margin is
calculated as follows:
% Margin = –abs(specification – observed)/specification
Margins are useful in comparison mode because you can detect improvement or regressions before they
are significant enough to change the requirement from pass to fail. The table at the bottom of the Details
page contains a representative row for each performance requirement. Each requirement is presented
with an explanation of its target, observed result, specification, margin, and status. Passed statuses are
shown in green and failed statuses are shown in red.

Supplemental Details page
The Supplemental Details page shows a detailed analysis of supplemental requirements. It contains the
same data as the Details page, except that it pertains to supplemental requirements.

Synchronization Point report
This report provides information about the synchronization points in test runs and lets you manually
release a user from a synchronization point. To release a user, right-click in the report and select Manage
Synchronization Points.
The Synchronization Point report contains the following information for each synchronization point in the
run:
• The name of the synchronization point.
• Time-out Value. The time after which the synchronization point is automatically released. A value
of 0 means that the synchronization point will be released after the arrival of the first user.
• Users Late. The number of virtual users that have arrived "late"; that is, after the synchronization
point was released.
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• Users Arrived. The number of virtual users that have arrived at the synchronization point.
• Current® State. The state of the synchronization point. The state can be:
◦ Inactive. No users have arrived or all locations are inactive.
◦ Active. At least one user has arrived.
◦ Released. All users have arrived, been release manually, or have timed out.
• Users Expected. The number of virtual users still expected to arrive.
• Run Duration. The time between the first user's arrival and the first user's release. The count begins
as soon as any location reports an Active state, and stops as soon as any location reports a
released state. The accuracy of the time might be adversely affected by a large statistics interval.

Loops report
This report summarizes the functionality of loops in a test.

Loop Invocation Details
This tab displays the number of times the loop was invoked in a test and loops that were invoked but did
not complete.

Loop Iteration Details
This tab displays how many iterations does each loop run and how many iterations in a loop were
successful.

Loop Iteration Health
This tab displays the health of each iteration of a loop. You can also view the error that cause the failure
of an iteration of a loop.

Agents Health Report
With the Agents Health Report, you can view the usage data of CPU, Memory, Threads, and JVM Heap
for the agent machines involved in the run. The report shows usage data for the Agent Host and Agent
Process on the agent machines. By default, the Enable Agent Health Report check box at Window >
Preferences > Test > Test Execution is selected. Also, by default, the report opens in the Compare mode.
You cannot disable the compare mode.

Report
CPU
The CPU usage graph shows the usage data for the Agent Host and Agent processes.
Note that the SAP, SOA, and Rational® Integration Tester test extensions runs as external
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processes on the agent locations and therefore are not counted in the Agent process but are
counted in the Agent Host with all others system processes (including the agent).
Memory
The Memory usage graph shows the memory consumed by the Agent processes in terms
of average and percentage and by the Agent Host. The average memory consumption of the
agent is usually very little. Therefore, the graph also displays the memory consumption in
terms of percentage. If the CPU and Memory consumption for the agents is high, you can
decide to add more locations to the execution of the performance tests.
JVM Heap
The JVM Heap graph shows the percentage of memory used compared to the total memory
allocated and the total JVM memory allocated. If the memory used is high, you can decide
to increase the JVM Heap size by adding the -Xmx property to the agent location.
Threads
Threads Usage graph shows the percentage of threads used for the currently running tasks
compared to the maximum of threads that the tool can create. It also shows the number of
tasks waiting for the threads to be made available to execute them.

Rate Runner report
You can use the Rate Runner report to view how all the Rate Runner groups in the Rate Schedule have
performed during the run.

Rate Runners
The Rate Runners page displays the graph with X-axis showing the time and Y-axis showing the rate or
workload generated per second. The top section of the report displays the following fields:
State: Status of the run for rate generators. One of the following statuses is displayed:
• Not started
• Arriving: At least one user has arrived at the synchronization point.
• Active: At least one iteration of workload.
• Inactive: No users or clients are running.
Users or Clients: Number of users or clients in the Arriving or Active state.
Target Rate: Number of iterations specified in Rate Generator or Rate Schedule. The report shows the
value in seconds. For example, if the iteration rate is 2 every minute, the Target Rate would show 0.032
per second.
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Workloads Started - First time: Time taken for the first workload to start after the test run. The time taken
includes the time to create the users or clients, begin the workload, meet at the rate synchronization point,
run any iteration delay, and then start the workload.
Workloads Started - Elapsed time: Time taken for the first workload to start and the last workload to end.
Workloads Started: Number of workloads already started at any given point of time during the run. For
example, for a target rate of 4 every minute, at the end of one minute, the number of workloads started
should be 4. However, it should increment throughout the run based on the target rate. So, at a target rate
of 4 every minute and a total duration of 10 minutes, the number of workloads at the end of the run should
show Workloads Started = 40 and Workloads Completed = 40.
Workloads Started - Rate: Actual rate achieved for the run. Compare it with the Target Rate to determine
the performance of the application.
Percent Target: Comparison of the Target Rate with the Actual Rate (Workloads Started - Rate) to indicate
by percentage how close the workload is to reach the specified target rate.
Percent Late - Percent: The percent of workloads in a user group or Rate Runner group that did not begin
to run at the specified time.

Health
Use this page to view the number of workloads that did not meet the target rate.

Throughput
Use this page to view the number of workloads that passed successfully.

Transaction report
This report summarizes the success of transactions in the run, plots on a graph the response trend of
each transaction during a specific sample interval, and shows the transaction throughput.
This report plots the sample intervals within a run. You set the Statistics sample interval value in the
schedule, as a schedule property.

Overall page
The Overall Transaction Rate graph shows the average elapsed time for all transactions during a specific
sample interval. Elapsed time is the actual time spent within the transaction container. If you have staged
loads in the schedule, this graph also delineates the stages with time range markers, in various colors, at
the top.
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The table under the graph lists the following information:
• The average elapsed time for all transactions in the entire run.
• The standard deviation of the elapsed time. The standard deviation tells you how tightly the data is
grouped about the mean. For example, assume that System A and System B both have an average
elapsed time of 12 ms. However, this does not mean that the elapsed times are similar. System A
might have elapsed times of 11, 12, 13, and 12 ms. System B might have elapsed times of 1, 20, 25,
and 2 ms. Although the mean time is the same, the standard deviation of System B is greater and
the elapsed time is more varied.
• The longest transaction in the entire run.
• The shortest transaction in the entire run.
• The average net server time for all transactions in the entire run.
• The standard deviation of the net server time.
• The longest net server time in the entire run.
• The shortest net server time in the entire run.

Elapsed Time vs. Time
The Elapsed Time vs. Time graph shows the average response of each transaction during a specific
sample interval. Each transaction is represented by a separate line. If you have staged loads in the
schedule, this graph also delineates the stages with time range markers, in various colors, at the top.
The table under the graph lists the following information for each transaction:
• The minimum elapsed time for the entire run.
• The average elapsed time for the entire run. This is similar to the graph above, but the information
in the table is the average for the entire run rather than the average per sample interval.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The maximum elapsed time for the entire run.
• The rate, per second, at which the transaction was completed.
• The number of attempts for the transaction.

Net End-to-End time vs. Time
Net end to end time for a transaction is a measured time of interactions with the server and a client such
as a browser or a device. Typically, this does not include think times or processing time by the workbench.
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Net Server Time vs. Time
Net server time for a transaction is a measured time of interactions with the server. Typically, this does
not include think times or processing time by the product. The server interaction calculation is protocol
specific. For example, in HTTP protocol, the net server time is exactly the sum of all page response times.
The elapsed time (wall clock time) includes think time and other product processing overhead. For a Web
UI test, the net server time includes the sum of time spent on the server and network.

Transaction Throughput
These line graphs provide an overview of the transaction frequency and the number of users that are
adding load, both over the course of a run.
• The Transaction Hit Rate graph shows the overall rates for starting and completing transactions
during a specified sample interval. If you have staged loads in the schedule, this graph also
delineates the stages with time range markers, in various colors, at the top. The summary table
under the graph lists the transaction rate per second and the number of transactions that were
completed for the entire run.
• The User Load graph shows the number of active users and the number of users that completed
testing over the course of the run. The summary table under the graph lists the number of active
users, the number of users that completed testing, and the total number of users for the latest
sample interval.

Transaction Throughput Details
The Transaction Throughput Details page displays the following information:
• The number of transactions that are active during the schedule run.
• The number of virtual users that execute certain transactions simultaneously.

Transaction Health
The Transaction Health page displays whether the transaction is healthy or unhealthy. When you define
error conditions for a transaction, you can set whether the behavior of the errors affect the health of the
run. If any one condition is met in a transaction, the transaction is marked unhealthy. The Transaction
Health page displays the percentage of healthy and unhealthy transactions. The graphic bar is displayed
only if there are no errors.
Note:
During the test run, the elapsed time is recorded for unhealthy transactions. You can select the Discard
time measurements for unhealthy transactions check box from the Test Execution Preferences
(Windows > Preferences > Test > Test Execution), if you do not want to record the elapsed time for the
unhealthy transactions.
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Transaction Details
The Transaction Completion Percentage graph in the Transaction Details page displays the overall
percentage of the successful transactions. The Transaction Details section shows the transactions that
were attempted, completed, exited, and the percentage of completed transactions.

Transaction Percentile report
This report shows the 85th, 90th, and 95th percentile elapsed times for all users, the union of all
transactions in a run, and for the 10 slowest transactions in a run.
The default percentiles in this report, 85, 90, and 95, are sufficient for most purposes. If you need a report
on a different percentile set, click Window > Preferences > Test > Percentile Analysis Targets to change
the percentiles in this report and in the Page Percentile report.
The Summary page of this report has a graph with three bars, which represent the 85th percentile, 90th
percentile, and 95th percentile elapsed times for all users and for all transactions in the run. For the 85th
percentile bar, 85% of all users achieved the indicated elapsed time or better. For the 90th percentile bar,
90% of all users achieved the indicated elapsed time or better. And for the 95% percentile bar, 95% of all
users achieved the indicated elapsed time or better.
The 85%, 90%, and 95% pages show the elapsed time percentiles of the 10 slowest transactions in the
run. For example, if you click the tab for the 85th percentile, and the total for a transaction is 110 (the total
is beneath each bar), you know that 85 percent of the elapsed times for that transaction are less than or
equal to 110 milliseconds (ms).
This graph provides an overall idea of the elapsed times for each transaction. For example, the
Transaction report might indicate that a login transaction is one of the 10 slowest transactions. However,
it is possible that only one instance of the login transaction was extremely slow while the other instances
of the login transaction were within acceptable range. The Transaction Percentile report shows which
transactions have slow elapsed time averages because they were slow in general, not because a few
elapsed times (out of many) were extremely slow.
The table beneath the graph provides the following information for each transaction:
• The minimum elapsed time for the run.
• The average elapsed time for the run.
• The standard deviation of the elapsed time. The standard deviation tells you how tightly the data is
grouped about the mean. For example, assume that System A and System B both have an average
elapsed time of 12 ms. However, this does not mean that the elapsed times are similar. System A
might have elapsed times of 11, 12, 13, and 12 ms. System B might have elapsed times of 1, 20, 25,
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and 2 ms. Although the mean time is the same, the standard deviation of System B is greater and
the elapsed time is more varied.
• The maximum elapsed time for the run.
• The 85th percentile for the run. That is, for this particular transaction, 85% of the elapsed times
were equal to or faster than this time.
• The 90th percentile for the run. That is, for this particular transaction, 90% of the elapsed times
were equal to or faster than this time.
• The 95th percentile for the run. That is, for this particular transaction, 95% of the elapsed times
were equal to or faster than this time.
• The number of attempts in the run.

Transaction Net Server Time Percentile report
This report shows the 85th, 90th, and 95th percentile net server times for all users and the union of all
transactions in a run. The report also shows the 10 slowest transactions in a run. The net server time
corresponds to the cumulative server response times within a transaction. Net server time does not
include think times and delays, which are included in the elapsed time.
The default percentiles in this report, 85th, 90th, and 95th, are sufficient for most purposes. However, if
you must report on a different percentile set, click Window > Preferences > Test > Percentile Analysis
Targets to change the percentiles in this report and in the Page Percentile report.
The Summary page of this report has a graph with three bars, which represent the 85th percentile,
90th percentile, and 95th percentile net server times for all users and for all transactions in the run. For
the 85th percentile bar, 85% of all users achieved the indicated net server time or better. For the 90th
percentile bar, 90% of all users achieved the indicated net server time or better. And for the 95% percentile
bar, 95% of all users achieved the indicated net server time or better.
The 85%, 90%, and 95% pages show the net server time percentiles of the 10 slowest transactions in the
run. For example, if you click the tab for the 85th percentile, and the total for a transaction is 110 (the total
is beneath each bar), you know that 85 percent of the net server times for that transaction are less than or
equal to 110 milliseconds (ms).
This graph provides an overall idea of the net server times for each transaction. For example, the
Transaction report might indicate that a login transaction is one of the 10 slowest transactions. However,
it is possible that only one instance of the login transaction was extremely slow while the other instances
of the login transaction were within acceptable range. The Transaction Net Server Time Percentile report
shows which transactions have slow net server time averages because they were slow in general, not
because a few net server times (out of many) were extremely slow.
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The table beneath the graph provides more detailed information for each transaction:
• The minimum net server time for the run.
• The average net server time for the run.
• The standard deviation of the net server time. The standard deviation tells you how tightly the data
is grouped about the mean.
• The maximum net server time for the run.
• The 85th percentile for the run. That is, for this particular transaction, 85% of the net server times
were equal to or faster than this time.
• The 90th percentile for the run. That is, for this particular transaction, 90% of the net server times
were equal to or faster than this time.
• The 95th percentile for the run. That is, for this particular transaction, 95% of the net server times
were equal to or faster than this time.
• The number of attempts in the run.

Rate Generator report
Use this report to determine if the transactions run at the rate that you specify.
The report contains three pages. See the description of each of the page.

Rate Generators
State: Status of the run for rate generators. One of the following statuses is displayed:
• Not started
• Arriving: At least one user has arrived at the synchronization point.
• Active: At least one iteration of workload.
• Inactive: No users or clients are running.
Users or Clients: Number of users or clients in the Arriving or Active state.
Target Rate: Number of iterations specified in Rate Generator or Rate Schedule. The report shows the
value in seconds. For example, if the iteration rate is 2 every minute, the Target Rate would show 0.032
per second.
Workloads Started - First time: Time taken for the first workload to start after the test run. The time taken
includes the time to create the users or clients, begin the workload, meet at the rate synchronization point,
run any iteration delay, and then start the workload.
Workloads Started - Elapsed time: Time taken for the first workload to start and the last workload to end.
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Workloads Started: Number of workloads already started at any given point of time during the run. For
example, for a target rate of 4 every minute, at the end of one minute, the number of workloads started
should be 4. However, it should increment throughout the run based on the target rate. So, at a target rate
of 4 every minute and a total duration of 10 minutes, the number of workloads at the end of the run should
show Workloads Started = 40 and Workloads Completed = 40.
Workloads Started - Rate: Actual rate achieved for the run. Compare it with the Target Rate to determine
the performance of the application.
Percent Target: Comparison of the Target Rate with the Actual Rate (Workloads Started - Rate) to indicate
by percentage how close the workload is to reach the specified target rate.
Percent Late - Percent: The percent of workloads in a user group or Rate Runner group that did not begin
to run at the specified time.

Health
Use this page to view the number of workloads that did not meet the target rate.

Throughput
Use this page to view the number of workloads that passed successfully.

Related information
Creating rate generators in user groups on page

HTTP performance test reports
When you test an HTTP system, reports are produced during a run and saved after a run. You can then
analyze the reports to know the performance of the system under test.
In a performance report, you can sort the order of HTTP pages that are captured in a test or schedule
either by alphabetical order or order of execution of the HTTP pages. The default sorting of the HTTP
pages is by order of execution.
You can either click the Execution order icon

or the Alphabetical order icon

sorting options. You can also click the Up Arrow icon

to toggle between the

to sort the HTTP pages in the correct order of

execution or the correct alphabetical order. Similarly, you can click the Down Arrow icon
HTTP pages in the reverse order of execution or the reverse alphabetical order.
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Performance report
The performance report summarizes the validity of the run and the data that is most significant to the
run. The report also shows the response trend of the slowest 10 pages in the test and the graph of the
response trend of each page for a specified interval.

Contents
• Overall page on page23
• Summary page on page25
• Page Performance page on page27
• Response vs. Time Summary page on page27
• Response vs. Time Detail page on page28
• Page Throughput page on page29
• Server Throughput page on page29
• Server Health Summary page on page30
• Server Health Detail page on page30
• Caching Details page on page31
• Resources page on page31
• Page Element Responses on page34
• Page Response Time Contributions on page34
• Page Size on page34
• Errors on page35
• Page Health on page35

Overall page
The Overall page provides the following information:
• A progress indicator that shows the state of the run.
• A pie chart that shows the information about the overall verification point passed and failed for the
test run if they were set. For the schedule run, it displays the overall requirements that passed and
failed.
Item
Page VPs

Description

Verdict

Displays the verdict of the page title verification

• Passed

points if they were set.

• Failed
• Inconclusive
• Error
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Item
Page Element VPs

Description

Verdict

Displays the verdict of the response code or re

• Passed

sponse size verification points if they were set.

• Failed
• Inconclusive
• Error

Page Status Codes

Displays the success and failure rate for the en

• Passed

tire run.

• Failed

If a primary request includes verification points,
the Page Status Code Successes value indicates
that the verification point for the response code
is passed.
If a primary request has no verification points,
the Page Status Code Successes value indicates
that the server received the primary request and
returned a response with one of the following
status codes:
• 200 or 300 category
• 400 or 500 category, which is an expected
response code
Page Element Status

Displays the success and failure rate for the en

• Passed

Codes

tire run.

• Failed

If a primary request includes verification points,
the Page Element Successes value indicates
that the response code verification point passed
for that request.
If a request has no verification points, the Page
Element Successes indicates that the server re
ceived the request and returned a response with
one of the following status codes:
• 200 or 300 category
• 400 or 500 category, which is an expected
response code
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Item
Page Health

Description

Verdict

Displays the total health of the pages, transac

• Healthy

tions, and loops for the test or schedule run.

• Unhealthy

• If you click any individual chart, you can go to that specific report to analyze the status in detail.
• If you click any legend (for example, Passed), the chart is updated to show only the other verdicts
of a test or a schedule run. For example, the Page Status Codes has a legend as Passed and
Failed. If you click Passed, the chart is updated to show only errors during a test or a schedule run.
• Similarly, if you double-click any legend, the chart is updated to show only the selected verdict by
removing all other verdicts from the chart. Thus you can focus on only one counter which you want
to investigate in detail.

Summary page
The Summary page summarizes the most important data about the test run, so that you can analyze the
final or intermediate results of a test at a glance.
The Summary page displays the following Run Summary information:
• The name of the test.
• The number of users that are active and the number of users that have completed testing. This
number is updated during the run.
• The elapsed time. This is the run duration, which is displayed in hours, minutes, and seconds.
• The status of the run. This can be Initializing Computers, Adding Users, Running, Transferring
data to test log, Stopped, or Complete.

• Displaying results for computer: All Hosts. To see summary results for individual computers,
click the computer name in the Performance Test Runs view.
The Summary page displays the following Page Summary information:
• The total number of page attempts and hits. A page attempt means that a primary request was
sent; it does not include requests within the page. A hit means that the server received the primary
request and returned any complete response.
• The average response time for all pages. Response time is the sum of response times for all
page elements (including the connect time and inter-request delays). Response time counters
omit page response times for pages that contain requests with status codes in the range of 4XX
(client errors) to 5XX (server errors). The only exception is when the failure (for example, a 404)
is recorded and returned, and the request is not the primary request for the page. Page response
times that contain requests that time out are always discarded.
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• The standard deviation of the average response time for all pages.
• The maximum response time for all pages.
• The minimum response time for all pages.
• A summary of the results for page verification points, if these verification points were set.
The Summary page displays the following Page Element Summary information:
• The total number of page element attempts and hits. A page element attempt means that a request
was sent. A hit means that the server received the request and returned any complete response.
• The total number of page elements where no request was sent to the server because the client
determined that the page elements were fresh in the local cache.
• The average response time for all page elements. Response time is the time between the first
request character sent and the last response character received. Response times for HTTP
requests that time out or that return an unexpected status code (the recorded and played back
codes do not match) in the range of 4XX (client errors) to 5XX (server errors) are discarded from
the reported values.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The percentage of verification points that passed.
• A summary of the results for page element verification points, if these verification points were set.
If you have set transactions in your test, the Summary page displays the following Transaction
information:
• The minimum, maximum, and average response time for all transactions. Response time is the
actual time spent within the transaction container.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The total number of transactions that were started and completed.
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Page Performance page
The Page Performance page shows the average response of the slowest 10 pages in the test as the test
progresses. With this information, you can evaluate system response during and after the test.
The bar chart shows the average response time of the 10 slowest pages. Each bar represents a page that
you visited during recording. As you run the test, the bar chart changes, because the 10 slowest pages are
updated dynamically during the run. For example, the Logon page might be one of the 10 slowest pages
at the start of the run, but then, as the test progresses, the Shopping Cart page might replace it as one of
the 10 slowest. After the run, the page shows the 10 slowest pages for the entire run.
The table under the bar chart provides the following additional information:
• The minimum response time for each page in the run. Response time is the time between the
first request character sent and the last response character received. Response time counters
omit page response times for pages that contain requests with status codes in the range of 4XX
(client errors) to 5XX (server errors). The only exception is when the failure (for example, a 404)
is recorded and returned, and the request is not the primary request for the page. Page response
times that contain requests that time out are always discarded.
• The average response time for each page in the run. This matches the information in the bar chart.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The maximum response time for each page in the run.
• The number of attempts per second to access each page. An attempt means that a primary
request was sent; it does not include requests within the page.
• The total number of attempts to access the page.
To display the 10 slowest page element response times, right-click a page and click Display Page Element
Responses.

Response vs. Time Summary page
The Response vs. Time Summary page shows the average response trend as graphed for a specified
interval. It contains two line graphs with corresponding summary tables. When a schedule includes
staged loads, colored time-range markers at the top of the graph delineate the stages.
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• The Page Response vs. Time graph shows the average response time for all pages during the run.
Each point on the graph is an average of what has occurred during that interval. The table after the
graph lists the total average response time for all pages in the run and the standard deviation of the
average response time.
• The Page Element response vs. Time graph shows the average response time for all page
elements during the run. Each point on the graph is an average of what has occurred during that
interval. The table under the graph lists the total average response time for all page elements in the
run and the standard deviation of the average response time. The table also lists the total number
of page elements where no request was sent to the server because the client determined that the
page elements were fresh in the local cache. You set the Statistics sample interval value in the
schedule, as a schedule property.

Response vs. Time Detail page
The Response vs. Time Detail page shows the response trend as graphed for the sample intervals. Each
page is represented by a separate line.
The Average Page Response Time graph shows the average response of each page for each sample
interval. When a schedule includes staged loads, colored time-range markers at the top of the graph
delineate the stages. The table after the graph provides the following additional information:
• The minimum page response time for the run. Response time is the time between the first request
character sent of the primary request and the last response character received. Response time
counters omit page response times for pages that contain requests with status codes in the range
of 4XX (client errors) to 5XX (server errors). The only exception is when the failure (for example,
a 404) is recorded and returned, and the request is not the primary request for the page. Page
response times that contain requests that time out are always discarded.
• The average page response time for the run. This is similar to the graph, but the information in the
table includes the entire run.
• The maximum page response time for the run.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
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• The rate of page attempts per interval for the most recent statistics sample interval. A page
attempt means that the primary request was sent; it does not include requests within the page. You
set the Statistics sample interval value in the schedule, as a schedule property.
• The number of page attempts per interval.

Page Throughput page
The Page Throughput page provides an overview of the frequency of requests being transferred per
sample interval.
• The Page Hit Rate graph shows the page attempt rate and page hit rate per sample interval for all
pages.
A page attempt means that the primary request was sent; it does not include requests within the
page.
A hit means that the server received the primary request and returned any complete response.
When a schedule includes staged loads, colored time-range markers at the top of the graph
delineate the stages. The summary table after the graph lists the total hit rates and counts for each
page in the run.
• The User Load graph shows active users and users that have completed testing, over the course of
a run. The summary table after the graph lists the results for the most recent sample interval. You
set the Statistics sample interval value in the schedule, as a schedule property. As the run nears
completion, the number of active users decreases and the number of completed users increases.
The summary table after the graph lists the active and completed users for the entire run.
Note: To set the sample interval value, open the schedule, click the Statistics tab, and then
view or modify Statistics sample interval.
If the number of requests and hits are not close, the server might be having trouble keeping up with the
workload.
If you add virtual users during a run and watch these two graphs in tandem, you can monitor the ability
of your system to keep up with the workload. As the page hit rate stabilizes, even though the active user
count continues to climb and the system is well-tuned, the average response time will naturally slow
down. This response time reduction happens because the system is running at its maximum effective
throughput level and is effectively throttling the rate of page hits by slowing down how quickly it responds
to requests.

Server Throughput page
The Server Throughput page lists the rate and number of bytes that are transferred per interval and for
the entire run. The page also lists the status of the virtual users for each interval and for the entire run.
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• The Byte Transfer Rates graph shows the rate of bytes sent and received per interval for all
intervals in the run. When a schedule includes staged loads, colored time-range markers at the
top of the graph delineate the stages. The summary table after the graph lists the total number of
bytes sent and received for the entire run.
• The User Load graph shows active users and users that have completed testing, per sample
interval, over the course of a run. You set the Statistics sample interval value in the schedule, as
a schedule property. As the run nears completion, the number of active users decreases and the
number of completed users increases. The summary table after the graph lists the active and
completed users for the entire run.
The bytes sent and bytes received throughput rate, which is computed from the client perspective, shows
how much data Rational® Performance Tester is pushing through your server. Typically, you analyze this
data with other metrics, such as the page throughput and resource monitoring data, to understand how
network throughput demand affects server performance.

Server Health Summary page
The Server Health Summary page gives an overall indication of how well the server is responding to the
load.
• The Page Health chart shows the total number of page attempts, page hits, and status code
successes for the run. The table under the bar chart lists the same information.
A page attempt means that a primary request was sent; it does not include requests within the
page.
A hit means that the server received the primary and returned any complete response.
A success means that the response code verification point passed for that request. If a primary
request has no verification points, the Success value indicates that the server received the primary
request and returned a response with one of the following status codes:
◦ 200 or 300 category
◦ 400 or 500 category, which is an expected response code
• The Page Element Health chart shows the total number of page element attempts, page element
hits, status code successes, and page element redirections for the run. The table under the bar
chart lists the same information and the total number of page elements where no request was sent
to the server because the client determined that the page elements were fresh in the local cache.

Server Health Detail page
The Server Health Detail page provides specific details for the 10 pages with the lowest success rate.
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• The bar chart shows 10 pages with the lowest success rate.
• The summary table under the chart lists, for all pages, the number of attempts, hits, and successes
in the run and the attempts per second during the run.
An attempt means that a primary request was sent; it does not include requests within the page.
A hit means that the server received the primary and returned any complete response.
A success means that the response code verification point passed for that request. If a primary
request has no verification points, the Success value indicates that the server received the primary
request and returned a response with one of the following status codes:
◦ 200 or 300 category
◦ 400 or 500 category, which is an expected response code

Caching Details page
The Caching Details page provides specific details on caching behavior during a test run.
• The Caching Activity graph shows the total number of page element cache attempts, page element
cache hits, and page element cache misses for the run. These values correspond to responses
from the server, indicating whether the content has been modified. Additionally, the bar chart
shows the total number of page elements in the cache that were skipped for the run. That value
indicates the cache hits that were still fresh in the local cache, where communication with the
server was not necessary.
• The Page Element Cache Hit Ratios graph shows the percentage of cache attempts that indicate
server-confirmed success and client-confirmed success for the run. Server-confirmed cache hits
occur when the server returns a 304 response code. Client-confirmed cache hits occur when the
content is still fresh in the local cache and no communication with the server is required.

Resources page
The Resources page shows information about all the resource counters that were monitored during the
schedule run. You can view the following information as mentioned in the table from the Resources page:
If...

Then the Resources page displays...

If you did not add any Resource Monitoring

A message that states that you must set up the

source to a performance schedule

Resource Monitoring sources to view the re
source details.
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If...
If you added Resource Monitoring sources to a
performance schedule

Then the Resources page displays...
• The Resource Monitoring sources that
were monitored during the schedule run.
• All resource counters for those Resource
Monitoring sources that were monitored
during the schedule run.
• The Unavailable sources section lists the
Resource Monitoring sources that were
unavailable or unreachable during the
schedule run.
Note: The Unavailable sources sec
tion is displayed only if any of the Re
source Monitoring sources were unreach
able or unavailable during the schedule
run.

If you added Resource Monitoring sources by us
ing labels to a performance schedule

• The following information in the Serv
er sources matching the labels set in
the schedule (*Source defined in team
space) section:
◦ Labels and the Resource Monitor
ing sources associated with those
labels that were monitored during
the schedule run.
◦ Resource Monitoring sources that
were unavailable or unreachable
during the schedule run.
◦ An empty array ([]) when you used
labels that were not tagged to any
Resource Monitoring source in Ra
tional® Test Automation Server.
◦ The asterisk (*) symbol is shown
after the name of the Resource
Monitoring source if you add the
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If...

Then the Resources page displays...
Resource Monitoring source at the
team space level in Rational® Test
Automation Server.
• All resource counters for the Resource
Monitoring sources that were monitored
during the schedule run.

If you ran a performance schedule by using the

• The following information in the Serv

overridermlabels command from the Rational®

er sources matching the labels set with

Performance Tester command line

the command-line flag -overridermlabels
(*Source defined in team space) section:
◦ Labels that you used to add the Re
source Monitoring sources to the
schedule for the schedule run.
◦ Resource Monitoring sources as
sociated with those labels that
were monitored during the sched
ule run.
◦ Resource Monitoring sources that
were unavailable or unreachable
during the schedule run.
◦ An empty array ([]) when you used
labels that were not tagged to any
Resource Monitoring source in Ra
tional® Test Automation Server.
◦ The asterisk (*) symbol is shown
after the name of the Resource
Monitoring source if you add the
Resource Monitoring source at the
team space level in Rational® Test
Automation Server.
• All resource counters for the Resource
Monitoring sources that were monitored
during the schedule run.

The Legend shows the Resource Monitoring type and its resource counters. When you have multiple
Resource Monitoring sources, the resource counters for the respective sources are displayed in front of
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their Resource Monitoring source name. You can customize the resource counter information displayed
in a graph by clicking any individual resource counter or type of source. You can click or double-click any
individual resource counter for the following results:
• A single click on the resource counter hides the data displayed on the graph. Click the resource
counter again to display the data in the graph.
• A double-click on the resource counter removes information about all other resource counters from
the graph and displays only the information about the selected resource counter.
Tip: You can click Select All option to restore all the resource counter information on the
graph.
When you click on any of the sources, the graph removes all the resource counters of other sources and
displays only the resource counters of the selected source.
For example, you have an Apache httpd server and a Windows Performance Host as a Resource
Monitoring source. When the schedule completes, the Resources page displays the resource counter
information of both the sources. If you want to analyze the resource counters for any one of the sources,
you can click the Apache httpd server or the Windows Performance Host. Based on your selection, the
graph is updated to show the selected source resource counters information.
The Performance Summary table under the graph lists the most recent values of the resource counters
that were monitored during the schedule run. The first two columns show the Type of the source and
Name of the resource counter. This table also lists the minimum, maximum, and average values of the
resource counters that were monitored during the schedule run.

Page Element Responses
The Page Element page shows the 10 slowest page element responses for the selected page.

Page Response Time Contributions
The Page Response Time Contributions page shows how much time each page element contributes to
the overall page response time and the client delay time and connection time.

Page Size
This page lists the size of each page of your application under test. The size of the page contributes to
the response time. If part of a page or an entire page is cached, then those requests coming from the
cache will not contribute to the total page size.
The size of a page is mostly determined by the size of its elements. Each bar in this report represents a
page. To view the Page Elements Size report, click a bar and select Page Element Sizes. All the elements
that are on the page show up with sizes.
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Errors
This page lists the number of errors and the corresponding actions that occurred in the test or schedule.
The Error Conditions section displays the number of error conditions met. The Error Behavior section
displays how each error condition was handled. You should have already defined how to handle errors in
the Advanced tab of the test editor, schedule editor, or compound test editor.

Page Health
Use this page(report) to determine if the pages of your application have errors. If a page contains any
error, the report displays that the page is not 100% healthy. If there are pages that are not 100% healthy,
the report displays another section listing such pages and the errors reported.

Page Element report
This report summarizes the most important page element data for the run.
The graphs in this report show time intervals, attempts, hits, and successes.
• The interval depends on the Statistics sample interval value that you set for the schedule.
• An attempt means that a request was sent.
• A hit means that the server received the request and returned any response.
• A success means that the response code verification point passed for that request. If the request
has no verification point, a success means that the server received a request and returned a
response where the status code was in the 200 or 300 category, or returned an expected response
in the 400 or 500 category.
• The response time is the time between the first request character sent and the last response
character received. The response time does not include HTTP requests that time out or requests
that return a status code in the range of 4XX (client errors) - 5XX (server errors) or requests that
timed out.Response times for HTTP requests that time out or that return an unexpected status
code (the recorded and played back codes do not match) in the range of 4XX (client errors) to 5XX
(server errors) are discarded from the reported values.

Overall page
The Overall line graph shows the average response time for all page elements during a specified interval.
When you have set staged loads in the schedule, this graph delineates the stages with time range
markers, in various colors, at the top. The table after the graph provides the following information:
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• The average response time for all page elements in the entire run
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The average number of page elements attempted for the entire run
• The total page element attempts for the entire run

Response vs. Time Summary page
The Response vs. Time Summary line graph shows the response time for the 10 slowest page elements
in the run. When you have set staged loads in the schedule, this graph delineates the stages with time
range markers, in various colors, at the top. The table after the graph lists the parent page and the page
element, and provides the following information:
• The average response time for that page element during the entire run
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The attempts per second during the most recent sample interval
• The number of attempts during the most recent sample interval

Response vs. Time Detail page
The Response vs. Time Detail page shows the response time for each page element in the run. The table
lists the parent page and page element, and provides the following information for each page element in
the entire run:
• The average response time
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
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• The number of attempts
• The number of attempts per second

Page Element Throughput page
The Page Element Throughput page shows the average response trend during a specified interval. It
contains two line graphs with corresponding summary tables:
• The Page Element Hit Rate graph shows the combined attempt rate and hit rate for all page
elements during the last recorded interval. The table after the graph lists one number: the average
hit rate for all pages in the run. When a schedule includes staged loads, colored time-range
markers at the top of the graph delineate the stages.
• The User Load graph shows active users compared to users that have completed testing. The table
after the graph lists the number of active users, the number of users that have completed testing,
and the total user count for the entire run.

Server Health Detail page
The Server Health Detail bar chart shows the percentage of successes for the 10 slowest page elements
in the run. The table under the chart lists the parent page and page element, and provides the following
information for the entire run:
• The number of attempts
• The number of hits
• The number of successes
• The percent of successes (matches the information in the bar chart)
• The number of attempts per second

Caching Details page
The Caching Details page provides specific details on caching behavior during a test run.
• The Caching Activity graph shows the total number of page element cache attempts, page element
cache hits, page element cache misses for the run. These values correspond to responses from
the server indicating whether the content has been modified. Additionally, the bar chart shows the
total number of page elements in cache skipped for the run. That value indicates the cache hits
that were still fresh in the local cache, where communication with the server was not necessary.
• The Page Element Cache Hit Ratios graph shows the percentage of cache attempts that indicate
server-confirmed success and client-confirmed success for the run. Server-confirmed cache hits
occur when the server returns a 304 response code. Client-confirmed cache hits occur when the
content is still fresh in the local cache and no communication with the server is required.
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• The summary table under the charts lists the the total number of page elements found fresh in the
cache for the run. This value indicates the cache hits that were still fresh in the local cache, where
communication with the server was not necessary. The table also lists the number of attempts,
the total number of page element cache attempts sent to the server, and the total number of page
element cache hits confirmed by the server for the run. Additionally, the table lists the percentage
of cache attempts that indicate server-confirmed success and client-confirmed success for the
run.

Why response time of a page does not equal the sum of its requests
The response time for a page typically differs from the sum of its requests. This does not mean that your
data is incorrect. The difference can be caused by concurrent requests, page connection times, interrequest delays, and custom code within a page.
The most common reason for the sum of the individual request times within a page to exceed the total
page response time is that requests are often sent concurrently (in parallel) to a server. Thus some of the
individual request response times overlap so the sum of the request response times would exceed the
page response time.
Additionally, the page response time can exceed the sum of the individual request response times within
the page for the following reasons:
• The individual request response times do not include time to establish connections but the page
response time does include the connection request time.
• Inter-request delays are not reflected in the individual request response time but are reflected in the
page response time.
• Custom code placed within a page is executed serially (after waiting for all previous individual
requests to complete) and thus contributes to the page response time. It does not affect individual
request response times. However, we recommend that you place custom code outside of a page,
where it will not affect page response time. For more information, see Reducing the performance
impact of custom code on page

.

Page Percentile report
This report shows the 85th, 90th, and 95th percentile response times for all users and all pages in a run,
as well as for the 10 slowest pages in a run.
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The default percentiles in this report, 85, 90, and 95, are sufficient for most purposes. However, if you are
required to report on a different percentile set, click Window > Preferences > Test > Percentile Analysis
Targets to change the percentiles in this report and in the Transaction Percentile report.
The Summary page shows a graph with three bars, which represent the 85th percentile, 90th percentile,
and 95th percentile response times for all users and for all pages in the run. For the 85th percentile bar,
85% of all users achieved the indicated response time or better. For the 90th percentile bar, 90% of all
users achieved the indicated response time or better. And for the 95% percentile bar, 95% of all users
achieved the indicated response time or better.
The 85%, 90%, and 95% pages show the response-time percentiles of the 10 slowest pages in the run. For
example, if you click the tab for the 85th percentile, and the total for a page is 110 (the total is beneath
each bar), you know that 85 percent of the response times for that page are less than or equal to 110
milliseconds (ms).
This graph provides an overall idea of the response times for each page. For example, the Page
Performance report might indicate that a Login page is one of the 10 slowest pages. However, it is
possible that one page attempt was extremely slow, but the other attempts were within range. The
Page Percentile report shows which pages have slow responses because they were slow in general, not
because a few responses (out of many) were extremely slow.
The table beneath the graph provides more detailed information for each page:
• The minimum response time for the run.
• The average response time for the run.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,

20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The maximum response time for the run.
• The 85th percentile for the run. That is, for this particular page, 85% of the response times were
equal to or faster than this time.
• The 90th percentile for the run. That is, for this particular page, 90% of the response times were
equal to or faster than this time.
• The 95th percentile for the run. That is, for this particular page, 95% of the response times were
equal to or faster than this time.
• The number of attempts in the run.
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Verification Points report
This report shows the status of the verification points in your tests.
This report is displayed if your tests verify page titles, the return code for a page element, or the response
size of a page element. To have your tests verify these items, complete the following steps:
1. Before recording, set the verification points. Click Window > Preferences > Test > Test Generation
> HTTP Test Generation and under Automatically include verification point of select one of the
verification point behavior that you want to test. Or, during test editing, enable page verification
points individually by right-clicking the test item.
2. In the schedule, set the level for logging statistics to Pages or All.
The VP Pass Rate vs. Time graph on the Summary page lists the percentage of verification points that
passed per sample interval during the last recorded interval. You set the Statistics sample interval value
in the schedule, as a schedule property. When a schedule includes staged loads, colored time-range
markers at the top of the graph delineate the stages.
The Page Verification Points page lists the following information for each page that has verification
points:
• The number of verification points that passed in the run
• The number of verification points that failed in the run
• The percentage of verification points that passed
The Page Element Verification Points page lists the following information for each page element that has
verification points:
• The name of the page and the element
• The number of verification points that passed in the run
• The number of verification points that failed in the run
• The percentage of verification points that passed

SAP performance test reports
When you test an SAP application, these performance test reports are produced during a run and saved
after a run.
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SAP Performance report
The SAP Performance report summarizes the health of the run, displays the data most significant to the
run, shows the response trend of the slowest 10 transactions in the test, and graphs the response trend of
each transaction for a specified interval.

Summary page
The Summary page summarizes the most important data about the test run, so that you can analyze the
final or intermediate results of a test at a glance.
The SAP Summary section displays the following information:
• A progress indicator that shows the state of the run.
• The number of virtual users that are active and the number of virtual users that have completed
testing. This number is updated during the run.
• The elapsed time. This figure is the run duration, which is displayed in hours, minutes, and
seconds.
• The location and name of the test suite or schedule.
• Results for computer, All Hosts. To see summary results for individual computers, click the
computer name in the Performance Test Runs view.
• The status of the run. This can be Initializing Computers, Adding Users, Running, Performing
Execution History Data Transfer, Stopped, or Complete.
• The total number of virtual users that are simulated during the test.
The Transaction Summary section displays the following information:
• The minimum, maximum, average, and standard deviation execution time for all transactions.
Execution time is the sum of response times for all screens of a transaction (including the connect
time and inter-request delays).
• The total number of transactions that were completed and started.
The Screen Summary section displays the following information:
• The minimum, maximum, average, and standard deviation screen request response times for all
SAP screens. Response time is the time between the first request character that is sent and the
last response character that is received.
• The total number of SAP screens that were completed and started.
• Percent of verification points that passed.
• Total verification points that failed.
• Total verification point errors.
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• Total verification points that passed.
• Total verification points that are inconclusive.
The Element Summary section displays the following information:
• The total number of SAP set, SAP get, and SAP call elements that were attempted.
• The total number of SAP set, SAP get, and SAP call elements that were completed.
• The percentage of completion of all SAP set, SAP get, and SAP call elements.

Screen Performance page
The Screen Performance page shows the average response time of the longest SAP screen requests in
the test as the test progresses. With this information, you can evaluate system response during and after
the test.
If you select Do not measure performance on this screen on a SAP screen in the test editor, then the
report does not include the response time results for that screen.
The bar chart shows the average response time of the 10 slowest transactions. Each bar represents a
page that you visited during recording. As you run the test, the bar chart changes, because the 10 slowest
screens are updated dynamically during the run. For example, the SAP Easy Access screen might be
one of the 10 slowest pages at the start of the run, but then, as the test progresses, Display Material
(Initial Screen) might replace it as one of the 10 slowest. After the run, the page shows the 10 slowest
transactions for the entire run.
The Performance Summary table that follows the bar chart provides the following additional information
for each SAP screen:
• The minimum response time for each SAP screen in the run. Response time is the time between
the first request character that is sent and the last response character that is received.
• The average response time for each SAP screen in the run. This matches the information in the
chart.
• The maximum response time for each SAP screen in the run.
• The standard deviation response time for each SAP screen in the run.
• The rate per second at which each SAP screens is started.
• The total number of times each SAP screen is started.

Response vs. Time Summary page
The Response vs. Time Summary page shows the average response trend as graphed for a specified
interval. The line graph shows the average response time for all SAP screens during the run. Each point on
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the graph is an average of what has occurred during that interval. You set the Statistics sample interval in
the schedule, as a schedule property.
The table that follows the graph displays the average and standard deviation response time for all SAP
screens during the run.

Response vs. Time Detail page
The Response vs. Time Detail page shows the response trend by screen as graphed for a specified
interval. Each separate line represents a SAP screen. You set the Statistics sample interval in the
schedule, as a schedule property.
The line graph shows the average response of each page during a specified interval. The table that
follows the graph provides the following additional information for each SAP screen:
• The minimum SAP screen request response time for the run. This is the time between the moment
the input is validated in the SAP GUI and the time the resulting SAP screen is displayed.
• The average SAP screen request response time for the run. This is similar to the graph, but the
information in the table is for the duration of the entire run.
• The maximum SAP screen request response time for the run.
• The standard deviation for SAP screen request response time for the run.
• The rate per second at which each SAP screen is started for the most recent interval.
• The total number of times each SAP screen is started for the most recent interval.

Screen Throughput page
The Screen Throughput page provides an overview of the frequency of requests that are being transferred
per interval.
• The line graph on the left shows two lines that represent the rate for intervals at which SAP screens
are started and the rate at which SAP screens are completed. The summary table under the graph
lists the start rates and the completed rates and counts for each SAP screen in the run.
• The line graph on the right shows active users and users that have completed testing, over the
course of a run. The summary table under the graph lists the results for the most recent sample
interval. You set the Statistics sample interval in the schedule, as a schedule property.

Server Health page
The Server Health Summary page shows an overall indication of how well the server is responding to the
load.
The bar chart on the left represents the total number of SAP screens started. The bar chart on the right
represents the percentage of SAP screens completed compared to the SAP screens started on each
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interval. The percentage can be over 100% if more screens were completed than started on a given
interval.
The table that follows the charts lists the same information for each SAP screen.

Batch Input Transaction Rate page
The Batch Input Transaction Rate page displays the number of batch input tests that were run during the
test run. The Batch Input Transaction graph represents the volume of batch input transactions that were
processed during the test run.

Related information
SAP Verification Points report on page44

SAP Verification Points report
The SAP Verification Points report shows the status of the verification points in your tests.

Summary page
The Summary page displays a line graph representing the percentage of verification points that passed
per interval. You set the Statistics sample interval value in the schedule, as a schedule property.
Below the graph, the Verification Point Summary table lists the following information:
• The percentage of verification points that passed during the run.
• The number of verification points that were tested.
• The number of verification points that passed.
• The number of verification points that failed.
• The number of verification points that produced an error.
• The number of verification points that were inconclusive.

Screen Verification Points page
The Screen Verification Points page lists the following information for each page element that has
verification points:
• The number of verification points that passed during the run
• The number of verification points that failed during the run
• The percentage of verification points that passed during the run
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Verification points set on the screen title are counted with verification points set on get events in the
screen.

Related information
SAP Performance report on page40

Citrix performance test reports
When you test a Citrix XenApp application, these reports are produced during a run and saved after a run.

Citrix Performance report
The Citrix performance report summarizes the validity of the run, graphs show response times, average
response time, and the server health depending on requests.

Citrix Overall page
The Overall page provides the following information:
• A progress indicator that shows the state of the run.
• The bar chart indicates the overall success of the run with the percentage of window and image
synchronization successes and the percentage of verification point successes. Synchronization
success indicates that the expected window and image events in the test match the actual window
and image events in the test run.

Performance Summary page
The Summary page summarizes general data about the test run, so that you can analyze the final or
intermediate results of a test at a glance.
The Run Summary table displays the following information:
• The number of virtual users that are active and the number of virtual users that have completed
testing. This number is updated during the run.
• The elapsed time. This is the total duration of the run, which is displayed in hours, minutes, and
seconds.
• The location and name of the test.

45

Reference Guide

• The status of the run. This can be Initializing Computer(s), Adding Users, Running, Performing
Execution History Data Transfer, Stopped, or Complete.
• The total number of virtual users emulated during the test.
The Citrix Summary section displays the following information:
• The statistics values (average, standard deviation, maximum, minimum) of the average response
time for all response time measurements. Response times are determined by measurements that
are located in the tests. Response time measurements can be automatically generated between
the last input action before a window create event and the window create event. The table does not
display values that equal zero.
• Total user actions for run. This indicates the total number of user input actions that were emulated
during the run.
• The total number of window synchronization attempts.
• The total number of window synchronization successes.
• The total number of window synchronization timeouts. A timeout occurs when the synchronization
fails.
• The total number of image synchronization attempts.
• The total number of image synchronization successes.
• The total number of image synchronization timeouts. A timeout occurs when the synchronization
fails.

Server Performance Summary page
The server Performance Summary page shows the average time virtual users are connected, active, and
disconnected.
The bar chart shows the average response time of each test phase. Each bar represents a particular
phase in the test: connecting to the Web interface, connecting to the server, identifying, activity phase and
disconnecting. As you run the test, the bar chart changes, because the time measurements are updated
dynamically during the run.
The table under the bar chart provides the following additional information for each window:
• The minimum response time during the run.
• The average response time during the run. This matches the information in the chart.
• The maximum response time during the run.
• The standard deviation response time during the run.
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Response vs. Time Summary page
The Response vs. Time Summary page shows the average response trend as graphed for a specified
interval. You set the Statistics sample interval value in the schedule, as a schedule property. Response
times are determined by measurements that are located in the tests. Response time measurements can
be automatically generated between the last input action before a window create event and the window
create event.
The line graph shows the average response time for all measurements during the run. Each point on the
graph is an average of what has occurred during that interval. The table under the graph lists the statistics
values of the total average response time for all measurements in the run.

Response vs. Time Details page
The Response vs. Time Details page shows the response trend as graphed for a specified interval.
You set the Statistics sample interval value in the schedule, as a schedule property. Response times
are determined by measurements that are located in the tests. Response time measurements can be
automatically generated between the last input action before a window create event and the window
create event.
The line graph shows the average response time of each measurement for a specified interval. Each
measurement is represented by a separate line.
The table under the graph provides the following additional information for each response time
measurement:
• The minimum response time during the run.
• The average window response time during the run. This is similar to the graph, but the information
in the table includes the entire run.
• The maximum window response time during the run.
• The standard deviation window response time during the run.

User Action Throughput page
The User Action Throughput page provides an overview of the frequency of requests being transferred per
interval. You set the Statistics sample interval value in the schedule, as a schedule property.
• The line graph on the left shows the user action rate per interval for all windows. This represents
the activity of virtual user input actions per second for each interval. The table under the graph lists
the user action rate per second for the entire run, and the total number of user actions for the run.
• The line graph on the right shows active users and users that have completed testing, over the
course of a run. The summary table under the graph lists the results for the most recent sample
interval.
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Server Health Summary page
The Server Health Summary page provides an overall indication of how well the server has performed.
The graph does not display values that equal zero.
The bar chart shows the following information:
• The total number of window synchronization attempts.
• The total number of window synchronization successes.
• The total number of window synchronization timeouts.
• The total number of image synchronization attempts.
• The total number of image synchronization successes.
• The total number of image synchronization timeouts.
• The total number of Citrix server errors or errors encountered during test execution.

Server Timeout page
The Server Timeout page shows when the synchronization timeouts and server errors occurred during the
run. The graph does not display values that equal zero.
The line graph shows the following information:
• Citrix window synchronization timeouts.
• Citrix image synchronization timeouts.
• Citrix server errors or errors encountered during test execution.

Resources page
The Resources page shows all resource counters monitored during the schedule run.
• The line chart shows the values of the resources counters monitored during the schedule run.
The chart scales automatically to accommodate the highest resource counter value.
• The summary table under the chart lists the average values of the resource counters monitored
during the schedule run. This table is organized by resource monitoring hosts.

Related information
Citrix Verification Points report on page48
Citrix response time percentile report on page50
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Citrix Verification Points report
The Citrix Verification Points report shows the status of the verification points in your tests.

Summary page
The Summary page displays a line graph representing the percentage of verification points that passed
per interval. You set the Statistics sample interval value in the schedule, as a schedule property.
Below the graph, the Window Verification Point Summary table lists the following information:
• The percentage of window verification points that passed during the run
• The number of window verification points that were attempted
• The number of window verification points that passed
• The number of window verification points that failed
The Image Synchronization Verification Point Summary table lists the following information:
• The percentage of image synchronization verification points that passed during the run
• The number of image synchronization verification points that were tested
• The number of image synchronization verification points that passed
• The number of image synchronization verification points that failed

Citrix Verification Points page
The Citrix Verification Points page contains tables with verification point details.
The Window Verification Points table lists the following information:
• The number of window verification points that passed during the run
• The number of window verification points that failed during the run
• The number of window verification points that caused an error during the run
• The number of window verification points that were inconclusive during the run
• The percentage of window verification points that passed during the run
The Image Synchronization Verification Points table lists the following information:
• The number of image synchronization verification points that passed during the run
• The number of image synchronization verification points that failed during the run
• The number of image synchronization verification points that caused an error during the run
• The number of image synchronization verification points that were inconclusive during the run
• The percentage of image synchronization verification points that passed during the run
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Related information
Citrix Performance report on page45
Citrix response time percentile report on page50

Citrix response time percentile report
This report shows the 85th, 90th, and 95th percentile response times for all users in a run.
The default percentiles in this report, 85, 90, and 95, are sufficient for most purposes. However, if you are
required to report on a different percentile set, click Window > Preferences > Test > Percentile Analysis
Targets to change the percentiles in this report.
The Summary page shows a graph with three bars, which represent the 85th percentile, 90th percentile,
and 95th percentile response times for all users in the run. For the 85th percentile bar, 85% of all users
achieved the indicated response time or better. For the 90th percentile bar, 90% of all users achieved the
indicated response time or better. And for the 95% percentile bar, 95% of all users achieved the indicated
response time or better.
The 85%, 90%, and 95% pages show the response-time percentiles of the 10 slowest window events in
the run. For example, if you click the tab for the 85th percentile, and the total for a page is 110 (the total is
beneath each bar), you know that 85 percent of the response times for that window event are less than or
equal to 110 milliseconds (ms).
This graph provides an overall idea of the response times for each window event. For example, the
Response Time Measurements page of the Citrix performance report might indicate that a Login screen
is one of the 10 slowest measurements. However, it is possible that one attempt was extremely slow,
but the other attempts were within range. The Citrix response time percentile report shows which
measurements have slow responses because they were slow in general, not because a few responses
(out of many) were extremely slow.
The table beneath the graph provides more detailed information for each window event:
• The minimum response time for the run.
• The average response time for the run.
• The standard deviation of the average response time. The standard deviation tells you how tightly
the data is grouped about the mean. For example, System A and System B both have an average
response time of 12 ms. However, this does not mean that the response times are similar. System
A might have response times of 11, 12, 13, and 12 ms. System B might have response times of 1,
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20, 25, and 2. Although the mean time is the same, the standard deviation of System B is greater
and the response time is more varied.
• The maximum response time for the run.
• The 85th percentile for the run. That is, for this particular measurement, 85% of the response times
were equal to or faster than this time.
• The 90th percentile for the run. That is, for this particular measurement, 90% of the response times
were equal to or faster than this time.
• The 95th percentile for the run. That is, for this particular measurement, 95% of the response times
were equal to or faster than this time.
• The number of attempts in the run.

Related reference
Percentile analysis preferences on page158
Related information
Citrix Performance report on page45
Citrix Verification Points report on page48

Web service reports
When you test a web service, these reports are produced during a run and saved after a run.

Service Performance report
The Service Performance report summarizes the validity of the run, summarizes the data most significant
to the run, shows the response trend of the slowest 10 service calls in the test, the server health
depending on requests, and graphs the response trend of each service calls for a specified interval.

Overall page
The Overall page provides the following information:
• A progress indicator that shows the state of the run.
• The bar graph on the left indicates the percentage of successful service calls during the run.
• The bar graph on the right indicates the percentage of verification points with a Pass status for the
run.
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Summary page
The Summary page summarizes the most important data about the test run, so that you can analyze the
final or intermediate results of a test at a glance.
The Run Summary table displays the following information:
• The number of virtual users that are active and the number of virtual users that have completed
testing. These numbers are updated during the run.
• The elapsed time. This is the total duration of the run, which is displayed in hours, minutes, and
seconds.
• The location and name of the test.
• The results for the computer and for all computers. To see summary results for individual
computers, click the computer name in the Performance Test Runs view.
• The status of the run. This can be Initializing Computers, Adding Users, Running, Performing
Execution History Data Transfer, Stopped, or Complete.
• The total number of virtual users emulated during the test.
The Call Summary section displays the following information:
• The percentage of verification points with a Pass status.
• The total number of verification points with a Fail status.
• The total number of verification points with an Error status.
• The total number of attempted service calls.
• The total number of successful service calls.
• The total number of service calls that produced a timeout.
The Bytes Summary section displays the following information:
• The minimum, maximum, and average number of bytes sent and received for each call in the run.
• The byte rate per second for the run.
• The total number of bytes sent and received for the run.

Response Time Results page
The Response Time Results page shows the average response of the service calls in the test as the test
progresses. With this information, you can evaluate system response during and after the test. The delay
between the moment a service call is invoked and the moment the corresponding message return is
received, determines the Response times.
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The bar chart shows the average response time of each service call. Each bar represents a service call
that was invoked during the test. As you run the test, the bar chart changes, because the response times
are updated dynamically during the run.
The table that follows the bar chart provides the following additional information for each service call:
• The minimum response time during the run.
• The average response time during the run. This matches the information in the chart.
• The maximum response time during the run.
• The standard deviation response time during the run.

Response Time vs. Time Summary page
The Response vs. Time Summary page shows the average response trend as graphed for a
specified interval. You set the Statistics sample interval value in the schedule, as a schedule
property. Measurements that are located in the tests determine the Response times. Response time
measurements can be automatically generated between the last input action before a service call and the
corresponding message return event.
The line graph shows the average response time for all measurements during the run. Each point on the
graph is an average of what has occurred during that interval. The table that follows the graph lists one
number: the total average response time for all measurements in the run.

Response Time vs. Time Details page
The Response vs. Time Details page shows the response trend as graphed for a specified interval. You
set the Statistics sample interval value in the schedule, as a schedule property. The delay between
the moment a service call is invoked and the moment the corresponding message return is received
determines the Response times.
The line graph shows the average response time of each measurement for a specified interval. A separate
line represents each measurement.
The table under the graph provides the following additional information for each response time
measurement:
• The minimum response time during the run.
• The average service call response time during the run. This is similar to the graph, but the
information in the table includes the entire run.
• The maximum service call response time during the run.
• The standard deviation service call response time during the run.
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Data Volume page
The Data Volume page provides details about the volume of data that is sent to and received from the
service. You set the Statistics sample interval value in the schedule, as a schedule property.
• The Sent and Received line graph shows the total bytes sent and received per interval.
• The Received Summary table lists, for each call, the received volume rate (bytes per second) for
the entire run, the minimum and maximum received bytes per interval, and the average number of
bytes received for each call.
• The Sent Summary table table lists, for each call, the sent volume rate (bytes per second) for the
entire run, the minimum and maximum sent bytes per interval, and the average number of bytes
sent for each call.

Call Throughput page
The Call Throughput page provides an overview of the frequency of service calls that are being transferred
per interval. You set the Statistics sample interval value in the schedule, as a schedule property.
• The line graph shows the calls that are started and ended per interval. Ended calls can be: success,
fail, or timeout.
• The Performance Summary table lists the details of the number of call starts, successes, failures
or timeouts for each call and for the run.

Resources page
The Resources page shows information about all the resource counters that were monitored during the
schedule run. You can view the following information as mentioned in the table from the Resources page:
If...

Then the Resources page displays...

If you did not add any Resource Monitoring

A message that states that you must set up the

source to a performance schedule

Resource Monitoring sources to view the re
source details.

If you added Resource Monitoring sources to a
performance schedule

• The Resource Monitoring sources that
were monitored during the schedule run.
• All resource counters for those Resource
Monitoring sources that were monitored
during the schedule run.
• The Unavailable sources section lists the
Resource Monitoring sources that were
unavailable or unreachable during the
schedule run.
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If...

Then the Resources page displays...
Note: The Unavailable sources sec
tion is displayed only if any of the Re
source Monitoring sources were unreach
able or unavailable during the schedule
run.

If you added Resource Monitoring sources by us
ing labels to a performance schedule

• The following information in the Serv
er sources matching the labels set in
the schedule (*Source defined in team
space) section:
◦ Labels and the Resource Monitor
ing sources associated with those
labels that were monitored during
the schedule run.
◦ Resource Monitoring sources that
were unavailable or unreachable
during the schedule run.
◦ An empty array ([]) when you used
labels that were not tagged to any
Resource Monitoring source in Ra
tional® Test Automation Server.
◦ The asterisk (*) symbol is shown
after the name of the Resource
Monitoring source if you add the
Resource Monitoring source at the
team space level in Rational® Test
Automation Server.
• All resource counters for the Resource
Monitoring sources that were monitored
during the schedule run.

If you ran a performance schedule by using the

• The following information in the Serv

overridermlabels command from the Rational®

er sources matching the labels set with

Performance Tester command line

the command-line flag -overridermlabels
(*Source defined in team space) section:
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If...

Then the Resources page displays...
◦ Labels that you used to add the Re
source Monitoring sources to the
schedule for the schedule run.
◦ Resource Monitoring sources as
sociated with those labels that
were monitored during the sched
ule run.
◦ Resource Monitoring sources that
were unavailable or unreachable
during the schedule run.
◦ An empty array ([]) when you used
labels that were not tagged to any
Resource Monitoring source in Ra
tional® Test Automation Server.
◦ The asterisk (*) symbol is shown
after the name of the Resource
Monitoring source if you add the
Resource Monitoring source at the
team space level in Rational® Test
Automation Server.
• All resource counters for the Resource
Monitoring sources that were monitored
during the schedule run.

The Legend shows the Resource Monitoring type and its resource counters. When you have multiple
Resource Monitoring sources, the resource counters for the respective sources are displayed in front of
their Resource Monitoring source name. You can customize the resource counter information displayed
in a graph by clicking any individual resource counter or type of source. You can click or double-click any
individual resource counter for the following results:
• A single click on the resource counter hides the data displayed on the graph. Click the resource
counter again to display the data in the graph.
• A double-click on the resource counter removes information about all other resource counters from
the graph and displays only the information about the selected resource counter.
Tip: You can click Select All option to restore all the resource counter information on the
graph.
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When you click on any of the sources, the graph removes all the resource counters of other sources and
displays only the resource counters of the selected source.
For example, you have an Apache httpd server and a Windows Performance Host as a Resource
Monitoring source. When the schedule completes, the Resources page displays the resource counter
information of both the sources. If you want to analyze the resource counters for any one of the sources,
you can click the Apache httpd server or the Windows Performance Host. Based on your selection, the
graph is updated to show the selected source resource counters information.
The Performance Summary table under the graph lists the most recent values of the resource counters
that were monitored during the schedule run. The first two columns show the Type of the source and
Name of the resource counter. This table also lists the minimum, maximum, and average values of the
resource counters that were monitored during the schedule run.

Related information
Web Service Verification Points report on page57
WSDL Coverage report on page60

Web Service Verification Points report
The web service verification points report shows the status of the verification points in your tests.

Summary page
The Summary page displays a bar graph representing the percentage of successful web service calls for
the test run. You can set the Statistics sample interval value in the schedule, as a schedule property.
The Verification Point Summary Tab table lists the following information:
• The number of verification points that were attempted, passed, and failed during the test run.
• The percentage of verification points that passed per interval during the test run.

Verification Points Detail page
The Verification Points Detail page displays the details for all types of verification points that were
checked during the test run.
The Verification Points Detail table lists the following information:
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• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Response Contain Verification Points page
The Response Contain Verification Points page displays the details of contain verification points that
were checked during the test run.
The Response Contain Verification Points table lists the following information:
• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Response Equal Verification Points page
The Response Equal Verification Points page displays the details of equal verification points that were
checked during the test run.
The Response Equal Verification Points table lists the following information:
• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Response Properties Verification Points page
The Response Properties Verification Points page displays the details of the verification point for the
properties that were checked during the test run.
The Response Properties Verification Points table lists the following information:
• The number of verification points that passed, failed, caused an error, and were inconclusive during
the test run.
• The percentage of verification points that passed during the test run.

Response Query Verification Points page
The Response Query Verification Points page displays the details of query verification points that were
checked during the test run.
The Response Query Verification Points table lists the following information:
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• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Response XSD Verification Points
The Response XSD Verification Points page displays the details of verification points that were checked
during the test run.
The Response XSD Verification Points table lists the following information:
• The number of verification points passed, failed, caused an error, were inconclusive during the test
run.
• The percentage of verification points that passed during the test run.

Response Attachment Verification Points page
The Response Attachment Verification Points page displays the details of attachment verification points
that were checked during the test run.
The Response Attachment Verification Points table lists the following information:
• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Response Text Verification Points
The Response Text Verification Points page displays the details of verification points that were checked
during the test run.
The Response Text Verification Points table lists the following information:
• The number of verification points that passed, failed, caused an error during the test run.
• The percentage of verification points that passed during the test run.

Callback Verification Points
The Callback Verification Points page displays the details of verification points that were checked during
the test run.
The Callback Verification Points table lists the following information:
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• The number of verification points that passed, failed, caused an error, were inconclusive during the
test run.
• The percentage of verification points that passed during the test run.

Related information
Service Performance report on page51
WSDL Coverage report on page60

WSDL Coverage report
The Web Services Description Language (WSDL) Coverage report displays all the bindings, methods, and
ports of a web service that were used in the test, compound test, or schedule. In this report, you can see
the methods or ports that are not called by the test so that they require more tests for better coverage.

Global Summary
To generate a WSDL Coverage report, in the Test Navigator view, right-click a service test result, and click
WSDL Coverage Report.
This section displays the number of tests, verification points, and defects available in the report.

WSDL Coverage Summary
This section includes sub-sections for the name of all the compound tests, schedules, and test runs for
each WSDL service. For example, if you run a compound test that contains four tests and each test runs
a different WSDL service, this section displays a table with four rows for the same compound test but
different WSDL services used. Another table displays each test run with the corresponding WSDL service.
The tables would display a column for the overall coverage percentage of each WSDL service.

WSDL Coverage Details
This section also includes sub-sections for the names of all the compound tests, schedules, and test
runs for each WSDL service. However, this section provides detail coverage information at the bindings,
methods, and ports level for the WSDL service. It reports the verdict and the number of requests sent
and responses received. The Coverage column of the table indicates whether the methods or ports are
called by the test. If the method is called, it shows as 100%. If the method is not called, it shows as 0%.
The percentages are then rolled up to the bindings and WSDL service level.
For example, in the following screenshot, there is one binding
BasicHttpBinding_IStockQuoteService with two methods. The method GetStockQuote is
called by the test. But, the GetWorldMajorIndices method was not called. Therefore, at the binding
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level, you see 50% coverage. As a user of the web service, if the GetWorldMajorIndices method is
required, you can check why it was not used by the test.

Related information
Service Performance report on page51
Web Service Verification Points report on page57

Socket performance test reports
When you test a socket application, these performance test reports are produced during a run and saved
after a run.

Socket Performance report
The Socket Performance report summarizes the health of the run, displays the data most significant to
the run, shows the response trend of the slowest 10 transactions in the test, and graphs the response
trend of each transaction for a specified interval, for socket API performance tests.

Overall page
The Overall page summarizes the most important data about the test run, so that you can analyze the
final or intermediate results of a test at a glance.
The top of the page displays a progress indicator bar that shows the state of the run.
The Virtual Users Activity bar chart displays the number of virtual users that are active and the number of
virtual users that have completed testing. This number is updated during the run.
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The Run Summary section displays the following information:
• The name of the test or schedule.
• The number of virtual users that are active and the number of virtual users that have completed
testing. This number is updated during the run.
• The total number of virtual users that are simulated during the test.
• The elapsed time. This figure is the run duration, which is displayed in hours, minutes, and
seconds.
• The status of the run. This can be Initializing Computers, Adding Users, Running, Performing
Execution History Data Transfer, Stopped, or Complete.
• Results for the computer, All Hosts. To see summary results for individual computers, click the
computer name in the Performance Test Runs view.

Connect Performance page
The Connect Performance page shows the performance of socket connection actions. With this
information, you can evaluate system response during and after the test.
The Connect Actions vs. Time bar chart shows the attempted and successful connection actions during
the test run.
The Connect Times vs. Time bar chart shows average, maximum, minimum, and standard deviation of
connection times during the test run.
The Connect Actions Summary displays this information:
• The number of connections that were attempted
• The number of connections that were successful
The Connect Times Summary displays the average, maximum, minimum, and standard deviation of
connection times.

Send/Receive Performance page
The Send/Receive Performance page shows the data throughput trend as graphed for a specified interval.
The line graph shows the average response time for all socket send and receive actions during the run.
Each point on the graph is an average of what has occurred during that interval. You set the Statistics
sample interval in the schedule as a schedule property.
The Send/Receive Actions vs. Time bar chart shows the attempted and successful send and receive
actions during the test run.
The Response Times vs. Time bar chart shows average, maximum, minimum, and standard deviation of
response times during the test run.
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The Connect Actions Summary displays this information:
• The number of send and receive actions that were attempted
• The number of send and receive actions that were successful
The Connect Times Summary displays the average, maximum, minimum, and standard deviation of
response times.

Byte Performance page
The Byte Performance page provides an overview of the frequency of requests that are being transferred
per interval:
• The Exchanged Bytes vs. Time line graph shows the quantity of bytes sent and received during the
test run.
• The Exchanged Bytes summary table after the graph lists the total number of bytes sent and
received.

HTTP counters
HTTP counters, which are displayed in the Performance Test Runs view, enable you to customize your
reports with dynamic information that is updated for each run.

Byte counters
These counters provide throughput information regarding the rate and the number of bytes sent and
received during a sample interval and during a run.
The counters in the following tables provide an aggregate value for all tests. Folders that contain
aggregate counters have a clock superimposed on them:

Counter name

.

Description

Bytes Received [for

The total number of bytes received for all tests for the entire

Run]

run

Bytes Sent [for Run]

The total number of bytes sent for all tests for the entire run
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Counter name
Count [for Interval]

Description
The total number of bytes received for all tests within the most recent
sample interval

Rate [per second] [for In

The bytes per second received for all tests within the most recent sam

terval]

ple interval

Rate [per second] [for

The bytes per second received for all tests for the entire run

Run]

Counter name
Count [for Interval]

Description
The total number of bytes sent for all tests within the most recent sam
ple interval

Rate [per second] [for In

The bytes per second sent for all tests within the most recent sample in

terval]

terval

Rate [per second] [for Run] The bytes per second sent for all tests for the entire run

Page counters
These counters provide information about page attempts, page hits, response time, response success,
and verification points. Some counters produce an aggregate value, where the values for several pages
are rolled up into one value; others produce values for each page.
Aggregate counters use the values for all the pages in a test to produce a single value for a report. This
value is rolled up from all values that satisfy the counter. When you drag an aggregate counter onto a
report, one value is displayed. Folders that contain aggregate counters have a clock superimposed on the
folder icon:

. The tables below that list aggregate counters have this icon in their title.

Individual counters produce values for each item that satisfies the counter, rather than a single rolled-up
value. Folders that contain individual counters have an asterisk superimposed on the folder icon:

. The

tables below that list individual counters have this icon in their title.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
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Adjustment counters
The counters in this section provide information about adjustments made to page response times.

Counter name
Average [for Interval]

Description
The average of all adjustments applied during the most recent sample
interval

Average [for Run]

The average of all adjustments applied for the entire run

Maximum [for Interval]

The maximum adjustment applied during the most recent sample inter
val

Maximum [for Run]

The maximum adjustment applied for the entire run

Minimum [for Interval]

The minimum adjustment applied during the most recent sample inter
val

Minimum [for Run]

The minimum adjustment applied for the entire run

Standard Deviation [for In The standard deviation for adjustments applied within the most recent
terval]

sample interval

Standard Deviation [for

The standard deviation for adjustments applied for the entire run

Run]
The counters in the following table are available only after a run, and only after you have displayed the
Page Percentile report.

Counter name

Description

85

85% of the users had a maximum adjustment of this amount applied

90

90% of the users had a maximum adjustment of this amount applied

95

95% of the users had a maximum adjustment of this amount applied

Attempt counters
The counters in this section provide information about attempts. When an attempt refers to a page, it
means that the primary request was sent; it does not include requests within the page. When an attempt
refers to a page element, it means that a request was sent.
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Counter name
Count [for Interval]

Description
The number of attempts for a specific page within the most recent sample
interval

Count [for Run]

The number of attempts for a specific page for the entire run

Rate [per second] [for

The rate at which attempts occurred for a specific page during the most re

Interval]

cent sample interval

Rate [per second] [for

The rate at which attempts occurred for a specific page for the entire run

Run]

Counter name

Description

Count [for In

The total number of page attempts completed for a specific page during the most

terval]

recent sample interval

Counter
name

Description

Count [for In

The total number of page attempts completed for a specific page element for the

terval]

most recent sample interval

Counter name
Count [for Interval]

Description
The number of attempts for a specific page element within the most recent
sample interval

Count [for Run]

The number of attempts for a specific page element for the entire run

Rate [per second] [for The rate at which attempts occurred for a specific page element during the
Interval]

most recent sample interval

Rate [per second] [for The rate at which attempts occurred for a specific page element for the en
Run]
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Counter name

Description

Page Attempt Rate [per second] [for The rate at which page attempts occurred within the most re
Interval]

cent sample interval

Page Attempt Rate [per second] [for The rate at which page attempts occurred for the entire run
Run]
Page Element Attempt Rate [per

The rate at which page element attempts occurred within the

second] [for Interval]

most recent sample interval

Page Element Attempt Rate [per

The rate at which page element attempts occurred for the en

second] [for Run]

tire run

Total Page Attempts [for Interval]

The number of page attempts during the most recent sample
interval

Total Page Attempts [for Run]

The number of page attempts for the entire run

Total Page Element Attempts [for In The number of page element attempts within the most recent
terval]

sample interval

Total Page Element Attempts [for

The number of page element attempts for the entire run

Run]
Each counter in the following table provides a single value to the report. This aggregated value has been
calculated from all pages.

Hit counters

Counter name
Count [for Interval]

Description
The number of hits for a specific page within the most recent sample in
terval

Count [for Run]

The number of hits for a specific page for the entire run

Rate [per second] [for In The rate at which hits occurred for a specific page during the most recent
terval]

sample interval

Rate [per second] [for

The rate at which hits occurred for a specific page for the entire run

Run]
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Counter name
Count [for Interval]

Description
The number of hits for a specific page element within the most recent sam
ple interval

Count [for Run]

The number of hits for a specific page element for the entire run

Rate [per second] [for

The rate at which hits occurred for a specific page element during the most

Interval]

recent sample interval

Rate [per second] [for

The rate at which hits occurred for a specific page element for the entire

Run]

run

Counter name

Description

Page Element Hit Rate [per second]

The rate of page element hits during the most recent sample

[for Interval]

interval

Page Element Hit Rate [per second]

The rate of page element hits for the entire run

[for Run]
Page Hit Rate [per second] [for Inter

The rate of page hits during the most recent sample interval

val]
Page Hit Rate [per second] [for Run]

The rate of page hits for the entire run

Total Page Element Hits [for Interval ] The total number of page element hits within the most re
cent sample interval
Total Page Element Hits [for Run]

The total number of page element hits for the entire run

Total Page Hits [for Interval]

The total number of page hits during the most recent sample
interval

Total Page Hits [for Run]

The total number of page hits for the entire run

Response Time counters
Response time counters omit page response times for pages that contain requests with status codes in
the range of 4XX (client errors) to 5XX (server errors). The only exception is when the failure (for example,
a 404) is recorded and returned, and the request is not the primary request for the page. Page response
times that contain requests that time out are always discarded.
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Counter name

Description

Average [for Interval]

The average response time for a specific page within the most recent
sample interval

Average [for Run]

The average response time for a specific page for the entire run

Maximum [for Interval]

The maximum response time for a specific page within the most recent
sample interval

Maximum [for Run]

The maximum response time for a specific page for the entire run

Minimum [for Interval]

The minimum response time for a specific page within the most recent
sample interval

Minimum [for Run]

The minimum response time for a specific page for the entire run

Standard Deviation [for In The standard deviation for a specific page within the most recent sam
terval]

ple interval

Standard Deviation [for

The standard deviation for a specific page for the entire run

Run]

Counter name

Description

Average [for Inter

The average response time for a specific page within the most recent sample

val]

interval

Average [for Run]

The average response time for a specific page for the entire run

The counters in the following table are available only after a run, and only after you have displayed the
Page Percentile report.

Counter name
85

Description
85% of the users experienced this response time or better on this specific
page

90

90% of the users experienced this response time or better on this specific
page
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Counter name
95

Description
95% of the users experienced this response time or better on this specific
page

The counters in the following table are available only after a run, and only after you have displayed the
Page Percentile report.

Counter name
85

Description
85% of the users experienced this response time or bet
ter

90

90% of the users experienced this response time or bet
ter

95

95% of the users experienced this response time or bet
ter

Response time counters omit page response times for pages that contain requests with status codes in
the range of 4XX (client errors) to 5XX (server errors). The only exception is when the failure (for example,
a 404) is recorded and returned, and the request is not the primary request for the page. Page response
times that contain requests that time out are always discarded.

Counter name

70

Description

Average Response Time for All Page Ele

The average response time for all page elements with

ments [ms] [for Interval]

in the most recent sample interval

Average Response Time for All Page Ele

The average response time for all page elements for

ments [ms] [for Run]

the entire run

Average Response Time for All Pages [ms]

The average response time for all pages within the

[for Interval]

most recent sample interval

Average Response Time for All Pages [ms]

The average response time for all pages for the entire

[for Run]

run

Maximum Response Time for All Pages

The maximum response time for all pages within the

[ms] [for Interval]

most recent sample interval
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Counter name

Description

Maximum Response Time for All Pages

The maximum response time for all pages for the en

[ms] [for Run]

tire run

Minimum Response Time for All Pages

The minimum response time for all pages within the

[ms] [for Interval]

most recent sample interval

Minimum Response Time for All Pages

The minimum response time for all pages for the en

[ms] [for Run]

tire run

Response Time Standard Deviation for All

The standard deviation for all page elements within

Page Elements [for Interval]

the most recent sample interval

Response Time Standard Deviation for All

The standard deviation for all page elements for the

Page Elements [for Run]

entire run

Response Time Standard Deviation for All

The standard deviation for all pages within the most

Pages [for Interval]

recent sample interval

Response Time Standard Deviation for All

The standard deviation for all pages for the entire run

Pages [for Run]

Status Code Success counters
A status code success means that the response code verification point passed for that request. If the
request has no verification points, a success means that the server received a request and returned a
response where the status code was in the 200 or 300 category, or returned an expected response in the
400 or 500 category.

Counter name
Count [for Interval]

Description
The number of status code successes for a specific page during the
most recent sample interval

Count [for Run]

The number of status code successes for a specific page for the en
tire run

Percent Status Code Suc

The percentage of status code successes for a specific page during

cess [for Interval]

the most recent sample interval

Percent Status Code Suc

The percentage of status code successes for a specific page for the

cess [for Run]

entire run
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Counter name

Description

Count [for Interval]

The number of status code successes for a spe
cific page element during the most recent sam
ple interval

Count [for Run]

The number of status code successes for a spe
cific page element for the entire run

Percent Status Code Success [for Interval]

The percentage of status code successes for a
specific page element during the most recent
sample interval

Percent Status Code Success [for Run]

The percentage of status code successes for a
specific page element for the entire run

Counter name
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Description

Percent Page Element Status

The percentage of status code successes for all page elements

Code Success [for Interval]

during the most recent sample interval

Percent Page Element Status

The percentage of status code successes for all page elements

Code Success [for Run]

for the entire run

Percent Page Status Code Suc

The percentage of status code successes for all pages during

cess [for Interval]

the most recent sample interval

Percent Page Status Code Suc

The percentage of status code successes for all pages for the

cess [for Run]

entire run

Total Page Element Status Code

The number of status code successes for all page elements

Successes [for Interval]

during the most recent sample interval

Total Page Element Status Code

The number of status code successes for all page elements for

Successes [for Run]

the entire run

Total Page Status Code Success

The number of status code successes for all pages within the

es [for Interval]

most recent sample interval

Total Page Status Code Success

The number of status code successes for all pages for the en

es [for Run]

tire run
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Verification Point counters
The tables in this section provide information about verification points. The verdict for a verification point
can be Pass, Fail, Error, or Inconclusive.
• Pass indicates that all verification points matched or received the expected response. For example,
a response code verification point is set to PASS when the recorded response code is received
during playback. If your test does not contain verification points, PASS means that all primary
requests in the test were successful.
• Fail indicates that at least one verification point did not match the expected response or that the
expected response was not received.
• Error indicates one of the following results: a primary request was not successfully sent to the
server, no response was received from the server for a primary request, or the primary request
response was incomplete or could not be parsed.
• The verdict is set to Inconclusive only if you provide custom code that defines a verdict of
Inconclusive.

Counter

Description

name
Percent

The percentage of page title verification points that passed for a specific page for the

Pass

entire run

Counter
name

Description

Percent

The percentage of response code or response size verification points that passed for a

Pass

specific page element for the entire run

Counter
name

Description

Count [for The number of response code or response size verification points classified as Error
Interval]

for a specific page element during the most recent sample interval

Count [for The number of response code or response size verification points classified as Error
Run]

for a specific page element for the entire run
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Counter

Description

name
Count [for

The number of response code or response size verification points that failed for a spe

Interval]

cific page element during the most recent sample interval

Count [for

The number of response code or response size verification points that failed for a spe

Run]

cific page element for the entire run

Counter

Description

name
Count

The number of response code or response size verification points classified as Incon-

[for Inter clusive for a specific page element during the most recent sample interval
val]
Count

The number of response code or response size verification points classified as Incon-

[for Run]

clusive for a specific page element for the entire run

Counter

Description

name

Count [for The number of response code or response size verification points that passed for a
Interval]

specific page element during the most recent sample interval

Count [for The number of response code or response size verification points that passed for a
Run]

specific page element for the entire run

Counter

Description

name
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Count [for

The number of response code or response size verification points classified as Error

Interval]

for a specific page during the most recent sample interval

Count [for

The number of response code or response size verification points classified as Error

Run]

for a specific page for the entire run
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Counter

Description

name
Count [for

The number of response code or response size verification points that failed for a spe

Interval]

cific page during the most recent sample interval

Count [for

The number of response code or response size verification points that failed for a spe

Run]

cific page for the entire run

Counter

Description

name

Count [for The number of response code or response size verification points classified as InconInterval]

clusive for a specific page during the most recent sample interval

Count [for The number of response code or response size verification points classified as InconRun]

clusive for a specific page for the entire run

Counter

Description

name
Count [for

The number of response code or response size verification points that passed for a

Interval]

specific page during the most recent sample interval

Count [for

The number of response code or response size verification points that passed for a

Run]

specific page for the entire run

Counter name

Description

Percent Page Element

The percentage of response code or response size verification points

VPs Passed [for Interval]

that passed during the most recent sample interval

Percent Page Element

The percentage of response code or response size verification points

VPs Passed [for Run]

that passed for the entire run

Percent Page VPs

The percentage of page title verification points that passed during the

Passed [for Interval]

most recent sample interval
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Counter name

Description

Percent Page VPs

The percentage of page title verification points that passed for the entire

Passed [for Run]

run

Total Page Element VPs

The number of response code or response size verification points exe

Attempted [for Interval]

cuted during the most recent sample interval

Total Page Element VPs

The number of response code or response size verification points exe

Attempted [for Run]

cuted for the entire run

Total Page Element VPs

The number of response code or response size verification points with a

Error [for Interval]

verdict of Error within the most recent sample interval

Total Page Element VPs

The number of response code or response size verification points with a

Error [for Run]

verdict of Error for the entire run

Total Page Element VPs

The number of response code or response size verification points that

Failed [for Interval]

failed during the most recent sample interval

Total Page Element VPs

The number of response code or response size verification points that

Failed [for Run]

failed for the entire run

Total Page Element VPs

The number of response code or response size verification points that

Inconclusive [for Interval] were marked as Inconclusive within the most recent sample interval
Total Page Element VPs

The number of response code or response size verification points that

Inconclusive [for Run]

were marked as Inconclusive for the entire run

Total Page Element VPs

The number of response code or response size verification points that

Passed [for Interval]

passed during the most recent sample interval

Total Page Element VPs

The number of response code or response size verification points that

Passed [for Run]

passed for the entire run

Total Page VPs Attempt

The percentage of page title verification points that were executed dur

ed [for Interval]

ing the most recent sample interval

Total Page VPs Attempt

The percentage of page title verification points that were executed for

ed [for Run]

the entire run

Total Page VPs Error [for The percentage of page title verification points with a verdict of Error
Interval]

during the most recent sample interval

Total Page VPs Error [for For each page that contains verification points, the total with a verdict of
Run]
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Counter name

Description

Total Page VPs Failed

The number of page title verification points that failed during the most

[for Interval]

recent sample interval

Total Page VPs Failed

The number of page title verification points that failed for the entire run

[for Run]
Total Page VPs Inconclu The number of page title verification points that were marked as Inconsive [for Interval]

clusive during the most recent sample interval

Total Page VPs Inconclu The number of page title verification points that were marked as Inconsive [for Run]

clusive for the entire run

Total Page VPs Passed

The number of page title verification points that passed during the most

[for Interval]

recent sample interval

Total Page VPs Passed

The number of page title verification points that passed for the entire run

[for Run]

Run counters
These counters provide information about the active users in the run, the users that have completed the
run, and the HTTP status codes that were received.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule
as a schedule property.

Counter name
Displaying Results for comput

Description
The name of the host.

er
Run Status

The run status or er
rors.

Counter name

Description

Count [for Run] The number of users that are currently ac
tive.
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Counter
Name
Count

Description
The length of time it took to collect all the statistics to send for the most recent sample

[for Inter interval. Typically a brief period. This value has limited use in a custom report.
val]

Counter name

Description

Count [for Run] The number of users that have completed the run.

Counter
Name

Description

Count [for In The number of HTTP status codes between 100 and 199 that were received during
terval]

the most recent sample interval.

Count [for

The number of HTTP status codes between 100 and 199 that were received in the

Run]

entire run.

Counter
name

Description

Count [for In The number of HTTP status codes between 200 and 299 that were received during
terval]

the most recent sample interval.

Count [for

The number of HTTP status codes between 200 and 299 that were received in the

Run]

entire run.

Counter
name

Description

Count [for In The number of HTTP status codes between 300 and 399 that were received during
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terval]

the most recent sample interval.

Count [for

The number of HTTP status codes between 300 and 399 that were received in the

Run]

entire run.
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Counter
name

Description

Count [for In The number of HTTP status codes between 400 and 499 that were received during
terval]

the most recent sample interval.

Count [for

The number of HTTP status codes between 400 and 499 that were received in the

Run]

entire run.

Counter
name

Description

Count [for In The number of HTTP status codes between 500 and 599 that were received during
terval]

the most recent sample interval.

Count [for

The number of HTTP status codes between 500 and 599 that were received in the

Run]

entire run.

Counter name
Count [for Run]

Description
The duration of the run, in milliseconds (ms).

Elapsed Time [H:M:S] The duration of the run, in hours, minutes, and sec
onds.

Counter name

Description

Count [for Run] The length of the sample interval.

Counter name

Description

Executed Test The web address of the schedule or test that was
run.
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Counter name

Description

Count [for Run] The clock value at the start of the run, in milliseconds
(ms).

Counter Name

Description

Count [for Run] The total number of users that were involved in the
run.

Test counters
These counters provide information about the execution time of the tests in a run. Some counters
produce an aggregate value, where the values for all tests are rolled up into one value; others produce
individual values for each test.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all tests. Folders that contain aggregate
counters have a clock superimposed on them:

Counter name
Average [for Interval]

.

Description
The average execution time for all tests within the most recent sample
interval

Average [for Run]

The average execution time for all tests in the entire run

Maximum [for Interval]

The maximum execution time for all tests within the most recent sam
ple interval

Maximum [for Run]

The maximum execution time for all tests in the entire run

Minimum [for Interval]

The minimum execution time for all tests within the most recent sam
ple interval

Minimum [for Run]

80

The minimum execution time for all tests in the entire run

Chapter 1. Reference Guide

Counter name

Description

Standard Deviation [for In

The standard deviation for all tests within the most recent sample in

terval]

terval

Standard Deviation [for

The standard deviation for all tests in the entire run

Run]
The counters in the following table provide individual values for each test. Folders that contain individual
counters have an asterisk superimposed on them:

.

Counter name

Description

Average Execution Time for All Tests [ms] The average execution time for each test within the
[for Interval]

most recent sample interval

Average Execution Time for All Tests [ms] The average execution time for each test in the entire
[for Run]

run

Execution Time Standard Deviation for All The standard deviation for each test within the most re
Tests [for Interval]

cent sample interval

Execution Time Standard Deviation for All The standard deviation for each test in the entire run
Tests [for Run]
Maximum Execution Time for All Tests

The maximum execution time for each test within the

[ms] [for Interval]

most recent sample interval

Maximum Execution Time for All Tests

The maximum execution time for each test in the entire

[ms] [for Run]

run

Minimum Execution Time for All Tests

The minimum execution time for each test within the

[ms] [for Interval]

most recent sample interval

Minimum Execution Time for All Tests

The minimum execution time for each test in the entire

[ms] [for Run]

run

Transaction counters
These counters provide information about transactions that were attempted, transactions that were
completed, and the elapsed time for the transactions. Some counters produce an aggregate value, where
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the values for all transactions are rolled up into one value; others produce individual values for each
transaction.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:

Counter name
Count [for Interval]

.

Description
The total number of transactions that were attempted within the last
recorded interval

Count [for Run]

The total number of transactions that were attempted in the entire run

Rate [per second] [for In The number of transactions that were attempted per second in the last
terval]

recorded interval

Rate [per second] [for

The number of transactions that were attempted per second in the entire

Run]

run

The counters in the following table provide individual values for each transaction. Folders that contain
individual counters have an asterisk superimposed on them:

.

Counter name

Description

Total Transactions Started [for Inter

The number of transactions that were started within the last

val]

recorded interval

Transaction Start Rate [per second]

The rate that transactions that were started within the last

[for Interval]

recorded interval

Transaction Start Rate [per second]

The rate that transactions that were started in the entire run

[for Run]
The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:
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Counter name
Count [for Interval]

Description
The total number of transactions that were completed within the last
recorded interval

Count [for Run]

The total number of transactions that were completed in the entire run

Rate [per second] [for In The number of transactions that were completed per second in the last
terval]

recorded interval

Rate [per second] [for

The number of transactions that were completed per second in the entire

Run]

run

The counters in the following table provide individual values for each transaction. Folders that contain
individual counters have an asterisk superimposed on them:

.

Counter name

Description

Total Transactions Completed [for Run]

The total number of transactions that were completed

Transaction Completion Rate [per second]

The rate that transactions were completed in the last

[for Interval]

recorded interval

Transaction Completion Rate [per second]

The rate that transactions were completed in the entire

[for Run]

run

The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:

Counter name
Average [for Interval]

.

Description
The average elapsed time for all transactions within the most recent
sample interval

Average [for Run]

The average elapsed time for all transactions in the entire run

Maximum [for Interval]

The maximum elapsed time for all transactions within the most recent
sample interval

Maximum [for Run]

The maximum elapsed time for all transactions in the entire run
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Counter name
Minimum [for Interval]

Description
The minimum elapsed time for all transactions within the most recent
sample interval

Minimum [for Run]

The minimum elapsed time for all transactions in the entire run

Standard deviation [for In The standard deviation for all transactions within the most recent sam
terval]

ple interval

Standard deviation [for

The standard deviation for all transactions for the entire run

Run]
The counters in the following table provide individual values for each transaction. Folders that contain
individual counters have an asterisk superimposed on them:

Counter name
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Description

Average Elapsed Time for All Transac

The average elapsed time for each transaction within

tions [ms] [for Interval]

the most recent sample interval

Average Elapsed Time for All Transac

The average elapsed time for each transaction in the en

tions [ms] [for Run]

tire run

Elapsed Time Standard Deviation for All

The standard deviation for each transaction within the

Transactions [for Interval]

most recent sample interval

Elapsed Time Standard Deviation for All

The standard deviation for each transaction in the entire

Transactions [for Run]

run

Maximum Elapsed Time for All Transac

The maximum elapsed time for each transaction within

tions [ms] [for Interval]

the most recent sample interval

Maximum Elapsed Time for All Transac

The maximum elapsed time for each transaction in the

tions [ms] [for Run]

entire run

Minimum Elapsed Time for All Transac

The minimum elapsed time for each transaction within

tions [ms] [for Interval]

the most recent sample interval

Minimum Elapsed Time for All Transac

The minimum elapsed time for each transaction in the

tions [ms] [for Run]

entire run
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Recording with Internet Protocol v6
To record Internet Protocol version 6 traffic, set the HTTP recording preferences to Firefox and select
Record using IPv6.
1. Click Windows > Preferences > Test > RPT HTTP recording.
2. In Application to record, select Firefox.
You cannot use Internet Explorer to record IPv6.
3. Select Record using IPv6.
You are now ready to record IPv6 traffic.

Changing HTTP recording preferences
You can change the behavior of the recorder by changing the preference settings. The default settings,
however, are appropriate for recording under Windows® or Linux® systems.
1. Open the HTTP Recording page. Click Window > Preferences > Test > Recording > Browsers
Recording.
2. Select the setting to change.
Enable the Rational® Performance Tester toolbar in browsers
Click to install the annotation toolbar. This enables you to add comments and
transactions, and to change page names during recording.
Verify annotation toolbar is installed before recording
Click to verify that the annotation toolbar is installed in the web browser before
recording.
3. After changing a setting, click Apply.

SAP counters
SAP generic counters, which are displayed in the Performance Test Runs view, enable you to customize
your SAP reports with dynamic information that is updated for each run.
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SAP screen counters
These counters provide information about screens started, screens completed, response times, and
verification points. Some counters produce an aggregate value, where the values for several screens are
rolled up into one value; others produce values for each screen.
Aggregate counters use the values for all the screens in a test to produce a single value for a report. This
value is rolled up from all values that satisfy the counter. When you drag an aggregate counter onto a
report, one value is displayed. Folders that contain aggregate counters have a clock superimposed on the
folder icon:

. The tables below that list aggregate counters have this icon in their title.

Individual counters produce values for each item that satisfies the counter, rather than a single rolled-up
value. Folders that contain individual counters have an asterisk superimposed on the folder icon:

. The

tables below that list individual counters have this icon in their title.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.

SAP Screen Request Response Time counters
The counters in this section provide information about the SAP application response time. This is the
time that elapses from the point that the SAP GUI client sends a request and the moment the response is
received and displayed by the SAP GUI client.

Counter name
Average [for Interval]

Description
The average response time for a specific SAP screen during the most recent
sample interval

Average [for Run]

The average response time for a specific SAP screen for the entire run

Maximum [for Inter

The maximum response time for a specific SAP screen during the most re

val]

cent sample interval

Maximum [for Run]

The maximum response time for a specific SAP screen for the entire run

Minimum [for Interval] The minimum response time for a specific SAP screen during the most re
cent sample interval
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The minimum response time for a specific SAP screen for the entire run

Standard Deviation

The standard deviation of response times for a specific SAP screen during

[for Interval]

the most recent sample interval
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Counter name

Description

Standard Deviation

The standard deviation of response times for a specific SAP screen for the

[for Run]

entire run

Counter name

Description

Average Screen Request Response Time for

The average response time for all SAP screens with

All SAP Screens [ms] [for Interval]

in the most recent sample interval

Average Screen Request Response Time for

The average response time for all SAP screens for

All SAP Screens [ms] [for Run]

the entire run

Maximum Screen Request Response Time for The maximum response time for all SAP screens
All SAP Screens [ms] [for Interval]

within the most recent sample interval

Maximum Screen Request Response Time for The maximum response time for all SAP screens for
All SAP Screens [ms] [for Run]

the entire run

Minimum Screen Request Response Time for

The minimum response time for all SAP screens

All SAP Screens [ms] [for Interval]

within the most recent sample interval

Minimum Screen Request Response Time for

The minimum response time for all SAP screens for

All SAP Screens [ms] [for Run]

the entire run

Standard Deviation Screen Request Response The standard deviation of response times for all
Time for All SAP Screens [ms] [for Interval]

SAP screens during the most recent sample interval

Standard Deviation Screen Request Response The standard deviation of response times for all
Time for All SAP Screens [ms] [for Run]

SAP screens for the entire run

SAP Screen Request Interpretation Time counters
The counters in this section provide information about the SAP GUI interpretation time. This is the
duration from the time that the SAP GUI client receives data from the server and the moment when
this data is displayed. This measures the health of the SAP GUI client used for the test rather than the
performance of the SAP server.

Counter name

Description

Average [for Interval] The average interpretation time for a specific SAP screen during the most re
cent sample interval
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Counter name

Description

Average [for Run]

The average interpretation time for a specific SAP screen for the entire run

Maximum [for Inter

The maximum interpretation time for a specific SAP screen during the most

val]

recent sample interval

Maximum [for Run]

The maximum interpretation time for a specific SAP screen for the entire run

Minimum [for Inter

The minimum interpretation time for a specific SAP screen during the most

val]

recent sample interval

Minimum [for Run]

The minimum interpretation time for a specific SAP screen for the entire run

Standard Deviation

The standard deviation of interpretation times for a specific SAP screen dur

[for Interval]

ing the most recent sample interval

Standard Deviation

The standard deviation of interpretation times for a specific SAP screen for

[for Run]

the entire run

Counter name

Description

Average Screen Request Interpretation Time

The average interpretation time for all SAP screens

for All SAP Screens [ms] [for Interval]

during the most recent sample interval

Average Screen Request Interpretation Time

The average interpretation time for all SAP screens

for All SAP Screens [ms] [for Run]

for the entire run

Maximum Screen Request Interpretation Time The maximum interpretation time for all SAP
for All SAP Screens [ms] [for Interval]

screens during the most recent sample interval

Maximum Screen Request Interpretation Time The maximum interpretation time for all SAP
for All SAP Screens [ms] [for Run]

screens for the entire run

Minimum Screen Request Interpretation Time The minimum interpretation time for all SAP
for All SAP Screens [ms] [for Interval]

screens during the most recent sample interval

Minimum Screen Request Interpretation Time The minimum interpretation time for all SAP
for All SAP Screens [ms] [for Run]

screens for the entire run

Standard Deviation Screen Request Interpre

The standard deviation of interpretation times for all

tation Time for All SAP Screens [ms] [for Inter SAP screens during the most recent sample interval
val]

88

Chapter 1. Reference Guide

Counter name

Description

Standard Deviation Screen Request Interpreta The standard deviation of interpretation times for all
tion Time for All SAP Screens [ms] [for Run]

SAP screens for the entire run

SAP Screens Started counters
The counters in this section provide information about screens that are started.

Counter name
Count [for Interval]

Description
The number of started screens for a specific SAP screen during the most re
cent sample interval

Count [for Run]

The number of started screens for a specific SAP screen for the entire run

Rate [per second] [for The rate at which screens were started for a specific SAP screen during the
Interval]

most recent sample interval

Rate [per second] [for The rate at which screens were started for a specific SAP screen for the en
Run]

tire run

Counter name

Description

SAP Screens Started Rate [for

The rate at which SAP screens were started within the most recent

Interval]

sample interval

SAP Screens Started Rate [for

The rate at which SAP screens were started for the entire run

Run]
Total SAP Screens Started [for

The number of started SAP screens for the entire run

Interval]
Total SAP Screens Started [for

The number of started SAP screens during the most recent sample

Run]

interval

SAP Screens Completed counters
The counters in this section provide information about SAP screens that were completed.
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Counter name
Count [for Interval]

Description
The number of completed screens for a specific SAP screen during the most
recent sample interval

Count [for Run]

The number of completed screens for a specific SAP screen for the entire
run

Rate [per second]

The rate at which screens were completed for a specific SAP screen during

[for Interval]

the most recent sample interval

Rate [per second]

The rate at which screens were completed for a specific SAP screen for the

[for Run]

entire run

Counter name

Description

SAP Screens Completed Percent

The percentage of completed SAP screens within the most re

[for Interval]

cent sample interval

SAP Screens Completed Percent

The percentage of completed SAP screens for the entire run

[for Run]
SAP Screens Completed Rate [for The rate at which SAP screens were completed within the most
Interval]

recent sample interval

SAP Screens Completed Rate [for The rate at which SAP screens were completed for the entire run
Run]
Total SAP Screens Completed

The number of completed SAP screens within the most recent

[for Interval]

sample interval

Total SAP Screens Completed

The number of completed SAP screens for the entire run

[for Run]

Verification Point counters
The tables in this section provide information about SAP screen verification points. The verdict for a
verification point can be Pass, Fail, Error, or Inconclusive.
• Pass indicates that the verification point matched or received the expected response. For example,
a response code verification point is set to Pass when the recorded response code is received
during playback. If your test does not contain verification points, it means that the connection
succeeded.
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• Fail indicates that the verification point did not match the expected response or that the expected
response was not received.
• Error indicates that the primary request was not successfully sent to the server, no response was
received from the server, or the response was incomplete or could not be parsed.
• The verdict is set to Inconclusive only if you provide custom code that defines a verdict of
Inconclusive.

Counter

Description

name
Percent

The percentage of verification points that passed for a specific SAP screen for the

Pass

entire run

Counter

Description

name

Count [for In The number of verification points classified as Error for a specific SAP screen during
terval]

the most recent sample interval

Count [for

The number of verification points classified as Error for a specific SAP screen for

Run]

the entire run

Counter

Description

name
Count [for In

The number of verification points that failed for a specific SAP screen during the

terval]

most recent sample interval

Count [for

The number of verification points that failed for a specific SAP screen for the entire

Run]

run

Counter
name

Description

Count [for

The number of verification points classified as Inconclusive for a specific SAP

Interval]

screen during the most recent sample interval
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Counter

Description

name
Count [for

The number of verification points classified as Inconclusive for a specific SAP

Run]

screen for the entire run

Counter

Description

name
Count [for In

The number of verification points that passed for a specific SAP screen during the

terval]

most recent sample interval

Count [for

The number of verification points that passed for a specific SAP screen for the en

Run]

tire run

Counter name

Description

Percent SAP Screens VPs

The percentage of verification points that passed within the most

Passed [for Interval]

recent sample interval

Percent SAP Screens VPs

The percentage of verification points that passed for the entire run

Passed [for Run]
Total SAP Screens VPs At

The number of verification points executed within the most recent

tempted [for Interval]

sample interval

Total SAP Screens VPs At

The number of verification points executed for the entire run

tempted [for Run]
Total SAP Screens VPs Error

The number of verification points with a verdict of Error within the

[for Interval]

most recent sample interval

Total SAP Screens VPs Error

The number of verification points with a verdict of Error for the en

[for Run]

tire run

Total SAP Screens VPs Failed

The number of verification points that failed within the most recent

[for Interval]

sample interval

Total SAP Screens VPs Failed

The number of verification points that failed for the entire run

[for Run]
Total SAP Screens VPs Incon The number of verification points that were marked as Inconcluclusive [for Interval]
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Counter name

Description

Total SAP Screens VPs Incon The number of verification points that were marked as Inconcluclusive [for Run]

sive for the entire run

Total SAP Screens VPs

The number of verification points that passed within the most re

Passed [for Interval]

cent sample interval

Total SAP Screens VPs

The number of verification points that passed for the entire run

Passed [for Run]

SAP Elements Attempted counters
The counters in this section provide information about SAP set elements, SAP get elements or SAP calls
that were attempted.

Counter name
Count [for Interval]

Description
The number of attempted elements for a specific SAP screen during the
most recent sample interval

Count [for Run]

The number of attempted elements for a specific SAP screen for the entire
run

Rate [per second]

The rate at which elements were attempted for a specific SAP screen within

[for Interval]

the most recent sample interval

Rate [per second]

The rate at which elements were attempted for a specific SAP screen for the

[for Run]

entire run

Counter name

Description

SAP Elements Attempted Rate

The rate at which SAP elements were attempted within the most

[for Interval]

recent sample interval

SAP Elements Attempted Rate

The rate at which SAP elements were attempted for the entire run

[for Run]
Total SAP Elements Attempted

The number of attempted SAP elements for the entire run

[for Interval]
Total SAP Elements Attempted

The number of attempted SAP elements within the most recent

[for Run]

sample interval
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SAP Elements Completed counters
The counters in this section provide information about SAP set elements, SAP get elements or SAP calls
that terminated normally. If an element does not complete, it is counted in the SAP Elements Attempted,
but not in SAP Elements Complete.

Counter name
Count [for Interval]

Description
The number of completed elements for a specific SAP screen during the
most recent sample interval

Count [for Run]

The number of completed elements for a specific SAP screen for the entire
run

Rate [per second]

The rate at which elements were completed for a specific SAP screen during

[for Interval]

the most recent sample interval

Rate [per second]

The rate at which elements were completed for a specific SAP screen for the

[for Run]

entire run

Counter name

Description

SAP Elements Completed Percent The percentage of completed SAP elements within the most re
[for Interval]

cent sample interval

SAP Elements Completed Percent The percentage of completed SAP elements for the entire run
[for Run]
SAP Elements Completed Rate

The rate at which SAP elements were completed within the

[for Interval]

most recent sample interval

SAP Elements Completed Rate

The rate at which SAP elements were completed for the entire

[for Run]

run

Total SAP Elements Completed

The number of completed SAP elements within the most recent

[for Interval]

sample interval

Total SAP Elements Completed

The number of completed SAP elements for the entire run

[for Run]
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Citrix counters
Citrix generic counters, which are displayed in the Performance Test Runs view, enable you to customize
your Citrix reports with dynamic information that is updated for each run.

Citrix window synchronization counters
Citrix window synchronization counters provide information about window synchronizations that were
attempted, completed, or produced a timeout within the specified timeout limit. Window synchronization
is the mechanism used by the test to compare windows from the test with actual windows in the run.
Some counters produce an aggregate value, where the values for several web service message returns
are combined into a single value; others produce values for each web service message return.
• Aggregate counters use the values for all the elements in a test to produce a single value for a
report. This value is rolled up from all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
superimposed on the folder icon:

. In the tables that follow, the aggregate counters are listed

after the titles that contain this icon.
• Individual counters produce values for each item that satisfies the counter, rather than an
aggregate value. Folders that contain individual counters have an asterisk superimposed on
the folder icon:

. In the tables that follow, the individual counters are listed after the titles that

contain this icon.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all window synchronizations. Folders
that contain aggregate counters have a clock superimposed on them:

Counter name

.

Description

Count [for In

The total number of window synchronizations that were attempted within the last

terval]

recorded interval

Count [for Run] The total number of window synchronizations that were attempted in the entire run
The counters in the following table provide an aggregate value for all window synchronizations. Folders
that contain aggregate counters have a clock superimposed on them:

.
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Counter name
Count [for Interval]

Description
The total number of window synchronizations that succeeded
within the last recorded interval

Count [for Run]

The total number of window synchronizations that succeeded in
the entire run

Percent Citrix Synchronization

The percentage of window synchronizations that succeeded

Success for Interval

within the last recorded interval

Percent Citrix Synchronization

The percentage of window synchronizations that succeeded in

Success for Run

the entire run

The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:

Counter name

.

Description

Count [for In

The total number of window synchronizations that produced a timeout within the

terval]

last recorded interval

Count [for

The total number of window synchronizations that produced a timeout in the entire

Run]

run

Related information
Citrix image synchronization counters on page96
Citrix timer counters on page100
Citrix user action counters on page102
Citrix window counters on page103

Citrix image synchronization counters
Citrix image synchronization counters provide information about image synchronizations that were
attempted, completed, or produced a timeout within the specified timeout limit. Image synchronization is
the mechanism used by the test to compare image areas from the test with actual image area in the run.
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Some counters produce an aggregate value, where the values for several web service message returns
are combined into a single value; others produce values for each web service message return.
• Aggregate counters use the values for all the elements in a test to produce a single value for a
report. This value is rolled up from all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
superimposed on the folder icon:

. In the tables that follow, the aggregate counters are listed

after the titles that contain this icon.
• Individual counters produce values for each item that satisfies the counter, rather than an
aggregate value. Folders that contain individual counters have an asterisk superimposed on
the folder icon:

. In the tables that follow, the individual counters are listed after the titles that

contain this icon.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all image synchronizations. Folders
that contain aggregate counters have a clock superimposed on them:

Counter name

.

Description

Count [for Inter The total number of image synchronizations that were attempted within the last
val]

recorded interval

Count [for Run] The total number of image synchronizations that were attempted in the entire run
The counters in the following table provide an aggregate value for all image synchronizations. Folders
that contain aggregate counters have a clock superimposed on them:

Counter name
Count [for Interval]

.

Description
The total number of image synchronizations that succeeded
within the last recorded interval

Count [for Run]

The total number of image synchronizations that succeeded in
the entire run

Percent Citrix Synchronization

The percentage of image synchronizations that succeeded

Success for Interval

within the last recorded interval
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Counter name

Description

Percent Citrix Synchronization

The percentage of image synchronizations that succeeded in

Success for Run

the entire run

The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:

Counter name

.

Description

Count [for In

The total number of image synchronizations that produced a timeout within the last

terval]

recorded interval

Count [for Run] The total number of image synchronizations that produced a timeout in the entire
run

Counter

Description

name
Percent

The percentage of image synchronization verification points that passed for a specific

Pass

window event for the entire run

Counter

Description

name
Count [for

The number of image synchronization verification points classified as Error for a spe

Interval]

cific window event during the most recent sample interval

Count [for

The number of image synchronization verification points classified as Error for a spe

Run]

cific window for the entire run

Counter
name
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dow event during the most recent sample interval
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Counter

Description

name
Count [for

The number of image synchronization verification points that failed for a specific win

Run]

dow event for the entire run

Counter

Description

name

Count [for The number of image synchronization verification points classified as Inconclusive for
Interval]

a specific window event during the most recent sample interval

Count [for The number of image synchronization verification points classified as Inconclusive for
Run]

a specific window event for the entire run

Counter

Description

name
Count [for

The number of image synchronization verification points that passed for a specific

Interval]

window event during the most recent sample interval

Count [for

The number of image synchronization verification points that passed for a specific

Run]

window event for the entire run

Counter name

Description

Percent Image Synchroniza

The percentage of image synchronization verification points that

tion VPs Passed For Interval

passed during the most recent sample interval

Percent Image Synchroniza

The percentage of image synchronization verification points that

tion VPs Passed For Run

passed for the entire run

Total Image Synchronization

The number of image synchronization verification points executed

VPs Attempted [for Interval]

during the most recent sample interval

Total Image Synchronization

The number of image synchronization verification points executed

VPs Attempted [for Run]

for the entire run

Total Image Synchronization

The number of image synchronization verification points with a ver

VPs Error [for Interval]

dict of Error during the most recent sample interval
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Counter name

Description

Total Image Synchronization

The number of image synchronization verification points with a ver

VPs Error [for Run]

dict of Error for the entire run

Total Image Synchronization

The number of image synchronization verification points that failed

VPs Failed [for Interval]

during the most recent sample interval

Total Image Synchronization

The number of image synchronization verification points that failed

VPs Failed [for Run]

for the entire run

Total Image Synchronization

The number of image synchronization verification points that were

VPs Inconclusive [for Interval] marked as Inconclusive within the most recent sample interval
Total Image Synchronization

The number of image synchronization verification points that were

VPs Inconclusive [for Run]

marked as Inconclusive for the entire run

Total Image Synchronization

The number of image synchronization verification points that

VPs Passed [for Interval]

passed during the most recent sample interval

Total Image Synchronization

The number of image synchronization verification points that

VPs Passed [for Run]

passed for the entire run

Related information
Citrix window synchronization counters on page95
Citrix timer counters on page100
Citrix user action counters on page102
Citrix window counters on page103

Citrix timer counters
Citrix timer counters provide information about the response time of window events in a run. Response
times are determined by measurements that are located in the tests.
Some counters produce an aggregate value, where the values for several web service message returns
are combined into a single value; others produce values for each web service message return.
• Aggregate counters use the values for all the elements in a test to produce a single value for a
report. This value is rolled up from all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
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superimposed on the folder icon:

. In the tables that follow, the aggregate counters are listed

after the titles that contain this icon.
• Individual counters produce values for each item that satisfies the counter, rather than an
aggregate value. Folders that contain individual counters have an asterisk superimposed on
the folder icon:

. In the tables that follow, the individual counters are listed after the titles that

contain this icon.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all tests. Folders that contain aggregate
counters have a clock superimposed on them:

.

Counter name

Description

Average Response Time For All Timers The average response time for all measurements within
For Interval [ms]

the most recent sample interval

Average Response Time For All Timers The average response time for all measurements in the en
For Run [ms]

tire run

Maximum Response Time For All

The maximum response time for all measurements within

Timers For Interval [ms]

the most recent sample interval

Maximum Response Time For All

The maximum response time for all measurements in the

Timers For Run [ms]

entire run

Minimum Response Time For All

The minimum response time for all measurements within

Timers For Interval [ms]

the most recent sample interval

Minimum Response Time For All

The minimum response time for all measurements in the

Timers For Run [ms]

entire run

Standard Deviation Response Time For The standard deviation response time for all measure
All Timers For Interval [ms]

ments during the most recent sample interval

Standard Deviation Response Time For The standard deviation response time for all measure
All Timers For Run [ms]

ments in the entire run

The counters in the following table provide individual values for each test. Folders that contain individual
counters have an asterisk superimposed on them:

.
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Counter name
Average [for Interval]

Description
The average response time for all measurements within the most recent
sample interval

Average [for Run]

The average response time for all measurements in the entire run

Maximum [for Interval]

The maximum response time for all measurements within the most recent
sample interval

Maximum [for Run]

The maximum response time for all measurements in the entire run

Minimum [for Interval]

The minimum response time for all measurements within the most recent
sample interval

Minimum [for Run]

The minimum response time for all measurements in the entire run

Standard Deviation [for The standard deviation response time for all measurements during the
Interval]

most recent sample interval

Standard Deviation [for The standard deviation response time for all measurements in the entire
Run]

run

Related information
Citrix window synchronization counters on page95
Citrix image synchronization counters on page96
Citrix user action counters on page102
Citrix window counters on page103

Citrix user action counters
Citrix user action counters provide information about emulated user input actions in the run.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.
The counters in the following table provide an aggregate value for all transactions. Folders that contain
aggregate counters have a clock superimposed on them:
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Counter Name
Count [for Interval]

Description
The total number of user input actions within the most recent sample
interval

Count [for Run]

The total number of user input actions in the entire run

Rate [per second] [for In

The rate per second of user input actions within the most recent sam

terval]

ple interval

Rate [per second] [for Run] The rate per second of user input actions in the entire run
The counters in the following table provide individual values for each test. Folders that contain individual
counters have an asterisk superimposed on them:

.

Counter Name

Description

Total User Actions For In

The total number of user input actions within the most recent sample

terval

interval

Total User Actions For Run The total number of user input actions in the entire run
User Action Rate For Inter The rate per second of user input actions within the most recent sam
val

ple interval

User Action Rate For Run

The rate per second of user input actions in the entire run

Related information
Citrix window synchronization counters on page95
Citrix image synchronization counters on page96
Citrix timer counters on page100
Citrix window counters on page103

Citrix window counters
Citrix window counters provide information about verification points.
The verdict for a verification point can be Pass, Fail, Error, or Inconclusive.
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• Pass indicates that the verification point matched or received the expected response. For example,
a response code verification point is set to Pass when the recorded response code is received
during the run. If your test does not contain verification points, it means that the connection
succeeded.
• Fail indicates that the verification point did not match the expected response or that the expected
response was not received.
• Error indicates that the primary request was not successfully sent to the server, no response was
received from the server, or the response was incomplete or could not be parsed.
• The verdict is set to Inconclusive only if you provide custom code that defines a verdict of
Inconclusive.

Some counters produce an aggregate value, where the values for several window events are rolled up into
one value; others produce values for each window event.
• Aggregate counters use the values for all the elements in a test to produce a single value for a
report. This value is rolled up from all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
superimposed on the folder icon:

. The tables below that list aggregate counters have this icon

in their title.
• Individual counters produce values for each item that satisfies the counter, rather than a single
rolled-up value. Folders that contain individual counters have an asterisk superimposed on the
folder icon:

. The tables below that list individual counters have this icon in their title.

Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.

Counter

Description

name
Percent

The percentage of window title verification points that passed for a specific window

Pass

event for the entire run

Counter
name
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Description

Count [for

The number of window title verification points classified as Error for a specific win

Interval]

dow event within the most recent sample interval
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Counter

Description

name
Count [for

The number of window title verification points classified as Error for a specific win

Run]

dow for the entire run

Counter

Description

name
Count [for

The number of window title verification points that failed for a specific window event

Interval]

during the most recent sample interval

Count [for

The number of window title verification points that failed for a specific window event

Run]

for the entire run

Counter

Description

name
Count [for

The number of window title verification points classified as Inconclusive for a specific

Interval]

window event within the most recent sample interval

Count [for

The number of window title verification points classified as Inconclusive for a specific

Run]

window event for the entire run

Counter

Description

name
Count [for

The number of window title verification points that passed for a specific window event

Interval]

during the most recent sample interval

Count [for

The number of window title verification points that passed for a specific window event

Run]

for the entire run

Counter name

Description

Percent Window VPs

The percentage of window title verification points that passed during

Passed For Interval

the most recent sample interval
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Counter name

Description

Percent Window VPs

The percentage of window title verification points that passed for the

Passed For Run

entire run

Total Window VPs At

The number of window title verification points executed during the most

tempted [for Interval]

recent sample interval

Total Window VPs At

The number of window title verification points executed for the entire

tempted [for Run]

run

Total Window VPs Error

The number of window title verification points with a verdict of Error

[for Interval]

during the most recent sample interval

Total Window VPs Error

The number of window title verification points with a verdict of Error for

[for Run]

the entire run

Total Window VPs Failed

The number of window title verification points that failed within the

[for Interval]

most recent sample interval

Total Window VPs Failed

The number of window title verification points that failed for the entire

[for Run]

run

Total Window VPs Incon

The number of window title verification points that were marked as In-

clusive [for Interval]

conclusive during the most recent sample interval

Total Window VPs Incon

The number of window title verification points that were marked as In-

clusive [for Run]

conclusive for the entire run

Total Window VPs

The number of window title verification points that passed during the

Passed [for Interval]

most recent sample interval

Total Window VPs

The number of window title verification points that passed for the entire

Passed [for Run]

run

Related information
Citrix window synchronization counters on page95
Citrix image synchronization counters on page96
Citrix timer counters on page100
Citrix user action counters on page102
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Service counters
Service counters, which are displayed in the Test Runs view, enable you to customize your service test
reports with dynamic information that is updated for each run.

Service call counters
Service call counters provide information about the calls that are invoked during the service test.
Some counters produce an aggregate value, where the values for several service calls are combined into a
single value; others produce values for each service call.
• Aggregate counters use the values for all the elements in a test to produce a single value for
a report. This value combines all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
superimposed on the folder icon:

. In the tables that follow, the aggregate counters are listed

after the titles that contain this icon.
• Individual counters produce values for each item that satisfies the counter, rather than an
aggregate value. Folders that contain individual counters have an asterisk superimposed on
the folder icon:

. In the tables that follow, the individual counters are listed after the titles that

contain this icon.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.

Counter name

Description

Average [for In The average time, in milliseconds, required to establish a connection to the web
terval]

service for all web service calls within the most recent sample interval

Average [for

The average time, in milliseconds, required to establish a connection to the web

Run]

service for all web service calls for the entire run

Standard devi

The standard deviation time, in milliseconds, required to establish a connection to

ation [for Inter the web service for all web service calls within the most recent sample interval
val]
Standard devia The standard deviation time, in milliseconds, required to establish a connection to
tion [for Run]

the web service for all web service calls for the entire run
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Counter name

Description

Maximum [for

The longest time, in milliseconds, required to establish a connection to the web

Interval]

service for all web service calls within the most recent sample interval

Maximum [for

The longest time, in milliseconds, required to establish a connection to the web

Run]

service for all web service calls for the entire run

Minimum [for

The shortest time, in milliseconds, required to establish a connection to the web

Interval]

service for all web service calls within the most recent sample interval

Minimum [for

The shortest time, in milliseconds, required to establish a connection to the web

Run]

service for all web service calls for the entire run

Counter name

Description

Average connection

The average time, in milliseconds, required to establish a connection to the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval

Average connection

The average time, in milliseconds, required to establish a connection to the

time [ms] [for Run]

web service for a specific web service call for the entire run

Connection time stan

The standard deviation time, in milliseconds, required to establish a con

dard deviation [ms] [for nection to the web service for a specific web service call during the most
Interval]

recent sample interval

Connection time stan

The standard deviation time, in milliseconds, required to establish a con

dard deviation [ms] [for nection to the web service for a specific web service call for the entire run
Run]
Maximum connection

The longest time, in milliseconds, required to establish a connection to the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval

Maximum connection

The longest time, in milliseconds, required to establish a connection to the

time [ms] [for Run]

web service for a specific web service call for the entire run

Minimum connection

The shortest time, in milliseconds, required to establish a connection to the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval
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The shortest time, in milliseconds, required to establish a connection to the

time [ms] [for Run]

web service for a specific web service call for the entire run
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Counter name

Description

Average [for In The average data volume, in bytes, received as a response from the web service
terval]

for all web service calls during the most recent sample interval

Average [for

The average data volume, in bytes, received as a response from the web service

Run]

for all web service calls for the entire run

Count [for Inter The total data volume, in bytes, received as a response from the web service for all
val]

web service calls during the most recent sample interval

Count [for Run]

The total data volume, in bytes, received as a response from the web service for all
web service calls for the entire run

Maximum [for

The largest data volume, in bytes, received as a response from the web service for

Interval]

all web service calls during the most recent sample interval

Maximum [for

The largest data volume, in bytes, received as a response from the web service for

Run]

all web service calls for the entire run

Maximum

The largest cumulated data volume, in bytes, received as a response from the web

Count [for Run]

service for all web service calls for the entire run

Minimum [for

The smallest data volume, in bytes, received as a response from the web service

Interval]

for all web service calls during the most recent sample interval

Minimum [for

The smallest data volume, in bytes, received as a response from the web service

Run]

for all web service calls for the entire run

Minimum

The smallest cumulated data volume, in bytes, received as a response from the

Count [for Run]

web service for all web service calls for the entire run

Rate [per sec

The data volume throughput, in bytes per second, received as a response from the

ond] [for Inter

web service for all web service calls within the most recent sample interval

val]
Rate [per sec

The data volume throughput, in bytes per second, received as a response from the

ond] [for Run]

web service for all web service calls for the entire run

Standard devi

The standard deviation data volume, in bytes, received as a response from the web

ation [for Inter

service for all web service calls within the most recent sample interval

val]
Standard devia The standard deviation data volume, in bytes, received as a response from the web
tion [for Run]

service for all web service calls for the entire run
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Counter name
Average received bytes

Description
The average data volume, in bytes, received as a response from the web

for all calls [Bytes] [for In service for all web service calls during the most recent sample interval
terval]
Average received bytes

The average data volume, in bytes, received as a response from the web

for all calls [Bytes] [for

service for all web service calls for the entire run

Run]
Maximum received bytes The largest data volume, in bytes, received as a response from the web
[Bytes] [for Interval]

service for a specific web service call during the most recent sample in
terval

Maximum received bytes The largest data volume, in bytes, received as a response from the web
[per Interval] [for Run]

service for a specific web service call for the entire run

Maximum received bytes The largest data volume, in bytes, received as a response from the web
for all calls [Bytes] [for In service for all web service calls during the most recent sample interval
terval]
Maximum received bytes The largest data volume, in bytes, received as a response from the web
for all calls [Bytes] [for

service for all web service calls for the entire run

Run]
Minimum received bytes

The smallest data volume, in bytes, received as a response from the web

[Bytes] [for Interval]

service for a specific web service call during the most recent sample in
terval

Minimum received bytes

The smallest data volume, in bytes, received as a response from the web

[per Interval] [for Run]

service for a specific web service call for the entire run

Minimum received bytes

The smallest data volume, in bytes, received as a response from the web

for all calls [Bytes] [for In service for a specific web service call during the most recent sample in
terval]

terval

Minimum received bytes

The smallest data volume, in bytes, received as a response from the web

for all calls [Bytes] [for

service for a specific web service call for the entire run

Run]
Rate received bytes [for

The data volume throughput, in bytes per second, received as a response

Interval]

from the web service for all web service calls within the most recent
sample interval
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Counter name

Description

Rate received bytes [for

The data volume throughput, in bytes per second, received as a response

Run]

from the web service for a specific web service call for the entire run

Received bytes standard

The standard deviation data volume, in bytes, received as a response

deviation [ms] [for Inter

from the web service for a specific web service call within the most re

val]

cent sample interval

Received bytes standard

The standard deviation data volume, in bytes, received as a response

deviation [ms] [for Run]

from the web service for a specific web service call for the entire run

Total received bytes

The total data volume, in bytes, received as a response from the web ser

[Bytes] [for Interval]

vice for a specific web service call during the most recent sample inter
val

Total received bytes

The total data volume, in bytes, received as a response from the web ser

[Bytes] [for Run]

vice for a specific web service call for the entire run

Counter name

Description

Average [for In

The average data volume, in bytes, sent as a call from the web service for all web

terval]

service calls during the most recent sample interval

Average [for

The average data volume, in bytes, sent as a call from the web service for all web

Run]

service calls for the entire run

Count [for Inter

The total data volume, in bytes, sent as a call from the web service for all web ser

val]

vice calls within the most recent sample interval

Count [for Run]

The total data volume, in bytes, sent as a call from the web service for all web ser
vice calls for the entire run

Maximum [for

The largest data volume, in bytes, sent as a call from the web service for all web

Interval]

service calls during the most recent sample interval

Maximum [for

The largest data volume, in bytes, sent as a call from the web service for all web

Run]

service calls for the entire run

Maximum Count The largest cumulated data volume, in bytes, sent as a call from the web service
[for Run]

for all web service calls for the entire run

Minimum [for In The smallest data volume, in bytes, sent as a call from the web service for all web
terval]

service calls during the most recent sample interval
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Counter name

Description

Minimum [for

The smallest data volume, in bytes, sent as a call from the web service for all web

Run]

service calls for the entire run

Minimum Count The smallest cumulated data volume, in bytes, sent as a call from the web service
[for Run]

for all web service calls for the entire run

Rate [per sec

The data volume throughput, in bytes per second, sent as a call from the web ser

ond] [for Inter

vice for all web service calls during the most recent sample interval

val]
Rate [per sec

The data volume throughput, in bytes per second, sent as a call from the web ser

ond] [for Run]

vice for all web service calls for the entire run

Standard devia

The standard deviation data volume, in bytes, sent as a call from the web service

tion [for Interval] for all web service calls during the most recent sample interval
Standard devia

The standard deviation data volume, in bytes, sent as a call from the web service

tion [for Run]

for all web service calls for the entire run

Counter name
Average sent bytes for

Description
The average data volume, in bytes, sent as a call from the web service for

all calls [Bytes] [for Inter all web service calls during the most recent sample interval
val]
Average sent bytes for

The average data volume, in bytes, sent as a call from the web service for

all calls [Bytes] [for Run]

all web service calls for the entire run

Maximum sent bytes

The largest data volume, in bytes, sent as a call from the web service for

[Bytes] [for Interval]

a specific web service call during the most recent sample interval

Maximum sent bytes

The largest data volume, in bytes, sent as a call from the web service for

[per Interval] [for Run]

a specific web service call for the entire run

Maximum sent bytes for

The largest data volume, in bytes, sent as a call from the web service for

all calls [Bytes] [for Inter all web service calls during the most recent sample interval
val]
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The largest data volume, in bytes, sent as a call from the web service for

all calls [Bytes] [for Run]

all web service calls for the entire run
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Counter name

Description

Minimum sent bytes

The smallest data volume, in bytes, sent as a call from the web service

[Bytes] [for Interval]

for a specific web service call during the most recent sample interval

Minimum sent bytes [per The smallest data volume, in bytes, sent as a call from the web service
Interval] [for Run]

for a specific web service call for the entire run

Minimum sent bytes for

The smallest data volume, in bytes, sent as a call from the web service

all calls [Bytes] [for Inter for a specific web service call during the most recent sample interval
val]
Minimum sent bytes for

The smallest data volume, in bytes, sent as a call from the web service

all calls [Bytes] [for Run]

for a specific web service call for the entire run

Rate sent bytes [for Inter The data volume throughput, in bytes per second, sent as a call from the
val]

web service for all web service calls during the most recent sample inter
val

Rate sent bytes [for Run] The data volume throughput, in bytes per second, sent as a call from the
web service for a specific web service call for the entire run
Sent bytes standard devi The standard deviation data volume, in bytes, sent as a call from the web
ation [ms] [for Interval]

service for a specific web service call within the most recent sample in
terval

Sent bytes standard devi The standard deviation data volume, in bytes, sent as a call from the web
ation [ms] [for Run]

service for a specific web service call for the entire run

Total sent bytes [Bytes]

The total data volume, in bytes, sent as a call from the web service for a

[for Interval]

specific web service call during the most recent sample interval

Total sent bytes [Bytes]

The total data volume, in bytes, sent as a call from the web service for a

[for Run]

specific web service call for the entire run

Counter name

Description

Average [for In The average time, in milliseconds, required to receive a response from the web ser
terval]

vice for all web service calls within the most recent sample interval

Average [for

The average time, in milliseconds, required to receive a response from the web ser

Run]

vice for all web service calls for the entire run
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Counter name

Description

Standard devi

The standard deviation time, in milliseconds, required to receive a response from

ation [for Inter

the web service for all web service calls within the most recent sample interval

val]
Standard devia The standard deviation time, in milliseconds, required to receive a response from
tion [for Run]

the web service for all web service calls for the entire run

Maximum [for

The longest time, in milliseconds, required to receive a response from the web ser

Interval]

vice for all web service calls within the most recent sample interval

Maximum [for

The longest time, in milliseconds, required to receive a response from the web ser

Run]

vice for all web service calls for the entire run

Minimum [for

The shortest time, in milliseconds, required to receive a response from the web

Interval]

service for all web service calls within the most recent sample interval

Minimum [for

The shortest time, in milliseconds, required to receive a response from the web

Run]

service for all web service calls for the entire run

Counter name

Description

Average connection

The average time, in milliseconds, required to receive a response from the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval

Average connection

The average time, in milliseconds, required to receive a response from the

time [ms] [for Run]

web service for a specific web service call for the entire run

Response time stan

The standard deviation time, in milliseconds, required to receive a response

dard deviation [ms]

from the web service for a specific web service call during the most recent

[for Interval]

sample interval

Response time stan

The standard deviation time, in milliseconds, required to receive a response

dard deviation [ms]

from the web service for a specific web service call for the entire run

[for Run]
Maximum response

The longest time, in milliseconds, required to receive a response from the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval
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The longest time, in milliseconds, required to receive a response from the

time [ms] [for Run]

web service for a specific web service call for the entire run
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Counter name

Description

Minimum response

The shortest time, in milliseconds, required to receive a response from the

time [ms] [for Interval]

web service for a specific web service call within the most recent sample
interval

Minimum response

The shortest time, in milliseconds, required to receive a response from the

time [ms] [for Run]

web service for a specific web service call for the entire run

Counter name
Count [for Interval]

Description
The number of times web service calls have been invoked during the most re
cent sample interval

Count [for Run]

The number of times web service calls have been invoked during the entire
run

Maximum [for Inter The maximum number of times web service calls have been invoked within an
val]

interval

Maximum [for Run]

The maximum number of times web service calls have been invoked during
the entire run

Rate [per second]

The number of times per second that web service calls have been invoked

[for Interval]

during the most recent sample interval

Rate [per second]

The number of times per second that web service calls have been invoked for

[for Run]

the entire run

Counter name

Description

Maximum Rate Web Service The maximum number of times per second that a specific web ser
Call Started [for Run]

vice call has been invoked for the entire run

Maximum Web Service Call

The maximum number of times a specific web service call has been

Started [for Interval]

invoked during the most recent sample interval

Maximum Web Service Call

The maximum number of times a specific web service call has been

Started [for Run]

invoked for the entire run

Minimum Rate Web Service The minimum number of times per second that a specific web service
Call Started [for Run]

call has been invoked for the entire run
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Counter name

Description

Minimum Web Service Call

The minimum number of times a specific web service call has been

Started [for Interval]

invoked during the most recent sample interval

Minimum Web Service Call

The minimum number of times a specific web service call has been

Started [for Run]

invoked for the entire run

Rate Web Service Call Start The number of times per second that a specific web service call has
ed [for Interval]

been invoked during the most recent sample interval

Rate Web Service Call Start The number of times per second that a specific web service call has
ed [for Run]

been invoked for the entire run

Total Web Service Call Start The number of times that a specific web service call has been invoked
ed [for Interval]

during the most recent sample interval

Total Web Service Call Start The number of times that a specific web service call has been invoked
ed [for Run]

for the entire run

Counter name

Description

Count [for Interval] The number of times web service calls have returned a valid response during
the most recent sample interval
Count [for Run]

The number of times web service calls have returned a valid response during
the entire run
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Maximum [for In

The maximum number of times web service calls have returned a valid re

terval]

sponse within an interval

Maximum [for

The maximum number of times web service calls have returned a valid re

Run]

sponse during the entire run

Rate [per second]

The number of times per second that web service calls have returned a valid re

[for Interval]

sponse during the most recent sample interval

Rate [per second]

The number of times per second that web service calls have returned a valid re

[for Run]

sponse for the entire run
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Counter name

Description

Maximum Rate Web Ser

The maximum number of times per second that a specific web service

vice Call Success [for Run] call has returned a valid response for the entire run
Maximum Web Service

The maximum number of times a specific web service call has returned

Call Success [for Interval]

a valid response during the most recent sample interval

Maximum Web Service

The maximum number of times a specific web service call has returned

Call Success [for Run]

a valid response for the entire run

Minimum Rate Web Ser

The minimum number of times per second that a specific web service

vice Call Success [for Run] call has returned a valid response for the entire run
Minimum Web Service Call The minimum number of times a specific web service call has returned
Success [for Interval]

a valid response during the most recent sample interval

Minimum Web Service Call The minimum number of times a specific web service call has returned
Success [for Run]

a valid response for the entire run

Rate Web Service Call Suc The number of times per second that a specific web service call has re
cess [for Interval]

turned a valid response during the most recent sample interval

Rate Web Service Call Suc The number of times per second that a specific web service call has re
cess [for Run]

turned a valid response for the entire run

Total Web Service Call

The number of times that a specific web service call has returned a

Success [for Interval]

valid response during the most recent sample interval

Total Web Service Call

The number of times that a specific web service call has returned a

Success [for Run]

valid response for the entire run

Counter name
Count [for Interval]

Description
The number of times web service calls have failed within the most recent
sample interval

Count [for Run]

The number of times web service calls have failed during the entire run

Maximum [for Inter

The maximum number of times web service calls have failed within an inter

val]

val

Maximum [for Run]

The maximum number of times web service calls have failed during the en
tire run
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Counter name

Description

Rate [per second] [for The number of times per second that web service calls have failed during the
Interval]

most recent sample interval

Rate [per second] [for The number of times per second that web service calls have failed for the en
Run]

tire run

Counter name
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Description

Maximum Rate Web Service

The maximum number of times per second that a specific web ser

Call Failures [for Run]

vice call has failed for the entire run

Maximum Web Service Call

The maximum number of times a specific web service call has failed

Failures [for Interval]

during the most recent sample interval

Maximum Web Service Call

The maximum number of times a specific web service call has failed

Failures [for Run]

for the entire run

Minimum Rate Web Service

The minimum number of times per second that a specific web ser

Call Failures [for Run]

vice call has failed for the entire run

Minimum Web Service Call

The minimum number of times a specific web service call has failed

Failures [for Interval]

during the most recent sample interval

Minimum Web Service Call

The minimum number of times a specific web service call has failed

Failures [for Run]

for the entire run

Rate Web Service Call Fail

The number of times per second that a specific web service call has

ures [for Interval]

failed during the most recent sample interval

Rate Web Service Call Fail

The number of times per second that a specific web service call has

ures [for Run]

failed for the entire run

Total Web Service Call Fail

The number of times that a specific web service call has failed dur

ures [for Interval]

ing the most recent sample interval

Total Web Service Call Fail

The number of times that a specific web service call has failed for

ures [for Run]

the entire run
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Counter name
Count [for Interval]

Description
The number of times web service calls produced a timeout during the most re
cent sample interval

Count [for Run]

The number of times web service calls produced a timeout during the entire
run

Maximum [for Inter The maximum number of times web service calls produced a timeout within
val]

an interval

Maximum [for Run]

The maximum number of times web service calls produced a timeout during
the entire run

Rate [per second]

The number of times per second that web service calls produced a timeout

[for Interval]

during the most recent sample interval

Rate [per second]

The number of times per second that web service calls produced a timeout for

[for Run]

the entire run

Counter name

Description

Maximum Rate Web Service The maximum number of times per second that a specific web ser
Call Timeouts [for Run]

vice call produces a timeout for the entire run

Maximum Web Service Call

The maximum number of times a specific web service call produces

Timeouts [for Interval]

a timeout during the most recent sample interval

Maximum Web Service Call

The maximum number of times a specific web service call produces

Timeouts [for Run]

a timeout for the entire run

Minimum Rate Web Service

The minimum number of times per second that a specific web ser

Call Timeouts [for Run]

vice call produces a timeout for the entire run

Minimum Web Service Call

The minimum number of times a specific web service call produces a

Timeouts [for Interval]

timeout during the most recent sample interval

Minimum Web Service Call

The minimum number of times a specific web service call produces a

Timeouts [for Run]

timeout for the entire run

Rate Web Service Call Time The number of times per second that a specific web service call pro
outs [for Interval]

duces a timeout during the most recent sample interval
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Counter name

Description

Rate Web Service Call Time The number of times per second that a specific web service call pro
outs [for Run]

duces a timeout for the entire run

Total Web Service Call Time The number of times that a specific web service call produces a time
outs [for Interval]

out during the most recent sample interval

Total Web Service Call Time The number of times that a specific web service call produces a time
outs [for Run]

out for the entire run

Related information
Service verification point counters on page120

Service verification point counters
Service verification point counters provide information about verification points.
The verdict for a verification point can be Pass, Fail, Error, or Inconclusive.
• Pass indicates that the verification point matched or received the expected response. For example,
a response code verification point is set to Pass when the recorded response code is received
during the run. If your test does not contain verification points, it means that the connection
succeeded.
• Fail indicates that the verification point did not match the expected response or that the expected
response was not received.
• Error indicates that the primary request was not successfully sent to the server, no response was
received from the server, or the response was incomplete or could not be parsed.
• Inconclusive is returned only if you provide custom code that defines an Inconclusive verdict.
Some counters produce an aggregate value, where the values for several web service message returns
are combined into a single value; others produce values for each web service message return.
• Aggregate counters use the values for all the elements in a test to produce a single value for a
report. This value is rolled up from all values that satisfy the counter. When you drag an aggregate
counter onto a report, one value is displayed. Folders that contain aggregate counters have a clock
superimposed on the folder icon:
after the titles that contain this icon.
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• Individual counters produce values for each item that satisfies the counter, rather than an
aggregate value. Folders that contain individual counters have an asterisk superimposed on
the folder icon:

. In the tables that follow, the individual counters are listed after the titles that

contain this icon.
Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule,
as a schedule property.

Counter

Description

name
Percent

The percentage of all verification points that passed for a specific web service mes

Pass

sage return for the entire run

Counter

Description

name
Count [for

The number of all verification points classified as Error for a specific web service mes

Interval]

sage return during the most recent sample interval

Count [for

The number of all verification points classified as Error for a specific web service mes

Run]

sage return for the entire run

Counter

Description

name
Count [for

The number of all verification points that failed for a specific web service message re

Interval]

turn during the most recent sample interval

Count [for

The number of all verification points that failed for a specific web service message re

Run]

turn for the entire run

Counter
name

Description

Count [for The number of all verification points classified as Inconclusive for a specific web ser
Interval]

vice message return during the most recent sample interval
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Counter

Description

name

Count [for The number of all verification points classified as Inconclusive for a specific web ser
Run]

vice message return for the entire run

Counter

Description

name
Count [for

The number of all verification points that passed for a specific web service message

Interval]

return during the most recent sample interval

Count [for

The number of all verification points that passed for a specific web service message

Run]

return for the entire run

Counter name

Description

Percent All VPs Passed

The percentage of all verification points that passed during the most re

For Interval

cent sample interval

Percent All VPs Passed

The percentage of all verification points that passed for the entire run

For Run
Total All VPs Attempted

The number of all verification points executed within the most recent

[for Interval]

sample interval

Total All VPs Attempted

The number of all verification points executed for the entire run

[for Run]
Total All VPs Error [for

The number of all verification points with a verdict of Error during the

Interval]

most recent sample interval

Total All VPs Error [for

The number of all verification points with a verdict of Error for the entire

Run]

run

Total All VPs Failed [for

The number of all verification points that failed within the most recent

Interval]

sample interval

Total All VPs Failed [for

The number of all verification points that failed for the entire run

Run]
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Total All VPs Inconclu

The number of all verification points that were marked as Inconclusive

sive [for Interval]

during the most recent sample interval
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Counter name

Description

Total All VPs Inconclu

The number of all verification points that were marked as Inconclusive

sive [for Run]

for the entire run

Total All VPs Passed [for The number of all verification points that passed within the most recent
Interval]

sample interval

Total All VPs Passed [for The number of all verification points that passed for the entire run
Run]

Counter

Description

name
Percent

The percentage of attachment verification points that passed for a specific web service

Pass

message return for the entire run

Counter

Description

name

Count [for The number of attachment verification points classified as Error for a specific web ser
Interval]

vice message return during the most recent sample interval

Count [for The number of attachment verification points classified as Error for a specific web ser
Run]

vice message return for the entire run

Counter

Description

name
Count [for

The number of attachment verification points that failed for a specific web service

Interval]

message return during the most recent sample interval

Count [for

The number of attachment verification points that failed for a specific web service

Run]

message return for the entire run
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Counter

Description

name

Count [for The number of attachment verification points classified as Inconclusive for a specific
Interval]

web service message return during the most recent sample interval

Count [for The number of attachment verification points classified as Inconclusive for a specific
Run]

web service message return for the entire run

Counter

Description

name
Count [for

The number of attachment verification points that passed for a specific web service

Interval]

message return during the most recent sample interval

Count [for

The number of attachment verification points that passed for a specific web service

Run]

message return for the entire run

Counter name

Description

Percent Attachment VPs

The percentage of attachment verification points that passed during

Passed For Interval

the most recent sample interval

Percent Attachment VPs

The percentage of attachment verification points that passed for the

Passed For Run

entire run

Total Attachment VPs At

The number of attachment verification points executed during the

tempted [for Interval]

most recent sample interval

Total Attachment VPs At

The number of attachment verification points executed for the entire

tempted [for Run]

run

Total Attachment VPs Error The number of attachment verification points with a verdict of Error
[for Interval]

during the most recent sample interval

Total Attachment VPs Error The number of attachment verification points with a verdict of Error
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[for Run]

for the entire run

Total Attachment VPs

The number of attachment verification points that failed during the

Failed [for Interval]

most recent sample interval
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Counter name

Description

Total Attachment VPs

The number of attachment verification points that failed for the entire

Failed [for Run]

run

Total Attachment VPs In

The number of attachment verification points that were marked as In-

conclusive [for Interval]

conclusive during the most recent sample interval

Total Attachment VPs In

The number of attachment verification points that were marked as In-

conclusive [for Run]

conclusive for the entire run

Total Attachment VPs

The number of attachment verification points that passed during the

Passed [for Interval]

most recent sample interval

Total Attachment VPs

The number of attachment verification points that passed for the en

Passed [for Run]

tire run

Counter

Description

name
Percent

The percentage of contain verification points that passed for a specific web service

Pass

message return for the entire run

Counter

Description

name
Count [for

The number of contain verification points classified as Error for a specific web service

Interval]

message return during the most recent sample interval

Count [for

The number of contain verification points classified as Error for a specific web service

Run]

message return for the entire run

Counter

Description

name
Count [for

The number of contain verification points that failed for a specific web service mes

Interval]

sage return during the most recent sample interval

Count [for

The number of contain verification points that failed for a specific web service mes

Run]

sage return for the entire run
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Counter

Description

name

Count [for The number of contain verification points classified as Inconclusive for a specific web
Interval]

service message return during the most recent sample interval

Count [for The number of contain verification points classified as Inconclusive for a specific web
Run]

service message return for the entire run

Counter

Description

name
Count [for

The number of contain verification points that passed for a specific web service mes

Interval]

sage return during the most recent sample interval

Count [for

The number of contain verification points that passed for a specific web service mes

Run]

sage return for the entire run

Counter name

Description

Percent Contain VPs

The percentage of contain verification points that passed during the

Passed For Interval

most recent sample interval

Percent Contain VPs

The percentage of contain verification points that passed for the entire

Passed For Run

run

Total Contain VPs At

The number of contain verification points executed within the most re

tempted [for Interval]

cent sample interval

Total Contain VPs At

The number of contain verification points executed for the entire run

tempted [for Run]
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Total Contain VPs Error

The number of contain verification points with a verdict of Error during

[for Interval]

the most recent sample interval

Total Contain VPs Error

The number of contain verification points with a verdict of Error for the

[for Run]

entire run

Total Contain VPs Failed

The number of contain verification points that failed during the most re

[for Interval]

cent sample interval
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Counter name
Total Contain VPs Failed

Description
The number of contain verification points that failed for the entire run

[for Run]
Total Contain VPs Incon

The number of contain verification points that were marked as Incon-

clusive [for Interval]

clusive during the most recent sample interval

Total Contain VPs Incon

The number of contain verification points that were marked as Incon-

clusive [for Run]

clusive for the entire run

Total Contain VPs Passed The number of contain verification points that passed during the most
[for Interval]

recent sample interval

Total Contain VPs Passed The number of contain verification points that passed for the entire run
[for Run]

Counter

Description

name
Percent

The percentage of equal verification points that passed for a specific web service mes

Pass

sage return for the entire run

Counter

Description

name
Count [for

The number of equal verification points classified as Error for a specific web service

Interval]

message return during the most recent sample interval

Count [for

The number of equal verification points classified as Error for a specific web service

Run]

message return for the entire run

Counter

Description

name
Count [for

The number of equal verification points that failed for a specific web service message

Interval]

return during the most recent sample interval

Count [for

The number of equal verification points that failed for a specific web service message

Run]

return for the entire run
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Counter

Description

name

Count [for The number of equal verification points classified as Inconclusive for a specific web
Interval]

service message return during the most recent sample interval

Count [for The number of equal verification points classified as Inconclusive for a specific web
Run]

service message return for the entire run

Counter

Description

name
Count [for

The number of equal verification points that passed for a specific web service mes

Interval]

sage return during the most recent sample interval

Count [for

The number of equal verification points that passed for a specific web service mes

Run]

sage return for the entire run

Counter name

Description

Percent Equal VPs

The percentage of equal verification points that passed during the most

Passed For Interval

recent sample interval

Percent Equal VPs

The percentage of equal verification points that passed for the entire run

Passed For Run
Total Equal VPs Attempt

The number of equal verification points executed within the most recent

ed [for Interval]

sample interval

Total Equal VPs Attempt

The number of equal verification points executed for the entire run

ed [for Run]
Total Equal VPs Error [for The number of equal verification points with a verdict of Error during
Interval]

the most recent sample interval

Total Equal VPs Error [for The number of equal verification points with a verdict of Error for the

128

Run]

entire run

Total Equal VPs Failed

The number of equal verification points that failed during the most re

[for Interval]

cent sample interval
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Counter name
Total Equal VPs Failed

Description
The number of equal verification points that failed for the entire run

[for Run]
Total Equal VPs Inconclu The number of equal verification points that were marked as Inconclusive [for Interval]

sive during the most recent sample interval

Total Equal VPs Inconclu The number of equal verification points that were marked as Inconclusive [for Run]

sive for the entire run

Total Equal VPs Passed

The number of equal verification points that passed during the most re

[for Interval]

cent sample interval

Total Equal VPs Passed

The number of equal verification points that passed for the entire run

[for Run]

Counter

Description

name
Percent

The percentage of query verification points that passed for a specific web service mes

Pass

sage return for the entire run

Counter

Description

name
Count [for

The number of query verification points classified as Error for a specific web service

Interval]

message return during the most recent sample interval

Count [for

The number of query verification points classified as Error for a specific web service

Run]

message return for the entire run

Counter

Description

name
Count [for

The number of query verification points that failed for a specific web service message

Interval]

return during the most recent sample interval

Count [for

The number of query verification points that failed for a specific web service message

Run]

return for the entire run
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Counter

Description

name

Count [for The number of query verification points classified as Inconclusive for a specific web
Interval]

service message return during the most recent sample interval

Count [for The number of query verification points classified as Inconclusive for a specific web
Run]

service message return for the entire run

Counter

Description

name
Count [for

The number of query verification points that passed for a specific web service mes

Interval]

sage return during the most recent sample interval

Count [for

The number of query verification points that passed for a specific web service mes

Run]

sage return for the entire run

Counter name

Description

Percent Query VPs

The percentage of query verification points that passed during the most

Passed For Interval

recent sample interval

Percent Query VPs

The percentage of query verification points that passed for the entire

Passed For Run

run

Total Query VPs Attempt The number of query verification points executed within the most recent
ed [for Interval]

sample interval

Total Query VPs Attempt The number of query verification points executed for the entire run
ed [for Run]
Total Query VPs Error [for The number of query verification points with a verdict of Error during
Interval]

the most recent sample interval

Total Query VPs Error [for The number of query verification points with a verdict of Error for the
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Run]

entire run

Total Query VPs Failed

The number of query verification points that failed during the most re

[for Interval]

cent sample interval
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Counter name
Total Query VPs Failed

Description
The number of query verification points that failed for the entire run

[for Run]
Total Query VPs Inconclu The number of query verification points that were marked as Inconclusive [for Interval]

sive during the most recent sample interval

Total Query VPs Inconclu The number of query verification points that were marked as Inconclusive [for Run]

sive for the entire run

Total Query VPs Passed

The number of query verification points that passed during the most re

[for Interval]

cent sample interval

Total Query VPs Passed

The number of query verification points that passed for the entire run

[for Run]

Related information
Service call counters on page107

Socket counters
With socket generic counters, which are displayed in the Performance Test Runs view, you can customize
your socket reports with dynamic information that is updated for each run.

Socket counters
These counters provide information about connections started, send and receive actions completed, and
connection times. Some counters produce an aggregate value, where the values for several send and
receive actions are represented in one value; others produce values for each action.
Aggregate counters use the values for all the connections in a test to produce a single value for a report.
This value is calculated from all values that satisfy the counter. When you drag an aggregate counter onto
a report, one value is displayed. Folders that contain aggregate counters have a clock superimposed on
the folder icon:

. The following tables that list aggregate counters have this icon in their title.

Individual counters produce values for each connection that satisfies the counter, rather than a single
aggregate value. Folders that contain individual counters have an asterisk superimposed on the folder
icon:

. The following tables that list individual counters have this icon in their title.
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Some counters pertain to intervals in the run. You set the Statistics sample interval value in the schedule
as a schedule property.

Bytes Received counters
The counters in this section provide information about the number of bytes that were received.

Counter name

Description

Count [for Inter The number of bytes received for a specific connection during the most recent
val]

sample interval

Count [for Run]

The number of bytes received for a specific connection for the entire run

Bytes Sent counters
The counters in this section provide information about the number of bytes that were sent.

Counter name

Description

Count [for Inter

The number of bytes sent for a specific connection within the most recent sam

val]

ple interval

Count [for Run]

The number of bytes sent for a specific connection for the entire run

Connect Attempts counters
The counters in this section provide information about the number of attempts to establish a connection
with the server.

Counter name

Description

Count [for Inter

The number of attempts to establish a connection within the most recent sample

val]

interval

Count [for Run]

The number of attempts to establish a connection for the entire run

Connect Times counters
The counters in this section provide information about the connection response time. This is the time, in
milliseconds, that elapses from the point that the test client attempts to establish a connection with the
server and the moment the connection is established.
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Counter name
Average [for Interval]

Description
The average connection time for a specific connection during the most re
cent sample interval

Average [for Run]

The average connection time for a specific connection for the entire run

Maximum [for Inter

The maximum connection time for a specific connection during the most re

val]

cent sample interval

Maximum [for Run]

The maximum connection time for a specific connection for the entire run

Minimum [for Interval] The minimum connection time for a specific connection during the most re
cent sample interval
Minimum [for Run]

The minimum connection time for a specific connection for the entire run

Standard Deviation

The standard deviation of connection times for a specific connection during

[for Interval]

the most recent sample interval

Standard Deviation

The standard deviation of connection times for a specific connection for the

[for Run]

entire run

Counter name

Description

Average [ms] [for Interval] The average connection time for all connections within the most recent
sample interval
Average [ms] [for Run]

The average connection time for all connections for the entire run

Maximum [ms] [for Inter

The maximum connection time for all connections within the most re

val]

cent sample interval

Maximum [ms] [for Run]

The maximum connection time for all connections for the entire run

Minimum [ms] [for Inter

The minimum connection time for a all connections within the most re

val]

cent sample interval

Minimum [ms] [for Run]

The minimum connection time for a all connections for the entire run

Standard Deviation [ms]

The standard deviation of connection times for all connections during

[for Interval]

the most recent sample interval

Standard Deviation [ms]

The standard deviation of connection times for all connections for the

[for Run]

entire run
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Connects counters
The counters in this section provide information about the number of connections that were established.

Counter name

Description

Count [for In

The number of established connections for a specific connection during the most

terval]

recent sample interval

Count [for

The number of established connections for a specific connection for the entire run

Run]

Receive Attempts counters
The counters in this section provide information about the number of attempts to receive data from the
connection.

Counter name

Description

Count [for Inter The number of receive attempts for a specific connection during the most recent
val]

sample interval

Count [for Run] The number of receive attempts for a specific connection for the entire run

Receives counters
The counters in this section provide information about the number of receive actions that were
successfully completed that were received.

Counter name

Description

Count [for In

The number of completed receives for a specific connection during the most re

terval]

cent sample interval

Count [for Run] The number of completed receives for a specific connection for the entire run

Send Attempts counters
The counters in this section provide information about the number of attempts to send data from the
connection.
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Counter name

Description

Count [for Inter The number of send attempts for a specific connection during the most recent
val]

sample interval

Count [for Run]

The number of send attempts for a specific connection for the entire run

Sends counters
The counters in this section provide information about the number of send actions that were successfully
completed.

Counter name

Description

Count [for Inter The number of completed sends for a specific connection during the most recent
val]

sample interval

Count [for Run] The number of completed sends for a specific connection for the entire run

UI reference for performance testing
UI preferences
Read the UI preferences topics.

HTTP preferences
You can change the product behavior by changing these HTTP-related settings.

HTTP protocol data view preferences
Preference settings control how protocol data is displayed when tests run.
Access the preference settings for the HTTP protocol data view. Click Window > Preferences > Test >
HTTP Protocol Data View.
Render binary response data
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Typically, you leave this box unchecked, because the data is generally unreadable and can
cause temporary high processor usage when converted into text. If enabled, the Response
and Browser pages of the Protocol Data view display unrecognized binary data.
Replay delay
During test debugging, when you replay one virtual user after the run is completed, specify
the number of seconds that the Protocol Data view pauses between showing each page.
Enable real-time protocol data support for HTTP test
Typically, you leave this box checked and select whether you want to display the Browser tab
or the Event Log tab by default; you can switch between these pages during playback.
Show the following page when launching HTTP test
Specifies which page is displayed when an HTTP test runs.
• Browser: Click to view rendered HTTP pages during playback, thus verifying that a
test is behaving as expected. Because the protocol data is used, the Browser page
might not render the contents exactly as a web browser would.
• Event Log: Click to see a line of summary information for each defined page of the
currently running test. This summary includes a count of verdicts that did not pass,
unexpected response codes, and other items of interest. Click an event to drill down
for more detailed information.
Highlight Substitutions in Protocol Data View
This option visibly highlights substituted data in the Request, Response Headers and
Response Content pages of the Protocol Data View when viewing test log or test editor
elements that use data correlation.

Related information
HTTP recorder preferences on page136
HTTP test editor preferences on page137
HTTP test generation preferences on page138

HTTP recorder preferences
Preference settings control the behavior of the recording wizard.
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Access the preference settings. Click Window > Preferences > Test > Recording > HTTP Recording. After
changing a setting, click Apply.
Enable the Rational® Performance Tester toolbar in browsers
Click to install the annotation toolbar. This enables you to add comments and transactions,
and to change page names during recording.
Verify annotation toolbar is installed before recording
Click to verify that the annotation toolbar is installed in the web browser before recording.

Related information
HTTP protocol data view preferences on page135
HTTP test editor preferences on page137
HTTP test generation preferences on page138

HTTP test editor preferences
The preference settings on the HTTP page of the test editor control how URLs are displayed in a test and
how content verification occurs.
To access the preference settings for HTTP test editor, click Window > Preferences > Test > Test Editor
> HTTP Test.
You can set the following preferences for the HTTP test editor:
Display decoded URLs whenever possible
Select to decode any encoded element in a URL. Decoding improves readability.
Hide HTTP request/response content larger than (kB)
Select to hide data larger than a specific size. The Content area in a response indicates
the size of the hidden data and whether it is binary. To display hidden data, press Ctrl+Shift
+Spacebar.
Show in all requests
Select to display the host and port information in every request in the Test Contents area
of the test editor. A test often contains many server connections. When you clear this
preference, it is easier to read a test.
Show on primary requests only
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Select to display the host and port information in only the primary request for each HTTP
page in the Test Contents area of the test editor.
Show when different from primary request
Select to display the host and port information in the Test Contents area of the test editor
for requests that use a different connection than the primary request.
Skip responses with binary contents
Select to skip binary response data when you enable content verification points in a test.
Content verification points verify whether specified strings are present in response data.
Create only in primary responses
Select to limit the creation of content verification points to primary responses when you
enable content verification points in a test.

Related information
HTTP protocol data view preferences on page135
HTTP recorder preferences on page136
HTTP test generation preferences on page138

HTTP test generation preferences
Preference settings control how performance tests are generated, such as how tests will process
verification points, data correlation, and generic protocols.

Test generation options
To access the preference settings for test generation options, click Window > Preferences > Test > Test
Generation > HTTP Test Generation, and click the Test Generation Options tab.
Do not generate a new page if think time is less than
Enter the shortest time, in milliseconds, that the generator uses as a delay to emulate user
think time for an HTTP page. If your tests contain fewer pages than expected, try a shorter
interval.
Create a new page if delay between requests is greater than
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Enter the longest delay, in milliseconds, that the generator allows between page requests.
If this time is exceeded, a new page is generated. If your tests contain more pages than
expected, try a longer interval.
Maximum request delay
Enter the longest delay, in milliseconds, that the generator allows before truncating HTTP
requests. The requests are truncated on the generated test. The recorded test still contains
the original values, and you can get them back by generating a new test.
Save only the first 4KB of responses larger than
Enter the limit of response data, in KB, that the generator saves. If a response is larger than
the specified limit, only the first 4 KB of data is saved.
Suppress NSLookup() and use numeric IPs
Select this option to shorten test generation time. The disadvantage is that IP addresses in
a test are less user-friendly than web page format (www.example.com).
Disable Page Cache Emulation during test generation
Select this option to disable page cache emulation. When page cache emulation is enabled,
caching information in server response headers is honored. Additionally, requests are not
submitted to the server for content that is confirmed by the client as fresh in the local cache.
Page cache emulation is enabled by default.
Enable domain review before test generation
Clear the check box to not show the test generation page to select specific domains to
be added to the test. By default, in addition to the domain that you intend to record, other
domains linked to the original domain are also recorded.
Remove HTTP request delays from page response times
To not include the client delays in the page response times for the test or A schedule, in this
context, is used to refer to both VU Schedule and Rate Schedule, select this check box. By
default, the page response times include delays to represent processing time caused by
clients such as a web browser. Sometimes this delay could exceed the logical limit causing
page response times to increase drastically.
Use Legacy Test Generator
Select this option if you have been instructed to use the legacy HTTP test generator.
Automatically include verification point of
Click to specify the types of verification points to be automatically included. If a check box
for a verification point is selected, the code and edit controls for this type of verification
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point are generated in all tests. Verification points can also be enabled or disabled within
specific tests.
Relaxed
Response codes that are in the same category (for example, 200, 201, 203, 209) are
considered equivalent. An error is reported if the response code is not in the same category.
Exact
An error is reported if the response code does not match the recorded value exactly.
Accept sizes for primary request within
If you are automatically generating response size verification points, click to specify the
acceptable size range for primary requests. No error is reported if a response is within the
specified percentage above or below the expected size. By default, for primary requests,
HTTP response size verification points use range matching.

Data correlation
To access the preference settings for data correlation, click Window > Preferences > Test > Test
Generation > HTTP Test Generation, and click the Data Correlation tab.
Automatically correlate host and port data
By default, host and port data is correlated automatically. If tests in a previous release have
significant manual correlations, or you are using proxies, the migration of the replace-host
functionality feature is likely to fail during playback. In this situation, clear the check box.
When you reopen your tests, they will not have the automatic correlation feature in them.
Automatically correlate URL pathname if redirected by response
Specifies whether URL path names are correlated if they are redirected by a selected
response code. If a check box for a response code is selected, the test generator performs
correlations for that response code. This option applies only to responses that are redirects,
with a status code between 300 and 399.
Automatically correlate Referers
By default, the Referer field in an HTTP request header is correlated automatically. Clear the
check box if you plan to correlate Referers manually. If you run tests against servers that
do not require a Referer field, clearing this check box reduces the number of correlations
performed when the test runs, and can increase user throughput.
Enable all other data correlation
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By default, request and response data is correlated automatically. Clear the check box to
disable automatic data correlation of request and response data. Consider clearing the
check box if you create your own data correlation rules in the rules editor.
Create substitutions for empty strings
Select this check box to correlate empty strings. For example, strings such as spouse name
or middle initial sometimes become important to correlate. However, correlating empty
strings increases the time to generate a test.
Optimize automatic data correlation for execution
Specifies the characteristic that tests are automated for.
• With the Accuracy setting (the default), many references with an identical session
ID value are created and the value of each session ID is substituted from the nearest
previous reference.
• To make a test run faster by reducing the number of references that are created
during automatic data correlation, change the optimization to Efficiency. For
example, consider a test where a session ID, which is assigned when a user logs
in, is included in every subsequent request in the test. With the Efficiency setting,
all session IDs are substituted from a single previous reference. The downside of
this setting is that it can result in incorrect correlations. For example, a request that
contains the Joe Smith string might be incorrectly correlated with a request that
contains the Joe Brown string.
URL rewriting for execution
Specifies how web addresses (URLs) are rewritten during test execution. When correlating
data, the test generator replaces part of a URL request string with a value that the server
returned in response to a previous request.
• Automatic (default): The test generator automatically determines when rewriting the
entire URL during substitution will facilitate test execution.
• On: Select to rewrite URLs in every instance of data correlation. This produces larger
tests that take longer to run. Try this setting if your tests fail unexpectedly.
• Off: Select to manually correlate the instances where URL rewriting is needed. This
setting might cause execution errors.
URL encoding for execution
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With this option, you can control the encoding of the URLs. If you set it to Automatic, the
tool detects the encoding that already exists in the test and applies it to the substitution
site. If you set it to ON, the tool always encodes the substitutions according to the encoding
standards. If you set it to OFF, no encoding occurs.
Note: To turn data correlation off entirely or to set whether names are automatically generated
for data correlation references, click Window > Preferences > Test > Test Generation > HTTP Test
Generation, and click the Data Correlation tab.

Data correlation types
To access the preference settings for types of data correlation, click Window > Preferences > Test > Test
Generation > HTTP Test Generation, and click the Data Correlation Types tab.
Data Correlation Types
Specify when to generate data correlation constructs. With the Automatic setting, the test
generator creates the required constructs where needed. If the test does not contain the
required constructs, change the setting to On, which will always perform data correlation.
If tests do not require a specific construct, select Off, which has the additional benefit of
improving performance on subsequent test generation.
Jazz Foundation Services
The On and Automatic options enable data correlation for Jazz applications that use REST
storage or query APIs from Jazz Foundation Services. An example of such an application
is Rational DOORS Next Generation. Although data correlation does not typically apply to
browser-based Jazz web clients, it may be useful for other HTTP client-server applications
that use REST services and the Atom Publishing Protocol for updating web resources.
Jazz Web Applications
The On and Automatic options enable data correlation for Jazz web applications that
use the Jazz Foundation web UI framework Examples of these web applications are the
web interfaces for Rational Quality Manager and Rational Team Concert. Data correlation
can also be useful for other web applications that contain javascript that employs JSON
for client-server data exchange. This is a common practice with DOJO- and AJAX-based
applications.
JSON
To perform data correlation on web applications that uses JSON framework, ensure that
Automatic or ON is set to the JSON entry.
Prioritize correlation based on ID
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Select On to correlate HTML response code based on its ID attribute. Generally, the HTML
response code after the recording would appears as <input type="username" name="User"
id="aaa" value="John"/>. Some applications dynamically update the name attribute.

Therefore, when you play back the test, the HTML response code would appear as <input
type="username" name="idt020" id="aaa" value="John"/>. Because the name attribute

is changes dynamically, data correlation does not occur and the playback fails. When this
option is turned on, the ID attribute is considered as the basis to correlate the name attribute
in the request and to locate the value attribute.

Related information
HTTP protocol data view preferences on page135
HTTP recorder preferences on page136
HTTP test editor preferences on page137

SAP test preferences
You can change the product behavior by changing these SAP-related settings.

SAP test editor preferences
The SAP test editor preferences control the specific behavior of the test editor with SAP test suites.
To access the SAP test editor preferences, click Window > Preferences, expand Test, expand Test Editor,
and click SAP Test Editor. After changing a setting, click Apply.
SAP Protocol Data View
These settings specify how the SAP Protocol Data view is displayed.
SAP GUI object highlight color
This setting specifies the color of the frame that highlights selected objects
on the SAP GUI Screen page of the SAP Protocol Data view. By default, the
highlight color is red.
Automatically set focus on SAP Protocol Data view
When enabled, this option automatically ensures that the SAP Protocol Data
view is displayed each time an element is selected in the test editor. Disable
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this option if you want to hide the SAP Protocol Data view or remove it from
the Performance Test perspective. This option is enabled by default.

SAP recording preferences
Test recorder preferences control the default settings for recording SAP tests.
To access the SAP Test Recorder preferences, click Window > Preferences, expand Test, expand
Recording, and click SAP Recording. After changing a setting, click Apply.
Screen capture options
These settings specify how the test recorder handles the screen captures that are shown in
the SAP Protocol Data view.
None
No screen captures are recorded. This saves disk space, but disables the
ability to create events or verification points from the SAP Protocol Data view.
On SAP screen entry
Screen captures are recorded each time a new screen is displayed in the SAP
GUI. The recorded screen capture shows the initial state of the screen, before
user input. This option is enabled by default.
On SAP screen exit
Screen captures are recorded each time a request is sent to the SAP server.
The recorded screen capture shows the final state of the screen, after user
input.
Both
Screen captures are recorded when a new screen is displayed in the SAP GUI
and when the request is sent to the SAP server. The SAP Data Protocol view
displays the final state on the send request elements and the initial state on all
other events.
Select a SAPLOGON configuration file
The saplogon.ini configuration file provides a list of SAP system names that are
displayed in the SAP recorder wizard. Use this setting to change the location of the
saplogon.ini file.
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SAP test generation preferences
Test generation preferences control how SAP tests are generated, such as how tests will process
verification points, data correlation, and the default settings for generated test elements.
To access the SAP Test Generation preferences, click Window > Preferences, expand Test, expand Test
Generation, and click SAP Test Generation. After changing a setting, click Apply.
Automatic Generation
These settings specify test elements that are automatically generated after recording the
test.
Use connection by string
When enabled, tests are generated with the connection by string launch
method instead of using the SAP Logon program. This option is enabled by
default.
Verification points for SAP screen titles
When enabled, this option generates verification points on screen titles with
each SAP screen. This option is disabled by default.
Verification points for SAP request response time threshold
When enabled, this option generates verification points on the response time
of the SAP server. If the server response time is above the specified threshold,
the test produces a failed verification point. This option is disabled by default.
Calculate threshold from recorded (%)
This specifes the default response time threshold that is calculated when
response time verification points are generated. The threshold value is
calculated as a percentage of the actual response time that was measured
during the recording. By default, the response time threshold is generated with
a value of 120% of the recorded response time.
Default request timeout [ms]
Specify a timeout value for a request to ping the server. When the request is timed out, it no
longer pings the server for that request.
GUI on execution
During test execution, it might not be desirable to display the SAP GUI. Hiding the SAP GUI
improves the performance of the virtual users. This setting specifies the default behavior
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when the test is generated. However, you can change this setting in the test editor by
selecting the SAP test element.
Hide GUI during execution
When selected, all instances of the SAP GUI are hidden. In some cases, modal
dialog boxes from the SAP GUI can flash briefly on the screen. This is the
default setting.
Note: If you run a test in the hidden mode and the test fails due to modal
dialog boxes or pop-up windows in transactions, you must add the RPT_VMARGS
property with value set to rptSapForceShowNone=true in the Location property.

Show GUI for only one virtual user
When selected, the SAP GUI is displayed only for the first virtual user. All other
instances of the SAP GUI are hidden. This allows you to monitor the execution.
Show GUI for all virtual users
When selected, the SAP GUI is displayed for all virtual users.
Password prompt
Specifies behavior of the password request.
Prompt me for password when generating test
When enabled, a password is requested at the end of the recording session. If
disabled, the password is recorded with an empty string. The recorder cannot
record the password during the test. Therefore, if this option is disabled, the
test uses an empty string for the password.

Citrix test preferences
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Citrix recorder preferences
Citrix recorder preferences control the behavior of the recording wizard.
To access the Citrix Recorder preferences, click Window > Preferences, expand Test, and click Citrix
Recording. After changing a setting, click Apply.
Screen capture options
These settings specify how the test recorder performs screen captures of the Citrix desktop
during recording.
No automatic screen capture
Select this option if you do not want the test recorder to record screen
captures automatically. When this option is selected, you can still record
screen captures manually. This option is selected by default.
Capture screen every
Select this option to automatically record a periodic screen capture and
specify the time between captures.
Capture screen on window creation
Select this option to record a screen capture each time a window object is
created in Citrix.
Exclude tooltips
When Capture screen on window creation is selected, enable this option to
prevent creating a screen capture each time a tooltip event is displayed during
the recording. If this option is disabled, screen captures are recorded when
tooltips are displayed.
Capture screen on image synchronization
Select this option to ensure that a screen capture is recorded each time an image
synchronization is recorded.

Citrix test editor preferences
Citrix test editor preferences control the test editor for Citrix performance tests.
To access the Citrix Test Editor preferences, click Window > Preferences, expand Test, expand Test
Editor, and click Citrix Test Editor. After changing settings, click Apply.
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Image Previews
These settings specify how screen captures are displayed in the test editor.
Fit screen to visible area
Select this option to automatically fit screen captures to the available area in
the test editor. If disabled, the screen capture will be the actual size, which
might require scrolling. This option is enabled by default.
Draw only last window
Select this option if you want to display only the current window in mouse
sequence actions. When disabled, all recorded windows are displayed. This
option is disabled by default.
Mouse Sequence
These settings specify how mouse sequences are displayed in the test editor.
Display mouse sequences for
This option specifies how you want to display previous, current, or all mouse
sequences in the current mouse sequence.
Current® sequence
Only the current mouse sequence is displayed in the test editor.
This option is selected by default.
Previous and current sequences
The current mouse sequence is displayed with any previous
mouse sequences of the current window.
All sequences
All mouse sequences of the current window are displayed
simultaneously.
Current® mouse sequence color
This option specifies the color of the currently selected mouse sequence.
Current® mouse sequence bold
Select this option if you want to display the current mouse sequence in bold.
This option is selected by default.
Mouse move sequence color
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This option specifies the color of mouse-move sequences when previous or all
sequences are displayed.
Mouse drag sequence color
This option specifies the color of mouse-drag sequences when previous or all
sequences are displayed.
Window color (when screen capture is not available)
This option specifies the color of a rectangle that represents the current
window if there is no screen capture.

Citrix test generation preferences
Test generation preferences control how Citrix performance tests are generated, such as how tests will
process verification points, data correlation, and options of the generated test elements.
Recording Optimization Options
These settings specify how mouse and window events are interpreted in the generated test.
Window activate recording
Specify whether to record no, last, or all window-activate actions when a
sequence of similar actions is detected.
• none disables recording of window-activate events.
• last records only the last of an uninterrupted sequence of window
events. This eliminates redundant window-activate actions from the
recording.
• all records all events of the sequence.
Mouse move recording
This setting specifies which mouse move events are recorded. Relevant is the
default setting.
• All records an uninterrupted sequence of mouse movements in the
generated test.
• Relevant records only the mouse movements that generate a response,
such as hover text.
• First and last records a simplified mouse-move action.
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Automatic Generation
These settings specify test elements that are automatically generated after recording the
test.
Verification point on every window title change
When enabled, this option generates a window title verification point whenever
the caption changes. If this option is disabled, the window title is verified only
when a new window is created. This option is disabled by default.
Response times for main windows
When enabled, this option generates response time measurements for all
recorded main window-create events. A main window is a window that is
created at the top level of the test contents tree and contains user actions.
The generated response time measurement starts with the keyboard or mouse
action that immediately precedes the window-create event. This option is
enabled by default.
Window event synchronization criteria
Use this option to disable window recognition on the window position, size, or title. Disable
any of these options if the test produces synchronization timeouts because a window
changes its position, size, or title between or during test runs.
Default Test Execution Delays
This page specifies the default keyboard and mouse delays for the test client. Do not
change these settings unless you are experiencing problems with events that do not run
correctly.
Synchronization timeout delay
This is the delay after which a timeout error is produced when a window
event or an image synchronization element is not recognized during test
runs. The default value is 15000 milliseconds. The specified delay is for
synchronizations that are set as conditional. Mandatory synchronizations use
a delay of three times the specified delay. Optional synchronizations use a
fixed delay of 2 seconds.
Note: In the generated test, the Override synchronization timeout for
a particular window creation event will be enabled with the corresponding
recorded time only if it is greater than what is specified in this preference.
If think time is under x ms, then replace with
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If the delay between two events is above the specified limit, then it is handled
as a think time. If the delay is below the limit, then the test generator replaces
the think time with one of the following delays. The think time is the delay
spent by a virtual user before performing an action. The default limit is 20000
milliseconds.
Note: In the generated test, the think time for a particular user action
will be enabled only when the recorded think time is greater than the value
specified for this preference.
Delay between mouse down and mouse up in a click
This is the default delay used to generate a mouse click action using a mouse
down and a mouse up action. The default value is 20 milliseconds.
Delay between two mouse clicks in a double click
This is the default delay used to generate a double-click action using two
mouse clicks. The default value is 50 milliseconds.
Delay between key down and a key up in a stroke
This is the default delay used to generate a key-stroke action using a key-down
and a key-up action. The default value is 20 milliseconds.
Delay between two keyboard strokes in a text input
This is the default delay used to generate a text input action using multiple key
stroke actions. The default value is 50 milliseconds.
Default OCR settings
This page specifies the settings for text extraction by optical character recognition in image
synchronizations. You might need to experiment with various settings to obtain good
results. These settings define the default behavior for new image synchronizations. You can
change the behavior for individual image synchronization elements by changing the OCR
settings in the test editor.
OCR default language
This is the language of the dictionary that is used to recognize words for the
application that you are testing. This setting defines the subset of languages
that will be available in image synchronization elements in the test editor.
OCR default zoom factor
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This is the enlargement factor that is applied to the image. The default setting
is medium for standard font sizes. Increase the zoom factor to improve
recognition of smaller fonts or decrease for larger fonts.
OCR default brightness
This is the brightness level from 0 to 250 that is applied to the image. The
default setting is 70 for text with normal contrast. Increase the brightness
setting to improve recognition of darker images or decrease for lighter images.
OCR default recognition rate
This is the rate of recognition that is required for the extracted string to match
the expected text. Decrease the recognition rate to tolerate a proportion of
mismatching characters in the recognized text. The default is 100%, which
means that an exact match is required.

Citrix monitoring panel reference
The Citrix monitoring panel is an optional panel that displays detailed information and control commands
for each virtual user during the run of a schedule. When enabled, the Citrix monitoring panel is available
during the run of a schedule.
Monitoring Panel
This panel displays information about the execution of each virtual user.
Pool Name
Displays the name of the virtual user pool. There is one pool per location and
user group.
Active Virtual Users
Displays the number of virtual users currently active. This value is updated
permanently during the run.
User Action Rate
Displays the number of Citrix user key or mouse actions that were simulated
during the last 5 second interval.
Total Elapsed Time
Displays the total time elapsed since the start of the schedule run.
Current® Action
Displays the last user action executed in the test.
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Timeouts
Displays the number of synchronization timeouts for the virtual user. The color
represents the status of the timeout:
• Green: ok.
• Yellow: a timeout occurred on a conditional synchronization.
• Red: a timeout occurred on a mandatory synchronization.
Elapsed Time
Displays the time elapsed since the start of the virtual user run.
Status
Displays the execution status of the virtual user.
Go To
Click to display the Citrix session of the selected virtual user.
Pause or Play
Click to pause or resume the execution of the selected virtual user. You can also pause the
execution by setting breakpoints in the test.
Step
When the test is on pause, click to execute each user input action in the test, step by step.
To pause test execution, you can either click the Pause button or set breakpoints in the test.
Click Play to resume the test.
Interact
When the test is on pause, click to allow manual actions in the virtual user session. Use
this feature if a test fails to synchronize or gets stuck in an unexpected state. To pause test
execution, you can either click the Pause button or set breakpoints in the test. Click Play
again to resume the test execution at the point where it was paused.
Stop
Click to stop the execution of the selected virtual user. When all virtual users are stopped,
the schedule ends.
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Related information
Enabling and disabling the Citrix monitoring panel on page
Debugging tests with the Citrix monitoring panel on page

Proxy recording preferences
Use these preferences to specify a list of endpoints to ignore when recording a test with the proxy
recorder.
To access the proxy recording preferences, click Window > Preferences, expand Test, expand Recording,
and click Proxy Recording. After changing a setting, click Apply.
Ignore traffic to the following destinations during recording
Select this option to enable filtering of HTTP or HTTPS requests to specific endpoints.
Click Add to add a hostname or IP address to the list of filtered endpoints. You can use the
asterisk (*) character to specify a wild card.

Test editor preferences
The General preferences control what happens when you move test elements, and how digital certificates
are substituted. The Colors and Fonts preferences control how the editor displays dataset and correlation
data. The Search and Replace preferences control the behavior of search and replace.

General
Click Window > Preferences > Test > Test Editor, and click the General tab.
Move selected items into new transactions
Controls whether selected elements are automatically moved into new transactions, or
whether you are prompted each time to move them.
Move selected items into new IF/ELSE blocks
Controls whether selected elements are automatically moved into new conditional blocks, or
whether you are prompted each time to move them.
Move selected items into new loops
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Controls whether selected elements are automatically moved into new loops, or whether you
are prompted each time to move them.
Move selected items into new random selectors
Controls whether selected elements are automatically moved into new random selectors, or
whether you are prompted each time to move them.
Keep children elements
When you delete a test element that has children elements, controls whether the test
element children are also deleted, or whether you are prompted each time to delete them.
Automatically dataset certificate names
Controls whether and how digital certificate names are included in dataseted.
Automatically adjust "once per user" dataset option
Controls whether and how digital certificates in dataset return dataset rows to a particular
virtual user.
Make user-defined strings available to all tests
Click to save user-defined strings for content verification points in the workspace (and thus
make them available to other tests). Click Clear saved to delete all saved strings.

Colors and Fonts
Click Window > Preferences > Test > Test Editor, and click the Colors and Fonts tab.
Here are some tips for working with these settings:
• To change a color, click the color box. From the color palette that opens, choose a different color.
• To save the current settings without closing the window, click Apply.
• To restore the settings to their factory defaults, click Restore Defaults.
• To save and close, click OK.
Information background
Click to change the highlighting shade that distinguishes page requests that contain dataset
candidates, data in dataset, or correlated data.
Disabled Elements
Disabled Elements: Enables you to select the prefix and the color for the test elements that
you manually disable. Click Display nested to precede nested elements with a double prefix
(////). If you first disable a test element and then disable an entire test, the test element
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prefix is ////. Clear Display nested to display all elements, whether nested or not, with a
single prefix (//).
Use color to mark test elements with errors
Click to display in red test elements that have errors.
Appearance color options
Shows the current color settings. Select an element, and then click Foreground or
background to change the settings.
Inline highlighting preview
Enables you to inspect the settings before you actually set them.

Search and Replace
Click Window > Preferences > Test > Test Editor, and click the Search and Replace tab.
Save search text
Click to retain the search text from session to session.
Save selected search types
Click to retain the test elements to search (pages, requests, responses, loops, and so on)
from session to session.
Enable decorations on search results
Click to differentiate between visited and unvisited search results. For example, if you
search for a name, and then click the text in the search result to locate it in the test, the
search result will be marked in the color and the text that you specify.

Report preferences
Report preference settings apply to all protocols.

Test report preferences
The preference settings for test reports control such preferences as the typeface, color, and graph style of
reports, and whether a Compare report is automatically launched when a staged run completes. You can
also display a warning when changing Page Percentile report options will cause data to be lost.
To access the Performance Test Reports preference settings, click Window > Preferences > Test >
Performance Test Reports.
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You can set the following preferences for test reports:
Default Result Action
Set the report or log viewer to be displayed after a test or schedule is run, or when a prior
result is opened from the Test Navigator view.

Default report preferences
Use this page to select the default report that opens during a run. Typically, you select Determine default
report based on protocols in test, which determines the protocols that you are testing, and automatically
opens the appropriate protocol-specific reports. Select a specific default report to display a customized
report or if the default reports do not meet your needs. Note, however, that you will have to change this
setting when you record other protocols.
Open the Default Report Preferences page. Click Window > Preferences > Test > Performance Test
Reports > Default Report.

Export report preferences
Use this page to automatically export reports to a comma-separated-values (CSV) file at the end of a run.
The CSV file is useful when you run a schedule from the command line because you can automatically
export results without opening the workbench. The CSV file contains metadata about the test run, a blank
line, and the report counter data. Simple CSV format contains only the last data value in the run. Full CSV
format contains all data values for every sample interval during a run.
Open the Export Report Preferences page. Click Window > Preferences > Test > Performance Test
Reports > Export Reports.

Web report preferences
Preference settings control access of reports from external web browser.
To access the preference setting for web report, click Window > Preferences > Test > Performance Test
Reports > Web Reports.
You can set the following preferences for the web reports:
Allow remote access from a web browser
Select this check box to allow access to reports from a web browser.
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Allow control of schedule execution from the web browser
Select this check box to control schedule execution from a web browser.
No security is required to access reports
Click this option to allow access to reports without login credentials. Specify a port number.
Security is required to access reports
Click this option to provide an authentication layer for accessing reports. Specify a port
number and provide the login credentials.

Percentile analysis preferences
Use this view to customize the percentiles that are reported in the Page Percentile report or to customize
the requirements on a percentile response. The defaults, 85, 90, and 95, are sufficient for most purposes.
However, if you need to report on a different percentile set, or to set a different percentile requirement, you
can edit the percentiles or add new percentiles.
Open the Percentile Analysis Targets preference page. Click Window > Preferences > Test > Percentile
Analysis Targets.

Test editor references
To understand the relevance of different UI fields in the test editor of various test extensions, read these
topics.

HTTP test editor reference
In HTTP testing, the test editor information is divided into five categories. This section describes the fields
in each category that can be edited manually.
This section focuses on low-level editing tasks that experienced performance testers do. For information
about the layout of the test editor and the more commonly performed, high-level editing tasks, see Editing
HTTP tests on page

.

HTTP test details
Test detail fields apply to the entire test.
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Common options
Datasets
Lists details about each dataset that the test uses: the name of the dataset, the columns
that are used, and the location in the test where the dataset column is referenced. Click an
item in the Location column to go to that location.
Add Dataset
Click to add a reference to a dataset for test to use. Clicking this option is the same as
clicking Add > Dataset with the test selected.
Delete
Select a dataset reference, and then click to delete the reference from the test. The dataset
is still available to other tests.
Show Dataset Candidates
Click to open the Show Dataset Candidates window, where you can review and change data
correlation.
Digital Certificates
Lists details about the certificate stores that the test uses. Click Add to add a certificate
store for the test to use. HTTP and SOA support digital certificates. Other protocols do not
support digital certificates.
Enable response time breakdown
Enables collection of response time breakdown data. With response time breakdown, you
can see statistics on any page element. The statistics show how much time was spent in
each part of the system under test. You can use response time breakdown to identify code
problems. You can see which application on which server is the performance bottleneck,
and then drill down further to determine exactly which package, class, or method is causing
the problem.
This option is displayed in multiple test elements. Enabling this option in an element also
enables it in the element’s children. For example, enabling monitoring at the test level also
enables monitoring at the page and request levels. You can enable monitoring for a specific
page; doing so enables monitoring for the requests of that page, but not for other pages or
their requests.
HTTP and SOA support response time breakdown. Other protocols do not support response
time breakdown.
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Security
Digital Certificates
Lists details about the certificate stores that the test uses. Click Add to add a certificate
store for the test to use. Not all protocols support digital certificates.
Enable Kerberos authentication
Select to enable Kerberos authentication. The user ID, password, and realm are supplied
when a Kerberos authentication challenge occurs during playback. If you record a test using
no authentication, and then enable Kerberos authentication on the system under test, select
this check box.
User ID
Type the user principal name. The user principal name format consists of the user name,
the "at" sign (@), and a user principal name suffix. Do not use the domain\username format.
User IDs are case-sensitive.
Password
Type the password for the User ID. Passwords are case-sensitive.
Client realm
Type the realm of the client application. In Windows environments, the client realm is the
Windows domain name for the computer sending the request to the server. Typically, the
client realm is all uppercase.
Client KDC
Type the name of the client key distribution center. In Windows environments, the client key
distribution center is the hostname of the domain controller for the client realm. By default,
the client key distribution center is set to the domain controller of the computer where the
test was recorded. Verify the default value with your system administrator.
Server realm
Type the realm of the server under test. The client and server might share the same realm.
Type the server realm only if the server realm is different from the client realm. Contact your
system administrator for more information about the server realm.
Server KDC
Type the name of the server key distribution center. In Windows environments, the server
key distribution center is the hostname of the domain controller for the server domain. Type
the server key distribution center only if the server is in a different domain than the client.
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Enable response time breakdown
Select to enable the collection of response time breakdown data. You can enable response
time breakdown collection at the parent or page level. Not all test elements support
response time breakdown data collection.

Performance Requirements
Requirements
The table displays the performance and functional requirements that are defined in the test.
To edit a requirement definition, double-click a table row. To return to this table, click the root
name of the test in the Test Contents area.
Clear
Select one or more requirements and click to remove the definition. The requirement is still
available and can be redefined.
Enable response time breakdown
Select to enable the collection of response time breakdown data. You can enable response
time breakdown collection at the parent or page level. Not all test elements support
response time breakdown data collection.

HTTP options
Timeout action
Specifies what the test does if the primary request for a page does not succeed within the
Timeout interval. If you select Log error and continue execution, the test logs the error and
proceeds to the next page. If you select Try to reload the page, the test attempts to reload
the page one more time. If that attempt fails, the test logs an error and proceeds to the next
page.
Timeout
Specifies the time threshold for initiating the action that you select for Timeout action.
Clear cookie cache when the test starts
This option resets the cookie cache when looping in the schedule or when a test follows
another test in the schedule. By default, the cookie cache for a virtual user is not reset,
which is consistent with browser behavior. If you want each loop iteration to behave as
a new user, select this option. Otherwise, the cookies in the cache might alter the server
responses and verification points might fail. To reset the cookie cache from one loop
iteration to the next when looping within a test, add custom code and call an API.
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Clear page cache when the test starts
This option deletes the page cache when a test starts. Typically, when a test follows another
test in the schedule or when you anticipate an out-of-memory exception due to overload, you
can delete the cache.
Disable page cache emulation in this test
This option disables page cache emulation. When page cache emulation is enabled, caching
information in server response headers is honored. Additionally, requests are not submitted
to the server for content that is confirmed by the client as fresh in the local cache. Page
cache emulation is enabled by default.
Remove HTTP request delays from page response times
To not include the client delays in the page response times for the test or A schedule, in this
context, is used to refer to both VU Schedule and Rate Schedule, select this check box. By
default, the page response times include delays to represent processing time caused by
clients such as a web browser. Sometimes this delay could exceed the logical limit causing
page response times to increase drastically.
Playback speed
Move the slider to increase or decrease the speed at which the HTTP requests are sent. You
can specify a range from no delays to twice the recorded length. This scale is applied to the
Delay field of each request in the test. If you speed playback up dramatically, requests might
occur out of order. To fix this problem, reduce playback speed until the test runs correctly
again.
Note: To set a maximum request delay, click Window > Preferences > Test > Test
Generation > HTTP Test Generation. Click the Protocol tab, and enter a value for Maximum
Request Delay.
Secondary request behavior
Click Modify to disable or reenable requests that occur within a page. You can disable all
secondary requests, images, host-based or port-based requests, or user-defined requests.
Enable response time breakdown
Select to enable the collection of response time breakdown data. You can enable response
time breakdown collection at the parent or page level. Not all test elements support
response time breakdown data collection.
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Related information
HTTP page details on page163
HTTP request details on page166
HTTP response data details on page171
HTTP server access configuration details on page172

HTTP page details
Page detail fields apply to the page that is currently selected.
General tab
Page title
Specifies the display name for the page. If the primary request returned a title, the display
name for the page is the content between the <title></title> tags. If the primary request
returned no title or an empty title, a name for the page is constructed from the first node in
the web address for the primary request URL, for example, www.site.com/displayname/....
If two pages have the same page title but are at different web addresses (for their primary
request), then a number might be appended to indicate that they are different (for example,
displayname {1}, displayname {2}). The pages are included in reports as separate pages,
with their unique appended names.
Pages with the same title and web address appear in the test editor with the same page title
and in reports as the same page. Rename any pages that you want to be reported on under
a different name. Renaming a page neither changes the value (if any) between the <title></
title> tags nor affects how the test runs.
Primary request
Displays a hyperlink to the primary request for the page. This request is highlighted and is
the request from which the display name for the page is derived.
Think time
Specifies the programmatically calculated time delay that is observed for each user when
this test is run with multiple virtual users. Think time is a statistical emulation of the amount
of time actual users spend reading or thinking about a page before requesting another page
from the server.
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Test data
Summarizes data substitutions and potential matches in the page. Right-click a row, or
select a row and then click Options, to perform common operations. Double-click a row
to navigate to the location where a substitution or potential match occurs. To associate
a dataset candidate with a dataset, click the row, and then click Substitute. To remove
a dataset substitution, click the row, and then click Remove Substitution. To find more
locations in the test that have the same value as the selected row, click Find More. Click the
icons to the left of the preview area to switch between an inline view and a hierarchical view
of the selected data.
URL Encode
Indicates whether a test value contains special characters such as spaces or commas.
With this option, special characters are encoded when variable data is substituted from a
dataset.
Page title verification point
Indicates whether the page title verification point is enabled for this page. If so, Enable
verification point is selected.
When Enable verification point is selected, the value between the <title></title> tags, if any,
is copied to the Expected page title field on the properties page of the verification point.
Click Edit Properties to change the Expected page title. The value between the title tags
is different from the display page title (the value in the Page title field) that is used for
reporting. Changing the Page title does not change the value between the title tags, and
therefore does not affect what is initially copied to the Expected page title field.
If Enable verification point is selected, the test verifies whether the page returns the value
in the Expected page title field. An error is reported in the test log if the title returned by the
primary request for the page does not contain the expected title. Although the comparison
is case-sensitive, it ignores multiple white-space characters (such as spaces, tabs, and
carriage returns).
Enable response time breakdown
Enables collection of response time breakdown data. With response time breakdown, you
can see statistics on any page element. The statistics show how much time was spent in
each part of the system under test. You can use response time breakdown to identify code
problems. You can see which application on which server is the performance bottleneck,
and then drill down further to determine exactly which package, class, or method is causing
the problem.
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This option is displayed in multiple test elements. Enabling this option in an element also
enables it in the element’s children. For example, enabling monitoring at the test level also
enables monitoring at the page and request levels. You can enable monitoring for a specific
page; doing so enables monitoring for the requests of that page, but not for other pages or
their requests.
HTTP and SOA support response time breakdown. Other protocols do not support response
time breakdown.
Advanced tab
Enable Requirements
Select to enable the use of performance and functional requirements for this test.
Name
Specifies the name of this set of enabled requirements. By default, it is the URL of the page.
Although you can change the name to improve readability, only the Requirements report
uses the changed name. Other reports use the default name. Click Use Defaults to reset
Name to the default value.
Requirement
All performance and functional requirements are displayed in the table. Shaded
requirements indicate that they are undefined. To define a requirement, set an Operator and
Value. To apply the defined requirement to multiple pages, select the pages in the test, rightclick the requirement row in the table, and click Copy Requirements.
Operator
Click this field to display a list of mathematical operators. Select an operator for this
requirement.
Value
Click this field to set a numeric time value in milliseconds.
Standard
Select to enable this requirement to be processed by the report as a standard requirement.
Standard requirements can cause a test to fail. Requirements that are not listed as standard
do not cause the test to fail.
Hide Undefined Requirements
Select to prevent undefined requirements from appearing in the table. This hides the shaded
rows.
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Clear
Select one or more requirements and click to remove the definition. The requirement is still
available and can be redefined.
Error Handling
Click to open the error condition table. You can use error handling to specify an action to
take and a message to log when a specific condition occurs. Conditions include verification
point failures, server timeouts, custom code alerts, and data correlation problems. All
conditions are displayed in the table, along with the action to take and the message to log
when the error occurs. To define an error handler, select a Condition, and then click Edit.
Hide unselected conditions
Click to display only the selected error handlers. Hiding a condition does not deactivate the
condition.

Related information
HTTP test details on page158
HTTP request details on page166
HTTP response data details on page171
HTTP server access configuration details on page172

HTTP request details
Page request fields apply to the page that is currently selected.
General tab
Version
Indicates the HTTP version.
Method
Indicates the HTTP request method that was used during recording. Typically, you do not
change this value unless you are adding a new request to a test. GET, POST, PUT, HEAD,
PATCH, and DELETE are supported.
Primary request for page
Displayed for the primary request, and cannot be modified. A page can contain only one
primary request.
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Click to set as primary
Displayed for all secondary requests. Because each page can have only one primary
request, if you select this option, the Primary request for page option is moved to this
request, and the Click to set as primary option is moved to the original primary request. To
undo your change, select Click to set as primary on the original primary request.
Connection
Specifies the connection to the web server. The connection includes the host name, which
is typically the fully qualified domain name, and the listener port on the web server. Click the
name of the connection to navigate to the server access configuration where the connection
is defined. Click Change to change the connection used for this request.
Total number of requests
Applies to HTTP Secondary Request Generator. Specify the number of requests to send to
the server. If there is an array variable assigned to the request, the number of requests set in
the Test editor takes precedence.
URL
Specifies the path to a resource (such as a page, graphics file, or stylesheet file). When the
method is GET, the URL field typically includes query strings that are designated as dataset
candidates.
Data
Specifies additional content data that might be needed to clarify the request. When the
method is POST, the data frequently includes values that are designated as dataset
candidates.
Request Headers
Lists each request header and its value. To change the value of a header, click the row, and
then click Modify. To add a new header, click Add. To delete a header, click Remove.
Enable response time breakdown
Select to enable the collection of response time breakdown data. You can enable response
time breakdown collection at the parent or page level. Not all test elements support
response time breakdown data collection.
Use the Advanced page to configure performance requirements, error handling, and delay behavior for the
request.
Advanced tab
Always log details
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To ensure that the details about the request is always logged, select this check box.
Use substituted URL in performance reports
Use this option to view the substitutions in Page Elements report.
Requirement
All performance and functional requirements are displayed in the table. Shaded
requirements indicate that they are undefined. To define a requirement, provide details
in Operator and Value. To apply the defined requirement to multiple requests, select
the requests in the test, right-click the requirement row in the table, and click Copy
Requirements.
Enable Requirements
Select to enable the use of performance and functional requirements for this test.
Name
Specifies the name of this set of defined requirements. By default, the name is the
URL of the request. Although you can change the name to improve readability, only the
Requirements report uses this name. Other reports use the default name. Click Use Defaults
to reset Name to the default value.
Operator
Click this field to display a list of mathematical operators. Select an operator for the
performance requirement.
Value
Click this field to set a value for the requirement.
Standard
Select to enable this requirement to be processed by the report as a standard requirement.
Standard requirements can cause a test to fail. Requirements that are not listed as standard
do not cause the test to fail.
Hide Undefined Requirements
Select to prevent the table from including undefined requirement candidates. Selecting this
check box hides all shaded rows.
Clear
Select one or more requirements, and click to remove the definition. The requirement is still
available and can be redefined.
Error Handling
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Click to open the error condition table. You can use error handling to specify an action
to take and a message to log when a specific condition occurs. Error conditions include
verification point failures, server timeouts, custom code alerts, and data correlation
problems. All error conditions are displayed in the table, beside the action to take and the
message to log when the error occurs. To define an error handler, select a Condition, and
then click Edit. The Errors report lists the number of errors and the corresponding actions
that occurred in the test or schedule. You can also specify whether an error contributes
to the health of the page. To set the health parameter, select a Condition and select the
Override contribution to health status check box. The Page Health report shows the health
of each page.
Hide unselected conditions
Click to display only the selected error handlers. Hiding a condition does not deactivate the
condition.
Applied Transform
Indicates the data transformation that is applied to the request. Click Change to select a
data transformation to apply to the request.
Character set
Indicates the character set to be used for the page request. Click Change to see the valid
character sets.
Pre / Postprocessing
To modify and inspect certain aspects of the action before and after it is executed, specify
pre and post processors. Click Create to create the Java file that will contain the skeleton
of the Java file needed. Click Browse to navigate to a Java processor that has already been
created.
Client Processing Delay
Previous versions of tests support only waiting for primary requests. Wait for and Release
when are not available. The additional delay in previous versions of tests is measured from
the first character received of the primary request.
Wait for
Indicates the associated request that must start or finish before this request is issued. Click
Request to select a different request. Click the Clear request association icon to remove the
association.
Release when
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Select Last Character Received or First Character Received to indicate when this request is
issued in relation to the associated request.
Additional delay (ms)
Indicates the additional delay, in milliseconds, to wait before this request is issued. Delays
are statistical emulations of user behavior. You can scale this delay at the test level to make
a test play back faster (or slower) than it was recorded.
Delay Between Requests
Applies to HTTP Secondary Request Generator. Use the delays to control the flow of
the requests to the server. In Release When, select when exactly to release the request.
For instance, First Character Sent indicates to release the second request after the first
character in the first request is sent.
In Additional delay, specify a value in milliseconds to indicate additional delay to send the
request.
Digital Certificates
Lists details about the certificate stores that the test uses. Click Add to add a certificate
store for the test to use. HTTP and SOA support digital certificates. Other protocols do not
support digital certificates.
Enable response time breakdown
Enables collection of response time breakdown data. With response time breakdown, you
can see statistics on any page element. The statistics show how much time was spent in
each part of the system under test. You can use response time breakdown to identify code
problems. You can see which application on which server is the performance bottleneck,
and then drill down further to determine exactly which package, class, or method is causing
the problem.
This option is displayed in multiple test elements. Enabling this option in an element also
enables it in the element’s children. For example, enabling monitoring at the test level also
enables monitoring at the page and request levels. You can enable monitoring for a specific
page; doing so enables monitoring for the requests of that page, but not for other pages or
their requests.
HTTP and SOA support response time breakdown. Other protocols do not support response
time breakdown.
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Related information
HTTP test details on page158
HTTP page details on page163
HTTP response data details on page171
HTTP server access configuration details on page172

HTTP response data details
Response data fields apply to the response data that is returned by each page request.
General tab
Status
Indicates the status code for the HTTP response, such as 200, 201, 203, or 302.
Version
Indicates the HTTP version, such as 1.1.
Reason
Indicates the code for the HTTP response, such as OK, Found, or Not Found.
Response Headers
Lists each response header and its value. To change the value of a header, click the row, and
then click Modify. To add a new header, click Add. To delete a header, click Remove.
Content
Shows the content (such as tagged HTML, graphics files, or stylesheet files) that the web
server returned, based on the corresponding request.
Advanced tab
Applied transform
Indicates the data transform that is applied to the response. Click Change to select a data
transform to apply to the response.
Character set
Indicates the character set to be used for the response. Click Change and select the
encoding to change the character set.
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Related information
HTTP test details on page158
HTTP page details on page163
HTTP request details on page166
HTTP server access configuration details on page172

HTTP server access configuration details
Server access configurations store HTTP connection information. By default, a connection does not
remain open across test boundaries. Several connections can use the same server access configuration,
and the same connection can be used by several other requests in the same test. If you change the host,
port, or authentication for a server access configuration, those changes apply to all connections in the
test that use the configuration.
Configuration name
Specifies the name of the server access configuration.
Host
Specifies the name of the host for the web server. Usually, this is the fully qualified domain
name, but it can be an IP address or other name.
Port
Specifies the listener port on the web server.
Authentication and security
Indicates whether this connection uses the Secure Sockets Layer (SSL) protocol, the NT/
LAN Manager (NTLM) authentication protocol from Microsoft™, or an HTTP proxy server. A
blank field indicates that the connection is unauthenticated and not secure. To add proxy,
SSL, or NTLM authentication, expand the request, click the connection, and then click Add.
Connections that use this configuration
Lists the connections that use this configuration.

Related information
HTTP test details on page158
HTTP page details on page163
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HTTP request details on page166
HTTP response data details on page171

SAP test editor reference
In SAP testing, the test editor information is divided into nine categories. This section describes the fields
in each category that can be edited manually.

SAP test details
In the test editor, the test element is the first element in the test suite. These settings apply to the entire
test.

SAP options
Display SAP GUI on execution
During test execution, it might not be desirable to display the SAP GUI. Hiding the SAP GUI
improves the performance of the virtual users. This setting specifies the behavior for the
current test suite. However, you can change the default setting for generated tests in the
SAP Test Generation preferences.
Hide
When selected, all instances of the SAP GUI are hidden. In some cases, modal
dialog boxes from the SAP GUI can flash briefly on the screen. This is the
default setting.
Show
When selected, the SAP GUI is displayed for all virtual users.
Show only first virtual user
When selected, the SAP GUI is displayed only for the first virtual user. All other
instances of the SAP GUI are hidden. This allows you to monitor the execution.

Common options
Datasets
Lists details about each dataset used by the test: the name of the dataset, the columns
that are used, and the location in the test where the dataset column is referenced. Click the
location to navigate there.
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Add dataset
Adds a reference to a dataset that you want a test to use. Clicking this option is the same as
clicking Add > Dataset with the test selected.
Remove
Removes the selected dataset. This option is not available if the dataset is in use.

Related information
SAP connection details on page174
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP connection details
In the test editor, SAP connection elements are at the top of the test site and describe the connection to
the SAP server. These settings apply to the entire test.
SAP system name
This is the description normally used by SAP Logon to identify the server. If the Connection
by string option is selected this field is ignored.
Connection by string
Select this option to use the connection string that was returned by the server when
recording to connect to the server without referring to the SAP Logon program. This is safer
when deploying the test on remote computers. Advanced users can edit the connection
string if necessary. You can use data correlation to substitute this value.
Get SAP GUI session statistics
Select this option to record session statistics from the SAP GUI client in the test results.
These results are displayed on the User Load page of the test report.
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Use new visual design
Select this option to run tests with a visual design theme when using SAP GUI 7.0 or later.
In most cases, it is best to leave this option disabled, which causes tests to run with the
default SAP GUI visual design and avoids compatibility issues.
Use recorded visual design theme
If Use new visual design is selected, select this option to use the visual design
theme that was used during the recording o
Use other visual design theme
If Use new visual design is selected, select this option to use a specific visual
design theme. Ensure that the name is correct and that the visual design
theme is installed on the test computer. Unexpected results might occur if
you specify a visual design theme name that cannot be located on the test
computer.

Related information
SAP test details on page173
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP screen details
In the test editor, SAP screen elements are located in transactions and are the basic performance
measurement unit for the test. These settings apply to the selected get event.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.
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Title
This is the recorded name of the SAP screen. This field is read-only.
Do not measure performance on this screen
Select this option if you do not want to obtain response time results for the current SAP
screen. Use this for SAP screens that are not meaningful for your test, such as the logon
screen.
Optional screen
Select this option if you do not want to log an error when the current SAP screen is not
displayed. Use this for SAP screens that are not always displayed.
Data Table
Summarizes data substitutions and substitution candidates in the SAP screen. Double-click
a row to navigate to the location where a substitution or candidate occurs. To associate a
dataset candidate with a dataset, click the row and then click Dataset Variable. To remove a
dataset substitution, click the row and then click Remove Substitution.

Screen Title Verification Point
Enable Verification Point
When selected, the test verifies whether the SAP screen returns the value shown in the
Expected screen title field. An error is reported in the test log if the screen title returned
during the test does not match the expected title.
Expected screen title
This field allows you to specify the expected SAP screen title. By default, the expected title is
the recorded title. The expected title can optionally be expressed as a regular expression.
Recorded screen title
This field displays the recorded title of the current SAP screen. This field is read-only.
Use Regular Expression
Select this option to express the expected title using the standard regular expression syntax.

Related information
SAP test details on page173
SAP connection details on page174
SAP set details on page177
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SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP set details
In the test editor, SAP sets are located in SAP screen elements and describe a user input action in the SAP
GUI client. These settings apply to the selected SAP set.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.
Think Time
Specifies the programmatically-calculated time delay that is observed for each user when
this test is run with multiple virtual users. Think time is a statistical emulation of the amount
of time actual users spend reading or thinking before performing an action.

SAP Set
Property name
This is the description of the GUI object related to the current SAP set as it appears to the
user in the SAP GUI. This field is read-only.
Value
This is the value entered by the user in the current SAP set. You can use data correlation to
substitute this value.

SAP GUI Object Information
Name
This is the recorded name of the GUI object related to the current element. This field is readonly.
Type
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This is the recorded type of the GUI object related to the current element. This field is readonly.
Identifier
This is the recorded identifier of the GUI object related to the current element. This field is
read-only.

Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP get details
In the test editor, SAP get events are located in SAP screen elements and provide a way to retrieve data
from a SAP GUI object to implement verification points. These settings apply to the selected get event.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.
Think Time
Specifies the programmatically-calculated time delay that is observed for each user when
this test is run with multiple virtual users. Think time is a statistical emulation of the amount
of time actual users spend reading or thinking before performing an action.

SAP Get
Property name
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This is the description of the GUI object related to the current event as it appears to the user
in the SAP GUI client. This field is read-only.
Value
This is the value recorded during the test or during the last execution. You can use data
correlation to reference this value. This field is read-only.

Verification Point
Enable Verification Point
When selected, the test verifies whether the screen returns the value specified in Expected
Value. An error is reported in the test log if the value returned during the test does not match
the expected value.
Expected Value
This field enables you to specify the expected value for the get event. The expected value
can optionally be expressed as a regular expression. You can use data correlation to
substitute this value.
Use Regular Expression
Select this option to express the expected value using standard regular expression syntax.

SAP GUI Object Information
Name
This is the recorded name of the GUI object related to the current element. This field is readonly.
Type
This is the recorded type of the GUI object related to the current element. This field is readonly.
Identifier
This is the recorded identifier of the GUI object related to the current element. This field is
read-only.

Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
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SAP set details on page177
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP call details
In the test editor, SAP call elements are located in SAP screen elements and describe various recorded
interactions with the SAP server. These settings apply to the selected SAP event.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.
Think Time
Specifies the programmatically-calculated time delay that is observed for each user when
this test is run with multiple virtual users. Think time is a statistical emulation of the amount
of time actual users spend reading or thinking before performing an action.

SAP Call
Method name
This is the internal method call used by the SAP GUI client. This field is read-only.
Parameter
If the method uses parameters, one Parameter line is displayed for each parameter.
Advanced users can modify these parameters. Refer to SAP documentation for more
information about the parameters used by SAP GUI method calls. You can use data
correlation to substitute this value.
Return
If the method returns a value, a Return line is displayed, which can be used for data
correlation or for a verification point. The value displayed is not the actual return value, but
only represents the type of the parameter, for example, string for a string type or 0 for an
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integer. Refer to SAP documentation for more information about the parameters used by
SAP GUI method calls.

Verification Point
Enable Verification Point
When selected, the test verifies whether the Return value of the SAP call (if any) matches
the value specified in Expected Value. An error is reported in the test log if the value
returned during the test does not match the expected value.
Expected Value
This field enables you to specify the expected value for the call. The expected value can
optionally be expressed as a regular expression. You can use data correlation to substitute
this value.
Use Regular Expression
Select this option to express the expected value using standard regular expression syntax.

SAP GUI Object Information
Name
This is the recorded name of the GUI object related to the current element. This field is readonly.
Type
This is the recorded type of the GUI object related to the current element. This field is readonly.
Identifier
This is the recorded identifier of the GUI object related to the current element. This field is
read-only.

Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP server request details on page182

181

Reference Guide

SAP batch connection details on page183
SAP batch input transaction details on page185

SAP server request details
In the test editor, server request elements are located at the end of every SAP screen and provide
information that the server returns for the selected screen.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.

SAP Screen
Name
This is the name of the current SAP transaction code. This field is read-only.
Program
This is the name of the SAP source program that is currently running. This field is read-only.
Flushes
This is the count of the number of flushes in the automation queue during server
communication. This field is read-only.
Response Time
This is the delay between the moment the SAP GUI client sends the request to the SAP
server and the moment the server response arrives. The units are milliseconds. This field is
read-only.
Interpretation Time
This is the delay between the moment the data is received by the SAP GUI client and the
moment the screen is updated. It measures interpretation of data by the SAP GUI client, not
SAP server performance. The units are milliseconds. This field is read-only.
Roundtrips
This is the count of token switches between the SAP GUI client and the SAP server to
perform the request. This field is read-only.
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Request Time Verification Point
Enable verification point
When selected, the test verifies whether the request time returned by the server is below the
specified threshold value. An error is reported in the test log if the measured request time is
above the threshold.
Response time threshold (ms)
This is the request time limit above which an error is reported in the test log.

Request Timeout
Timeout value (ms)
Select this option to change the default timeout value (3 minutes) for very long transactions.
Response time threshold (ms)
The test verifies that the request time returned by the server is below the specified threshold
value. An error is reported in the test log if the measured request time is above the
threshold.

Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP call details on page180
SAP batch connection details on page183
SAP batch input transaction details on page185

SAP batch connection details
In SAP batch input tests, SAP batch connections contain the basic connection information for a batch
input test to connect to the SAP server without a SAP GUI. In most cases, these details are the same as
those used when you connect manually to SAP with the SAP GUI.
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SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.

SAP Batch Input Connection
Client
This is the SAP client number that is used by the batch input test to connect to the SAP
server. You can use data correlation to substitute this value.
User
This is the user name that the batch input test uses to connect to the SAP server. You can
use data correlation to substitute this value.
Password
This is the password that the batch input test uses to connect to the SAP server. You can
use data correlation to substitute this value.
Language
This is the two-letter language code. You can use data correlation to substitute this value.
Host
This is the IP address or computer name of the SAP server. You can use data correlation to
substitute this value.
System Number
This is the system number of the SAP server. You can use data correlation to substitute this
value.
Additional SAP Connection Properties
Use this list to specify any advanced SAP Java™ Connector (JCo) properties for advanced
SAP router setup. Select the JCo property that you want to set in the Property name list, and
type the required value in Property value. Click Add to add more properties.
Test Connection
Use this button to test the connection to the SAP server.
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Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch input transaction details on page185

SAP batch input transaction details
In the SAP batch input tests, SAP batch input transactions are located in transactions and are recorded
transactions that are to be run at a low level, without a SAP GUI, in order to produce a load on the SAP
server.
SAP element label
This is the name of the selected SAP test element as it is displayed in the Test Contents.
Use this field to rename the test element, or click Restore Default to revert to the default
name.

SAP Batch Input Transaction
Code
This is the SAP transaction code of the recorded transaction.
Mode
This is the mode of the batch input transaction as it was recorded in the SAP GUI.
Data table
This is the data table of the batch input transaction as it was recorded in the SAP GUI. See
the SAP documentation for details on the contents of the recording.
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Related information
SAP test details on page173
SAP connection details on page174
SAP screen details on page175
SAP set details on page177
SAP get details on page178
SAP call details on page180
SAP server request details on page182
SAP batch connection details on page183

Citrix test editor reference
In Citrix testing, the test editor information is divided into eleven categories. This section describes the
fields in each category that can be edited manually.

Citrix test details
In the test editor, the Citrix Test is the first element of a Citrix test. These settings apply to the entire Citrix
test.

Citrix options
Synchronization timeout delay
This is the delay after which a timeout error is produced when a window event is not
recognized during test execution. The default value is 6000 milliseconds.
Delay between mouse down and mouse up in a click
This is the default delay used to generate a mouse click action using a mouse down and a
mouse up action. The default value is 50 milliseconds.
Delay between two mouse clicks in a double click
This is the default delay used to generate a double-click action using two mouse clicks. The
default value is 200 milliseconds.
Delay between key down and a key up in a key stroke
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This is the default delay used to generate a key stroke action using a key down and a key up
action. The default value is 100 milliseconds.
Delay between two keyboard strokes in a text input
This is the default delay used to generate a text input action using multiple key stroke
actions. The default value is 500 milliseconds.

Common options
Datasets
Lists details about each dataset used by the test: the name of the dataset, the columns
that are used, and the location in the test where the dataset column is referenced. Click the
location to navigate there.
Add dataset
Adds a reference to a dataset that you want a test to use. Clicking this option is the same as
clicking Add > Dataset with the test selected.
Remove
Removes the selected dataset. This option is not available if the dataset is in use.

Related information
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203
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Citrix session details
In the test editor, the session is located at the top of the Citrix test. Session settings apply to connection
with the server.

Session Attributes
Session Title
This is the name of the current session. By default, it is the same as the name of the test.
Server Address
This is the address of the Citrix server. The value can be a host name or an IP address. This
value can be linked to a dataset.
Initial Program
This is the name of a published application on the Citrix server. Use this option to manually
specify a published application if no Independent Computing Architecture (ICA) file is
available. If no published application and no ICA file is specified, the session starts with the
Windows™ desktop.
ICA File
If you recorded the test with an ICA file, this is the location and name of the file. The ICA file
contains connection and application information to launch directly a published application
with the Citrix XenApp client.
User name and Password
These fields allow you to specify user authentication information. These values can be
linked to a dataset.
Color Depth
This is the recorded color depth for the Citrix XenApp client. This value is read-only.
Screen Size
This is the recorded screen resolution for the Citrix XenApp client. This value is read-only.

Response Time Definitions
This table defines the response time measurements that will be performed during the test. By default,
response times are automatically generated on main create window events.
Response Time
This is the name of the response time measurement. To change a name, select a response
time and click Rename. These names appear in the performance test report.
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Started by
This is the user input action that triggers the start of the response time measurement. To
navigate to the corresponding user input action in the test editor, click Go to Start.
Stopped by
This is the user window event that stops the response time measurement. To navigate to
the corresponding user input action in the test editor, click Go to Stop.
Add, Rename and Delete
These buttons allow you to manually create, rename or delete a response time
measurement.

Related information
Citrix test details on page186
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix window details
In the test editor, the Citrix window elements contain all user input actions and window events. These
settings apply to the selected window element.
Window Title
This is the title of the window as displayed in the Citrix session. Some windows do not have
titles, and the window ID is used for identification. This field is read-only.
Window ID
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This is the window ID number attributed by the Windows™ operating system when the
window is created during the recording session. This number changes each time the test is
executed, but the ID remains the same throughout a session. This field is read-only.
Locations
This field displays the X and Y coordinates of the top left corner of the window and size of
the window in pixels. This field is read-only.
Window recognition during execution uses
This option allows you to disable window recognition on window position or size. Disable
any of these options if the test produces synchronization timeouts because a window
changes its position or size between or during test runs.
Parent Window
This is a link to the window element that is the parent of the selected window.
Go to same occurrences of this window
Use these navigation buttons to navigate through the test to other occurrences of this
window, for example if during a test the user switches back and forth between windows, or
if the current window is modified in any way.

Styles
Window Styles
This area lists the style properties that are enabled for the current window. These are readonly.
Window Extended Styles
This area lists the extended style properties that are enabled for the current window. These
are read-only.

Verification Point
Enable Verification Point
When selected, the test verifies whether the window returns the title shown in the Expected
title field. An error is reported in the test log if the title returned during the test does not
match the expected title.
Use Regular Expression
Select this option to express the expected title using standard regular expression syntax.
Expected title
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This field allows you to specify the expected title for the window. The expected title can
optionally be expressed as a regular expression.
Recorded title
This displays the title that was recorded for the current window. This field is read-only.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix window event details
In the test editor, the Citrix window event elements are located inside window elements and describe any
changes to the location or size of a window. These settings apply to the selected window event element.
Type of Event
This is the type of window event.
Window ID
This is the window ID number attributed by the Windows™ operating system when the
window is created during the recording session. This number changes each time the test is
executed, but the ID remains the same throughout a session. This field is read only.
Window Title
This is the title of the window as displayed in the Citrix session. Some windows do not have
titles, and the window ID is used for identification. This field is read only. You can click the
window title to select the window element in the test contents.
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Window Title
This is the title of the window as displayed in the Citrix session. Some windows do not have
titles, and the window ID is used for identification. This field is read only. You can click the
window title to select the window element in the test contents.
Synchronization state
This describes the behavior of the test if a synchronization timeout occurs on the window
event. The base timeout delay is specified in the Citrix test generation preferences, however
the actual delay varies with the level of synchronization.
Conditional
The conditional timeout delay is the base timeout delay as specified in the
Citrix test generation preferences. If the synchronization fails, the test tries to
resume execution and a timeout is logged in the Citrix performance report and
the test log.
Mandatory
The mandatory timeout delay is three times the base timeout delay. If the
synchronization fails, the test exits with an error status and a timeout is logged
in the test log.
Optional
The optional timeout delay is fixed at 2 seconds. If the synchronization fails,
the test ignores the timeout.

Response Time
Stop response time for
Select this option to use the current window event to stop a response time measurement.
When you select this option on an window event that is not already linked to a response
time, a new response time is created with a default name. If there are response times that
do not have a stop action, then these are also listed. Select the response time that you want
to link to.
Go to response time definition
Click here to navigate to the session element to view the Response Time Definitions table.
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Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix key action details
Citrix key action fields apply to the selected key action element.
Type
This is the type of key action.
• Key Down: The key is pressed.
• Key Up: The key is released.
• Key Stroke: The key is pressed and released.
Key Code
This is the code of the key as interpreted by the Windows™ operating system.
Character
This field displays the actual key combination that is interpreted.
Modifiers
These options allow you to specify the standard keyboard modifiers: Control, Shift, Alt, or
Extended.
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Think Time
Enable Think Time
Select this option to specify a think time for the current user input action.
Think Time
Specifies the programmatically calculated time delay that is observed for each virtual user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking about an input before performing the
action.

Character edition
Enter a character
This area allows you to enter any key combination to produce Unicode characters that
are not normally available through single keystrokes. Select the input field and enter the
character on your keyboard. The Key Code and Character fields display the corresponding
character.
Note: The workbench uses some key combinations as keyboard shortcuts. Such
combinations can be intercepted and cause undesirable actions instead of displaying a
particular character in the Character field.

Response Time
Start response time for
Select this option to use the current input action to trigger the start of a response time
measurement. When you select this option on an input action that is not already linked to
a response time, a new response time is created with a default name. If there are response
times that do not have a start action, then these are also listed. Select the response time
that you want to link to.
Go to response time definition
Click here to navigate to the session element to view the Response Time Definitions table.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
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Citrix window event details on page191
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix mouse action details
In the test editor, mouse action elements are located in window elements and describe mouse input.
These settings apply to the selected mouse action element.
Type of Event
This is the type of mouse action:
• Mouse Down: The mouse button is pressed.
• Mouse Up: The mouse button is released.
• Mouse Click: The mouse button is pressed and released.
• Mouse Double Click: The mouse button is clicked twice.
• Mouse Move: The mouse is moved to a new location.
X Position and Y Position
These are the coordinates of the mouse action. In the case of a mouse move action, these
are the coordinates at the end of the movement.
Buttons
These are the buttons that are activated, if any.

Think Time
Enable Think Time
Select this option to specify a think time for the current user input action.
Think Time
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Specifies the programmatically calculated time delay that is observed for each virtual user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking about an input before performing the
action.

Response Time
Start response time for
Select this option to use the current input action to trigger the start of a response time
measurement. When you select this option on an input action that is not already linked to
a response time, a new response time is created with a default name. If there are response
times that do not have a start action, then these are also listed. Select the response time
that you want to link to.
Go to response time definition
Click here to navigate to the session element to view the Response Time Definitions table.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix text input details
In the test editor, text input action elements are located under window events and describe a series of key
strokes. These settings apply to the selected text input element.
Value
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Specify a string or portion of text that can be entered during the test. You can use
references or dataset variables.

Think Time
Enable Think Time
Select this option to specify a think time for the current user input action.
Think Time
Specifies the programmatically calculated time delay that is observed for each virtual user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking about an input before performing the
action.

Response Time
Start response time for
Select this option to use the current input action to trigger the start of a response time
measurement. When you select this option on an input action that is not already linked to
a response time, a new response time is created with a default name. If there are response
times that do not have a start action, then these are also listed. Select the response time
that you want to link to.
Go to response time definition
Click here to navigate to the session element to view the Response Time Definitions table.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix mouse sequence details on page198
Citrix screen capture details on page199
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Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix mouse sequence details
In the test editor, Citrix mouse sequence elements are located under window elements and describe a
series of mouse movements. These settings apply to the selected mouse sequence element.
Display mouse sequences for
This option specifies how you want to display previous, current, or all mouse sequences in
the current mouse sequence:
Current® sequence
Only the current mouse sequence is displayed in the test editor. This option is
selected by default.
Previous and current sequences
The current mouse sequence is displayed with any previous mouse
sequences.
All sequences
All mouse sequences are displayed simultaneously.
Fit screen to visible area
Select this option to adjust the display of the mouse sequence to the available area in
the test editor. If disabled, the screen capture will be the actual size, which might require
scrolling. This option is enabled by default.
Screen capture area
This area represents the mouse movements on the screen. If a screen capture was
recorded, it is displayed in the background. Mouse sequences are displayed as specified.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
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Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix screen capture details on page199
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix screen capture details
In the test editor, screen captures display a graphical overview of the state of the application at a given
moment in the test, providing you with a point of reference for navigating through the test.

Session Attributes
Screen captures are obtained by clicking the Capture screen

button in the Citrix Recorder Control

window during recording.
Locations
These are the screen coordinates and the size of the captured screen area.

Screen Capture Preview
This section displays a view of the screen or screen area that was captured during the recording.
Fit screen to visible area
Select this option to resize the screen capture to the available space in the test editor.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
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Citrix mouse sequence details on page198
Citrix image synchronization details on page200
Citrix logoff details on page203

Citrix image synchronization details
In the test editor, the Citrix image synchronization allows Citrix performance tests to keep track of the
contents of a screen area during the replay. These settings apply to the image synchronization element
that is selected.

Image synchronization attributes
Locations
These are the coordinates of the top left corner of the image synchronization area, and the
size of the image synchronization area in pixels. This field is read only.
Synchronization state
This describes the behavior of the test if a synchronization timeout occurs on the image.
The base timeout delay is specified in the Citrix test generation preferences, however the
actual delay varies with the level of synchronization.
Conditional
The conditional timeout delay is the base timeout delay as specified in the
Citrix test generation preferences. If the synchronization fails, the test tries to
resume execution and a timeout is logged in the Citrix performance report and
the test log.
Mandatory
The mandatory timeout delay is three times the base timeout delay. If the
synchronization fails, the test exits with an error status and a timeout is logged
in the test log.
Optional
The optional timeout delay is fixed at 2 seconds. If the synchronization fails,
the test ignores the timeout.
Image synchronization preview
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This is the screen capture of the image synchronization area as it was recorded. Select Fit
screen to visible area to limit the size of the screen capture in the test editor.

Synchronization
Bitmap hash code
This specifies that the synchronization will be evaluated on the bitmap hash code. A hash
code is a unique number that is calculated from the image of the selected area. When an
image synchronization is encountered during test execution, the test calculates the hash
code on the selected area and synchronizes the test if the hash code of the screen area
matches the expected hash code before a timeout occurs.
Optical character recognition
This specifies that the synchronization will be evaluated on a recognized text value. Optical
character recognition extracts a text string from the selected image area. When an image
synchronization is encountered during test execution, the test continually applies text
recognition to the selected area and synchronizes the test as soon as the extracted text
value matches the expected text value before a timeout occurs.
Value
This page specifies the expected value depending on the specified recognition technique.
You can add alternate values by clicking Add so that the image synchronization can succeed
in multiple conditions. Alternate values are evaluated in the same way as the main expected
value.
Bitmap hash code
When Bitmap hash code is selected, this is the hash code that was calculated
on the selected image area during the recording. After executing a test, you
can create alternate hash code values by copying the resulting hash codes
from the Citrix image synchronization view.
Expected text
When Optical character recognition is selected, this is the expected text value
that was extracted by the optical character recognition from the selected
image area. Click Extract text to extract a text string from the selected image
area.
If the text extraction is unsuccessful, try changing the text recognition
settings on the Options page. However, accuracy of the recognized text is not
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essential. It is only important that the recognized text is consistent each time
the test is executed for the test to synchronize.
Use regular expression
Select this option to express the expected text string using standard regular
expression syntax.
Options
This page specifies the settings for text extraction by optical character recognition. You
might need to experiment with various settings to obtain good results. After changing
a setting, click the Value tab and click Extract text to see if the text recognition has
improved. Note that because optical character recognition is used for verification purposes,
consistency of the results in more important than the accuracy of the extracted text.
Zoom factor
This is the enlargement factor that is applied to the image. The default setting
is medium for standard font sizes. Increase the zoom factor to improve
recognition of smaller fonts or decrease for larger fonts.
Language
This is the language of the dictionary used by the text recognition
synchronization. Select the language of the application you are testing. If the
language of your application is not available in the list, change the language
setting in the Default OCR settings of the Citrix Test Generation preferences.
Brightness
This is the brightness level from 0 to 250 that is applied to the image. The
default setting is 70 for normally contrasted text. Increase the brightness
setting to improve recognition of darker images or decrease for lighter images.
Recognition rate
This is the rate of recognition required for the extracted string to match
the expected text. Decrease the recognition rate to tolerate a proportion of
mismatching characters in the recognized text. The default is 100%, which
means that an exact match is required.

Verification Point
Enable verification point on synchronized element
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When selected, the test verifies whether the image synchronization succeeds. If the
synchronization produces a timeout, the verification point returns a fail status in the Citrix
performance test report.

Response Time
Stop response time for
Select this option to use the current image synchronization to stop a response time
measurement. When you select this option on an image synchronization that is not already
linked to a response time, a new response time is created with a default name. If there
are response times that do not have a stop action, then these are also listed. Select the
response time that you want to link to.
Go to response time definition
Click here to navigate to the session element to view the Response Time Definitions table.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix logoff details on page203

Citrix logoff details
In the test editor, the logoff element is located at the end of the Citrix test. The logoff element is created
only when the recording is stopped by clicking
Stop Recording
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in the Recorder Control window. Other methods of ending a recording, such as closing the Citrix XenApp
client or closing the Windows™ session, do not create a session logoff element in the generated test.

Session Logoff Attributes
Session Title
This is the name of the current session. By default, it is the same as the name of the test.
Type of Event
Select whether the logoff element performs a Logoff or a Disconnect event.

Think Time
Enable Think Time
Select this option to specify a think time for the current user input action.
Think Time
Specifies the programmatically calculated time delay that is observed for each virtual user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking about an input before performing the
action.

Related information
Citrix test details on page186
Citrix session details on page187
Citrix window details on page189
Citrix window event details on page191
Citrix key action details on page193
Citrix mouse action details on page195
Citrix text input details on page196
Citrix mouse sequence details on page198
Citrix screen capture details on page199
Citrix image synchronization details on page200
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Service test editor reference
In service testing, the test editor information is divided into eleven categories. This section describes the
fields in each category that can be edited manually.

Service test details
In the test editor, the test element is the first element in the test suite. The settings in the test element
apply to the entire test.

Common options
Datasets
This lists details about each dataset that the test uses: the name of the dataset, the
columns that are used, and the location in the test where the dataset column is referenced.
Click the location to navigate there.
Add dataset
This adds a reference to a dataset that you want a test to use. Clicking this option is the
same as clicking Add > Dataset with the test selected.
Remove
This removes the selected dataset. This option is not available if the dataset is in use.

SSL configuration
Define an SSL configuration for certificate authentication between the client and the server. SSL
configurations can be used by any message request in the test. If you use multiple SSL configurations in
the test, you must specify the configuration in each message request.
The default SSL configuration always trusts servers, which is equivalent to no authentication.
SSL configuration
Select an existing SSL configuration or create one. You can use the toolbar push buttons to
create a New SSL configuration and to Rename or Delete existing SSL configurations. You
can also Copy and Paste SSL configurations to and from the SSL editor and the test editor.
Server Authentication
This section describes how the client trusts the server.
Always trust server
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Select this option if no authentication is required or to ignore server
certificates so that all servers are trusted. If you are using single
authentication and you want to accept trusted servers only, then disable this
option and specify a truststore that contains the trusted server certificates.
Client truststore
When you are using single authentication, the client truststore contains the
certificates of all trusted servers. Click Browse to specify a KS, JKS, or JCEKS
file containing valid certificates of the trusted servers.
Password
If the client truststore file is encrypted, type the password required to access
the file.
Mutual Authentication
This section describes how the server trusts the client in addition to server authentication.
Use client-side certificate
If you are using double authentication, select this option to specify a keystore containing the
client certificate. This certificate allows the server to authenticate the client.
Client certificate keystore
Click Browse to specify a KS, JKS, or JCEKS file containing a valid certificate
that authenticates the client.
Password
If the client truststore file is encrypted, type the password required to access
the file.
Select trust alias for Mutual Authentication
Select an alias to be used for the SSL configuration. There could be multiple aliases in a
keystore for different security certificates. Choose an appropriate alias for a user. You can
also use dataset to store aliases that you can apply to virtual users at run time.

Protocol Configuration (HTTP)
The HTTP configuration page of the test element specifies the information that your server libraries
require to execute the HTTP send and receive functions.
An HTTP configuration can be used by any message call in the test. If you are using multiple protocol
configurations in the test, you must specify the configuration for each message call.
HTTP/2
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Note: Testing HTTP/2 service is in the Beta mode. For more information, see Preparing
to record a HTTP/2 service on page

.

To test a service that uses the HTTP/2 protocol, select the Activate check box. This check
box is automatically selected when you record a service by using a browser. If you use the
Generic Service Client component to create a HTTP/2 test, you have to manually select the
check box.
HTTP/2 client connection timeout
Specifies the time limit for the HTTP/2 client to connect to the HTTP/2 server.
Time out for the HTTP/2 session creations
Specifies the time limit to create the HTTP/2 session. This time starts after the connection
is established.
Enable HTTP/2 Push
The Push functionality of HTTP/2 automatically identifies and passes the related objects or
requests to the client when a request is sent to the server. Clear the check box to not use the
functionality.
Initial session window
Specifies the buffer size on the sessions.
Initial stream window
Specifies the window size for buffer on each stream after the connection is established.
HTTP/2 Client Input Buffer Size
Specifies the buffer size that is used to read the network traffic.
Maximum Quantity of Messages that can be queued
Specifies the maximum number of messages that can be queued for the HTTP/2 client on a
thread.
Maximum Quantity of HTTP/2 thread pool
Specifies the maximum number of thread pools that will be used by the HTTP/2 client to
distribute the workload.
Minimum Quantity of HTTP/2 thread pool
Specifies the minimum number of thread pools that will be used by the HTTP/2 client to
distribute the workload.
HTTP/2 client bytebuffer pool size
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Specifies the buffer size to receive the unciphered values.
Server Name Indication
Note: Not applicable for HTTP/2.
Clear this check box if you do not want to connect to the host computer by using the Server
Name Indication protocol. If the host computer is already configured with Server Name
Indication protocol, you should keep this check box selected.
Use HTTP Keep Alive
Select this option to keep the HTTP connection open after the request. This option is not
available if you are using IBM® Rational® AppScan®.
Use SSL
Select this option to use an SSL configuration. Click Configure SSL to create an SSL
configuration or select an existing configuration.
Platform Authentication
In this section, specify the type of authentication that is required to access the service.
Select None if no authentication is required.
Basic HTTP authentication
Select this option to specify the User Name and Password that are used for
basic authentication.
NTLM authentication
Note: Not applicable for HTTP/2.
Select this option to use the Microsoft™ NT LAN Manager (NTLM)
authentication protocol. NTLM uses challenge-response authentication. This
view lists what is negotiated (supported by the client and requested of the
server) and what is authenticated (the client reply to the challenge from the
server).
Kerberos authentication
Note: Not applicable for HTTP/2.
Select this option to use the Kerberos authentication protocol between the
client and server.
Connect through proxy server
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Note: Not applicable for HTTP/2.
If the HTTP connection needs to go through a proxy server or a corporate firewall, specify
the Address and Port of the proxy server. If the proxy requires authentication, select either
Basic proxy authentication or NTLM proxy authentication.
Proxy authentication
In this section, specify the type of authentication that is required to access the
proxy. Select None if no authentication is required.
Basic proxy authentication
Select this option to specify the User Name and Password that
are used for basic authentication.
NTLM proxy authentication
Select this option to use the Microsoft™ NT LAN Manager
(NTLM) authentication protocol. NTLM uses challenge-response
authentication. This view lists what is negotiated (supported by
the client and requested of the server) and what is authenticated
(the client reply to the challenge from the server).
Custom class
Note: Not applicable for HTTP/2.
Select this option if the communication protocol requires complex, low-level processing with
a custom Java™ code to transform incoming or outgoing messages. Click Browse to select
a Java™ class that uses the corresponding API. This option is not available in IBM® Security
AppScan®.

Protocol Configuration (JMS)
The Java™ Message Service (JMS) configuration page of the test element specifies the information that
your server libraries require to execute the JMS send and reception.
A JMS configuration can be used by any message call in the test. If you are using multiple protocol
configurations within the test, you must specify the configuration in each message call.
Destination style
This is the style of the JMS destination. Select either Topic or Queue.
End-point address
This is the address of the destination.
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Use temporary object
Select this option to send the JMS destination as a temporary object. For a JMS queue, a
temporary JMS queue is sent in the message.
Reception point address
If Use temporary object is disabled, specify the JMS address of the
destination endpoint.
Basic authentication
Select this option to specify the User Name and Password that are used for basic
authentication.
Custom adapter class name
Set up a custom Java™ Naming and Directory Interface (JNDI) vendor adapter for this
configuration. To use a custom adapter, you must write a Java™ class that extends the Axis
class and methods. Specify the name of your custom adapter class in Adapter class name.
Text message
Specify whether the message is a text or a byte message.
Context factory properties
Edit the properties for a context factory. Click Add to add string properties to the context
factory configuration.
Connector properties
Edit the properties for a connector. Click Add to add string properties to the connector
configuration. The product supports the following connectors:
• JMS priority
• JMS delivery mode
• JMS time to live

Protocol Configuration (WebSphere® MQ)
The WebSphere® MQ configuration page of the test element specifies the information that your server
libraries require to execute the WebSphere® MQ transport send and receive functions.
An MQ configuration can be used by any message call in the test. If you are using multiple protocol
configurations in the test, you must specify the configuration for each message call.
Queue Manager
Use this area to specify queue manager options for the service.
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Queue manager name
Specify the name of the queue manager to which to send the request.
Authentication
If a queue manager require authentication, select the check box and provide
login credentials of the queue manager. If authentication is not required for a
queue manager, you can ignore this check box.
Use local queue manager
Select this option to use a local queue manager. If you disable this option,
specify the following information:
Queue manager address
Specify the IP address or host name of the remote WebSphere®
MQ server.
Queue manager port
Specify the listener port of the remote WebSphere® MQ server.
Client channel
Specify the server-connection mode channel of the remote
queue manager.
Queues
Use this area to specify the send queue options for the service.
Send queue name
Specify the name of the queue that the queue manager manages.
Use temporary queue for response
Specifies whether the WebSphere® MQ server creates a temporary queue.
If selected, the temporary queue is created for the sole purpose of receiving
specific messages, and then deleted.
Receive queue name
If Use temporary queue is cleared, this option specifies the
queue manager that is specified on the Queue manager name
line. The specified queue manager must manage this queue. You
can specify multiple queue names by using a semicolon (;) as a
separator.
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Text message
Change the message format by selecting the Text Message check box in the Message
Structure.
Use RFH2 header
Select whether to use the transport for SOAP over MQ feature that is provided by
WebSphere® MQ. This feature uses a predetermined MQ message format (RFH2); therefore,
when selected, other Message Descriptor options are disabled.
SSL connection
Select this option to use an SSL configuration if a Client Channel setting refers to a secure
channel. Click Open SSL Editor to create an SSL configuration or Change to change the SSL
configuration that is associated with the current test.
If the WSDL that you use to create the message request uses a supported JMS URI to
point to the WebSphere® MQ server, then the SSL configuration is created automatically.
If the test generator is unable to create the SSL configuration, you must create a new one
manually.
If the WSDL is generated with the WebSphere® MQ service (amqwdeployWMService), you
must edit the WSDL to change the transport binding from HTTP to JMS to prevent the test
generator from producing an HTTP configuration.
Cipher suite
Specify the cipher suite that is used in the channel configuration.
Message Descriptor
Configure the fields of the request. You can replace a subset of an MQ message descriptor
with a custom format for use with other server types, specifically when using an XML
message request. Refer to WebSphere® MQ documentation for details about message
descriptors.
Use the Message Properties table to specify the following MQ message properties:
• JMSXDeliveryCount
• JMSXGroupSeq
• JMS_IBM_Report_Exception
• JMS_IBM_Report_Expiration
• JMS_IBM_Report_COA
• JMS_IBM_Report_COD
• JMS_IBM_Report_PAN
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• JMS_IBM_Report_NAN
• JMS_IBM_Report_Pass_Msg_ID
• JMS_IBM_Report_Pass_Correl_ID
• JMS_IBM_Report_Discard_Msg
• JMS_IBM_MsgType
• JMS_IBM_Feedback
• JMS_IBM_PutApplType
• JMS_IBM_Encoding
• JMS_IBM_Last_Msg_In_Group
For more information about these properties, refer to the IBM WebSphere® MQ
documentation.
Target service
When using Microsoft™ .NET framework with the SOAP over MQ feature of WebSphere®
MQ, specify the name of the target service for the WSDL.

Related information
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Service call details
Service call elements contain the contents of the call and the transport information for this call. The
contents are made of the SOAP envelope. The transport information refers to the information that is
required to send and receive and answer depending on the selected protocol.
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Call Settings
Update node name automatically
Select this option to automatically rename the request in the Test Contents view.
Name
Name of the request. You can use custom code or dataset to change name.
Do not wait for response
Select this option to skip directly to the next request in the test after the current request is
sent.
Operation and WSDL Name
These identify the WSDL name and operation to which the service request is binded.
WSDL Resource
This is the name of the WSDL resource in the workbench. Click the link to edit the WSDL file.
If the WSDL file is missing, click the link to bind the request to a WSDL in the workspace or
to import a WSDL. You can click the Edit WSDL Security button to edit the security policy
for the WSDL or click the WSDL Synchronization button to update an imported WSDL with a
remote WSDL.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
Update Response
Click this button to invoke the request with the current settings and to use the response to
create a service response element or to update the existing response element.

Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form

214

Chapter 1. Reference Guide

This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.
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Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
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URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
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SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Related information
Service test details on page205
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
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Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

XML call details
XML call elements contain the contents of the call and the transport information for this call. The
contents consist of plain XML that is transmitted over an HTTP or JMS transport. The transport
information refers to the information that is required to send and receive and answer depending on the
selected protocol.
Update node name automatically
When enabled, this option updates the name of the XML call element in the test contents.
One way
This option specifies that no response from the server is expected after the call. This
disables the Update Return button.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically-calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
Update Return
This opens the Return Preview window. From this window, you can invoke the call from the
workbench to create or update the message return that is associated with the call.

Message
These pages present the XML contents of the call and provide access to data correlation in three different
forms
Form
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This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.
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Attachments
This page lists the MIME attachments that are attached to the call. The contents of this view correspond
to the specification of Multipurpose Internet Mail Extensions (MIME). You can use this page to add
workbench resources as MIME attachments and change properties.
The Content ID is the identifier that the call uses to refer to the attachments. The method for using this
identifier depends on your server requirements.

Protocol
This page covers the protocol that is used to send the call. The protocol can be either HTTP or Java™
Message Service (JMS) on a message-by-message basis.
HTTP
This page enables you to override the HTTP settings that are attached to the call for a local
HTTP configuration.
Method
This option enables you to specify the HTTP method of the XML call, among
the following list of methods:
• POST
• GET
• PUT
• DELETE
Version
This option enables you to specify either HTTP 1.0 or HTTP 1.1.
URL
This field enables you to specify the URL of the XML call.
Headers
This section enables you to add headers to your call. Headers must be
compatible with the specified HTTP method.
The application manages the following headers and they cannot be added:
• User Agent
• Host Connection
• Cache-Control
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• Pragma
• Content-Type
• Content-Length
Cookies
This section enables you to manage cookies. You can add, edit and remove
cookies, and create references.
JMS
This page enables you to add string properties that are attached to the call for a local JMS
configuration. These will be sent as message properties through JMS.
MQ
This page enables you to override settings that are attached to the call for a local
WebSphere® MQ configuration.
Name
This is the name that is displayed in the message call as a link to this protocol
configuration.
Queue manager name
Specifies the name of the queue manager to which you want to send the call.
Queue name
Specifies the name of the queue that the queue manager manages.
Use local queue manager
Specifies whether the WebSphere® MQ server is running on the local
computer. If the server is located on a remote computer, clear this option to
specify the remote MQ server details.
Queue manager address
Specifies the IP address or hostname of the remote MQ server.
Queue manager port
Specifies the listener port of the remote MQ server.
Client channel
Specifies the server-connection mode channel of the remote queue manager.
Use temporary queue
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Specifies whether the MQ server creates a temporary queue. If selected,
the temporary queue is created for the sole purpose of receiving specific
messages, and then deleted.
Queue name
If Use temporary queue is cleared, this option specifies the name of the queue
where message returns from the MQ server are received. The queue manager
that is specified in Queue manager name must manage this queue.
The calls and message returns are associated by the correlation ID in the
MQ message, which means that the report setting of the message is set
to MQC.MQRO_COPY_MSG_ID_TO_CORREL_ID. The server must follow
this constraint. This supports the transport for SOAP feature provided by
WebSphere® MQ.
Target service
This option is for using Microsoft™ .NET with the IBM® WebSphere® MQ
transport for SOAP feature. This specifies the name of the ASPX file within
the .NET listener directory.
Use RFH2 Header
Specifies whether the SOAP messages uses an RFH2 header, which uses
a predetermined MQ message format. When selected, other Message
Descriptor options are disabled. Use this option for the WebSphere®
MQ transport for SOAP feature. If you are using WebSphere® Integration
Developer (WID) MQ binding, the binding understands messages with or
without the RFH2 header.
Message Descriptor
This section enables you to configure the fields of the message call. You can
replace a subset of an MQ message descriptor with a custom format for use
with other server types, specifically when using an XML message call. See
WebSphere® MQ documentation for details about message descriptors.
Use temporary queue
This section enables you to specify a user name and password for basic
authentication on the application server.
SSL connection
Select this option to use an SSL configuration if a Client Channel setting refers
to a secure channel. Click Open SSL Editor to create a new SSL configuration,
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or Change to change the SSL configuration that is associated with the current
test.
If the Web Services Description Language (WSDL) that is used to create
the message call uses a supported JMS URI to point to the WebSphere®
MQ server, then the SSL configuration is created automatically. If the test
generator was unable to create the SSL configuration, you must create a new
one manually.
If the WSDL was generated with the WebSphere® MQ service
(amqwdeployWMService), edit the WSDL to change the transport binding
from HTTP to JMS in order to prevent the test generator to produce an HTTP
configuration.
Cipher suite
Specify the cipher suite that is used in the channel configuration.

Local XML Security
This page allows you to add a custom security algorithm that is implemented in a Java™ class. Custom
algorithms can be applied to the XML contents that are sent to and received from the server.
Add, Insert, Remove, Up, and Down
These buttons allow you to create a stack of security algorithms. Each algorithm is applied
to the stack sequentially. Click Add to add a custom security algorithm.
Tools
This button allows you to change the way the algorithm stack is displayed.
Custom Security Algorithm
After adding a custom security algorithm to the stack. With this window, you can specify the
Java™ class that implements the algorithm. The Java™ class uses the following interface:
/**
* ***************************************************************
* IBM Confidential
*
* (c) Copyright IBM Corporation. 2008. All Rights Reserved.
*
* The source code for this program is not published or otherwise
* divested of its trade secrets, irrespective of what has been
* deposited with the U.S. Copyright Office.
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* ***************************************************************
*
*/

package com.ibm.rational.test.lt.models.wscore.datamodel.security.xmlsec;

import java.util.Properties;
import org.w3c.dom.Document;

public interface ICustomSecurityAlgorithm {

/**
* The following methods can be used in both case:
* Execution in the workbench and execution of the test.
*/

/**
* Called to process de Document that is sent over a transport.
* @param subject
*/
void process(Document subject);
/**
* Called to un process a document that is received from a server.
* @param subject
*/
void unProcess(Document subject);

/**
* Properties defined in the UI of the CustomSecurityAlgorithm.
* @param map
*/
void setProperties(Properties map);

/**
* The following methods can only be used in terms of cast to test service interface,
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* or in terms of access to the previous XML

information, when the jar containing

* the custom security algorithm is deployed in the performance test project. In
* this case you cannot use the algorimth directly from the workbench.
*/

/**
* This object corresponds to the ITestExecutionService object.
* This applies only to an algorithm that must link to the execution of the test.
* If you plan to use this object you will need to deploy the jar containing the
* implementation into your performance test project and not directly into the JRE.
*
* In case of a need of the previous xml document received from the execution you can
* obtain the value using:
* IDataArea area = ((ITestExecutionService)executionObject).findDataArea(IDataArea.VIRTUALUSER);
*String previousXML = (String) area.get("PREVIOUS_XML"); //$NON-NLS-1$
*
*/
void setExecutionContext(Object executionObject);

• The process method modifies the XML before it is sent to the server.
• The unprocess method modifies the XML after it is received from the server.
• ThesetProperties method retrieves any properties that are defined in the security
editor for this custom security interface.
• The setExecutionContext method is called during test with the object
ITestExecutionServices

that corresponds to the message using this custom security

interface.
Custom Security Algorithm Class Name
This specifies the class that implements the security algorithm. Click Browse
Class to select a class from the workspace.
Algorithm Name
This specifies a name for the current algorithm.
Properties
This list specifies properties that the setProperties method uses in the
algorithm. Use Add, Remove, or Edit to create the properties list.
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Related information
Service test details on page205
Service call details on page213
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Binary call details
Binary calls are specialized service calls that can be used to send binary messages. The transport
information refers to the information that is required to send and receive and answer depending on the
selected protocol.

Message
Update node name automatically
Select this option to automatically rename the request in the Test Contents view.
Do not wait for response
Select this option to skip directly to the next request in the test after the current request is
sent.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
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Update Response
Click this button to invoke the request with the current settings and to use the response to
create a binary response element or to update the existing response element.
Source
This page presents the binary contents of the request and provides access to data
correlation. The same contents are presented in Binary and Raw ASCII views.
Attachments
This page lists the MIME or DIME attachments that are attached to the request. The
contents of this view conform to the Multipurpose Internet Mail Extensions (MIME) or
Direct Internet Message Encapsulation (DIME) specification. You can use this page to add
workbench resources as MIME or DIME attachments and change properties.
Transport
This page covers the transport protocol used to send the request. The transport protocol
can be either HTTP, Java™ Message Service (JMS), or WebSphere® MQ. You can create
several configurations for each protocol so that you can easily switch protocols or variants
of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is
available.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).
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Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
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Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
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These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Related information
Service test details on page205
Service call details on page213
XML call details on page219
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Text call details
Text calls are specialized calls for sending plain text messages. The transport information refers to the
information that is required to send and receive and answer depending on the selected protocol.

Message
Update node name automatically
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Select this option to automatically rename the request in the Test Contents view.
Do not wait for response
Select this option to skip directly to the next request in the test after the current request is
sent.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
Update Response
Click this button to invoke the request with the current settings and to use the response to
create a service response element or to update the existing response element.
Source
This page presents the plain text contents of the request and provides access to data
correlation.
Attachments
This page lists the MIME or DIME attachments that are attached to the request. The
contents of this view conform to the Multipurpose Internet Mail Extensions (MIME) or
Direct Internet Message Encapsulation (DIME) specification. You can use this page to add
workbench resources as MIME or DIME attachments and change properties.
Transport
This page covers the transport protocol used to send the request. The transport protocol
can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ, or Microsoft .NET. You
can create several configurations for each protocol so that you can easily switch protocols
or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is
available.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
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(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
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Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
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Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
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Service parallel details on page243
Service receive details on page244

Service message return details
In the test editor, message return elements are located after every service call. Message returns describe
the expected content returned by the service. You can use the information in the message return element
for data correlation.
You can automatically generate or update the contents of a message return by clicking Update Return in
the call element.

Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form
This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
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Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Response Properties
This page lists the names and values of properties of the response.
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Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Service verification point details
Verification points enable you to test the behavior of a service by checking the message return of a call
against criteria. You can perform checks on the contents of the XML document of the message return, the
number of nodes returned by an XPath query, or the existence of a specific attachment.

Contain and equal verification points
Contain verification points return a Pass status when the message return object contains the specified
XML message. Equal verification points return a Pass status when the message return object matches
the specified XML message.
The verification occurs if the message return object is a valid XML message. The verification is performed
on both the name of the XML element and final return value of the element. Attributes are not checked.
Use the Form, Tree and Source views to edit the message content.
Test using XML namespace
Select this option to perform the verification on a qualified structure, including the XML
namespace, instead of the simple name. For example, if the expected XML data is:
<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

When Namespace aware is enabled, the verification is made on the full name of the return
value:
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<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

When Namespace aware is disabled, the verification ignores the namespace tagging and
checks only the simple name of the element and the final return value:
<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

In this case, you can simplify the value of the expected XML data to:
<responseElement><responseElement>

Test XML text nodes
Select this option to include XML text values in the verification.
Test XML attributes
Select this option to include XML attributes in the verification.
Form
This view provides an simple view of the elements of the call with their values. Use this view
to quickly edit values in the form.
Tree
This view provides a hierarchical view of the elements of the call with their values, attributes,
and the associated namespaces. You can use Add, Insert, Remove, Up, and Down to edit
this list.
Click the namespace, attribute, or text filter buttons, depending on your requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable smart
editing if you do not have an XSD or if you want to bypass the schema.
You can specify standard Java™ regular expressions. In the Regexp column, select the
line of an attribute or text value and type the regular expression in the Value column. For
example, the following regular expression checks for a correctly formatted email address: /
^([a-zA-Z0-9_\.\-])+\@(([a-zA-Z0-9\-])+\.)+([a-zA-Z0-9]{2,4})+$/

Source
This view displays the source XML document of the call.
Important: The ID tags that are shown in the Source page refer to an internal
representation for the test. If you remove these tags, you will remove any existing references
and substitutions. You cannot re-create these tags after you delete them.
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Query verification points
Query verification points return a Pass status when the number of nodes returned by an XML Path
language query matches the expected number of nodes specified in the verification point.
The verification occurs if the message return object is a valid XML document.
XPath expression
Specify a query using the XML path language. Refer to the XPath specification for details on
expressing an XPath query: http://www.w3.org/TR/xpath. Click Build Expression to open the
XPath Expression Builder window.
Note: Because XPath expressions require that the qualified name has a prefix, XPath
expressions will return null for the default namespace declared with xmlns.
Operator and Expected Count
These specify the expected number of nodes returned by the query.
Evaluate
Click this button to calculate the number of nodes based on the current input. This value
automatically replaces the current Expected count.

Attachment verification points
Attachment verification points return a Pass status when the message return attachment matches all of
the criteria specified in the verification point.
The verification occurs only if the message return object is a valid XML document.
Index of the attachment to be verified
In the case of multiple attachments, this number specifies which attachment to check.
Attachment size
This specifies the expected size of the attachment.
MIME type
This specifies the expected MIME type of the attachment.
Encoding
This specifies the expected encoding of the attachment.
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XSD verification points
XSD verification points check that the content returned by the service is validated by the specified XML
Schema Definition (XSD) files or Web Service Definition Language (WSDL) files that contain XSDs.
The verification occurs only if the message return object is a valid XML document.
Add XSD
Add an XSD to the list of validation checks.
Add WSDL
Add a WSDL that contains an XSD to the list of validation checks.
Open
Open a selected XSD or WSDL file.

Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service callback details on page241
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Service callback details
Callback elements define the web service or XML call that contains the element as an asynchronous
call. The behavior of the test after invoking the asynchronous call is specified by the parallel, receive, and
timeout elements that are contained in the callback element.
Callback endpoint location
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This element specifies the XML element in the asynchronous call that defines the endpoint
URL of the callback receiver. During a test, this endpoint is used to redirect the callback to
the tester instead of the real receiver.
Display full path
Select this option to display the extended path of the endpoint XML element.

Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service timeout details on page242
Service parallel details on page243
Service receive details on page244

Service timeout details
Timeout elements describe the behavior of an asynchronous service test when the callback is not
received after a specified timeout period. Timeout elements are created inside callback elements.
Timeout
This value specifies the timeout delay after which the test runs the elements that the
timeout element contains.
Enable verification point for timeout
With this option, you can enable a verification point on the timeout. If the timeout delay is
reached, the verification point reports a fail status in the test log.
The list displays the test elements that the timeout element contains. These are the same contents as
displayed in the Test Contents of the test editor.
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Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service parallel details on page243
Service receive details on page244

Service parallel details
Parallel elements describe the behavior of an asynchronous web service test after the asynchronous
call has been made and while the tester is waiting for a callback message return. Parallel elements are
created inside callback elements.
The list displays the test elements that the parallel element contains. These are the same contents as
displayed in the Test Contents area of the test editor.

Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
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Service timeout details on page242
Service receive details on page244

Service receive details
Service receive elements specify the callback message return from an asynchronous web service. A
receive element can contain elements that describe the behavior of the test when the callback message
return is received. Receive elements are created inside callback elements.
The contents of a receive element are the same as a typical message return element.

Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form
This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
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Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Response Properties
This page lists the names and values of properties of the response.
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Related information
Service test details on page205
Service call details on page213
XML call details on page219
Binary call details on page227
Text call details on page231
Service message return details on page236
Service verification point details on page238
Service callback details on page241
Service timeout details on page242
Service parallel details on page243

Service stub editor reference
Service stub elements are part of the service stub and can be edited in the stub editor.

Stub operation details
Stub operation elements describe the format of the call that the service stub expects to receive. There is
one stub operation for each operation that was detected in the WSDL specification. Each stub operation
contains at least one default case element, or several case elements describing the response of the
service stub depending on the incoming calls. The information from the stub operation element can be
used for data correlation.
This page presents the XML or text contents of the call and provides access to data correlation. The
same contents are presented in Form, Tree or Source view.
Form
This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
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WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.

Related information
Stub case details on page248
Stub response details on page250
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Stub case details
Stub case elements enable you to specify the response of a service stub according to the content of an
incoming call. You can perform checks on the contents of the XML document of the message return,
the number of nodes returned by an XPath query, or the existence of a specific attachment. Each case
element has an associated response element. There can be multiple case elements in a stub operation,
but the Case : Default element is mandatory.

Default case
The default case contains the default response when no other criteria has been met. When multiple cases
are defined, the default case is always the last one to be evaluated.

Contain and equal cases
Contain cases send their response when the incoming call contains the specified XML message. Equal
cases send their response when the incoming call matched the specified XML message.
The verification occurs if the message return object is a valid XML message. The verification is performed
on both the name of the XML element and final return value of the element. Attributes are not checked.
Use the Form, Tree and Source views to edit the message content.
Test using XML namespace
Select this option to perform the verification on a qualified structure, including the XML
namespace, instead of the simple name. For example, if the expected XML data is:
<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

When Namespace aware is enabled, the verification is made on the full name of the return
value:
<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

When Namespace aware is disabled, the verification ignores the namespace tagging and
checks only the simple name of the element and the final return value:
<ns1:responseElement xmlns:ns1="http://www.ibm.com/wbse"></ns1:responseElement>

In this case, you can simplify the value of the expected XML data to:
<responseElement><responseElement>

Test XML text nodes
Select this option to include XML text values in the verification.
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Test XML attributes
Select this option to include XML attributes in the verification.
Form
This view provides an simple view of the elements of the call with their values. Use this view
to quickly edit values in the form.
Tree
This view provides a hierarchical view of the elements of the call with their values, attributes,
and the associated namespaces. You can use Add, Insert, Remove, Up, and Down to edit
this list.
Click the namespace, attribute, or text filter buttons, depending on your requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable smart
editing if you do not have an XSD or if you want to bypass the schema.
You can specify standard Java™ regular expressions. In the Regexp column, select the
line of an attribute or text value and type the regular expression in the Value column. For
example, the following regular expression checks for a correctly formatted email address: /
^([a-zA-Z0-9_\.\-])+\@(([a-zA-Z0-9\-])+\.)+([a-zA-Z0-9]{2,4})+$/

Source
This view displays the source XML document of the call.
Important: The ID tags that are shown in the Source page refer to an internal
representation for the test. If you remove these tags, you will remove any existing references
and substitutions. You cannot re-create these tags after you delete them.

Query case
Query cases send their response when the number of nodes returned by an XML Path language query
matches the expected number of nodes specified in the case element.
The verification occurs if the message return object is a valid XML document.
XPath expression
Specify a query using the XML path language. Refer to the XPath specification for details on
expressing an XPath query: http://www.w3.org/TR/xpath. Click Build Expression to open the
XPath Expression Builder window.
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Note: Because XPath expressions require that the qualified name has a prefix, XPath
expressions will return null for the default namespace declared with xmlns.
Operator and Expected Count
These specify the expected number of nodes returned by the query.
Evaluate
Click this button to calculate the number of nodes based on the current input. This value
automatically replaces the current Expected count.

Default case
Attachment verification points return a Pass status when the message return attachment matches all of
the criteria specified in the verification point.
The verification occurs only if the message return object is a valid XML document.
Enable verification point
When selected, the test verifies whether the web service message return objects match the
expected criteria of the verification point. An error is reported in the test log if the message
return does not match the expected criteria.
Index of the attachment to be verified
In the case of multiple attachments, this number specifies which attachment to check.
Attachment size
This specifies the expected size of the attachment.
MIME type
This specifies the expected MIME type of the attachment.
Encoding
This specifies the expected encoding of the attachment.

Related information
Stub operation details on page246
Stub response details on page250
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Stub response details
In the stub editor, there is one response elements associated with each case element. Stub responses
describe the content that is returned by the stub service, simulating the response of the original service.

Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form
This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
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You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Related information
Stub operation details on page246
Stub case details on page248

Service test editor reference
In service testing, the test editor information is divided into eleven categories. This section describes the
fields in each category that can be edited manually.
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Socket test details
In the test editor, the socket test is the highest level element of a socket test.
Common options
Lists details about each dataset that is used by the test: the name of the dataset, the
columns that are used, and the location in the test where the dataset column is referenced.
Click the location to navigate there.
Datasets
Lists details about each dataset that is used by the test: the name of the
dataset, the columns that are used, and the location in the test where the
dataset column is referenced. Click the location to navigate there.
Add dataset
Adds a reference to a dataset that you want a test to use. Clicking this option
is the same as selecting a test, and then clicking Add > Dataset .
Delete
Removes the selected dataset reference from the test. This option is not
available if the dataset is in use.
Enable response time breakdown
This is not supported for socket performance tests
Client program
Lists details about each client program that was used to record the test.

Related information
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
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Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket connection details
In the test editor, socket connection elements describe the connection to a server. A connection must
exist before you can send or receive data. These settings apply to all send, receive, and close elements
that use the selected connection.
Establish a new connection to the host
Specify whether to create a new connection to the host or to reuse a connection from a
different test. Select Reuse an existing connection if you are using multiple split tests
in a schedule. A schedule, in this context, is used to refer to both VU Schedule and Rate
Schedule. For example, one test can open a connection, another test can reuse the
connection, and a final test can close the connection. Specific name is a label that must
match the name specified in the test that opens the connection.
Host and Port
Specify the computer name or IP address, and the port, to which the connection is made.
Timeout
Specify the timeout delay (in seconds) after which the test returns an error if no connection
is established.
Symbolic name
Type the name of the connection as it will appear in the test results.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Connection time
This is the reference time that was measured when the test was recorded.
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Client program
This is the name of the recorded client application

Related information
Socket test details on page253
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket close details
In the test editor, socket close elements are located inside a socket test and represent the closing of a
socket connect. These settings apply to the selected socket close element.
Connection
Specifies the socket connection that is closed. Click the link to navigate to the socket
connection test element.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.

Related information
Socket test details on page253
Socket connection details on page254
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Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket-secure upgrade details
In the test editor, the socket-secure upgrade represents the SSL or TLS negotiation that upgrades an
existing connection to a secure connection.
Connection
Specify the socket connection that is used to send the data. Click the link to navigate to the
socket connection test element.
Recorded negotiation time
Displays the delay that was required to negotiate the secure connection when recording the
test. This value is read-only.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Encryption protocol
Select whether the connection uses the SSL v3 or the TLS v1 protocol.
Recorded negotiation time
Displays the delay that was required to negotiate the secure connection when recording the
test. This value is read-only.
Recorded cipher suite
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Displays the encryption algorithm that was detected when the test recorded. This value is
read-only.
Cipher suite
In most cases, select Auto to have the protocol negotiation to occur automatically. If
necessary, select a specific encryption algorithm.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket send details
In the test editor, socket send elements represent the reception of data from the server.
Connection
Specifies the socket connection that is used to send the data. Click the link to navigate to
the socket connection test element.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Manipulate data from custom code
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Select this option to process the receive data with a custom Java™ class. Type the name of
a custom Java™ class that is located in your workspace or click Generate Code to create a
new Java™ class template. Click View Code to open the class in the Java™ editor.
Data
Specify the data that is sent through the connection. Bytes are expressed as 7-bit
alphanumeric characters or hexadecimal bytes preceded with "\x". Bytes displays the
number of bytes sent as data through the connection.
Connection
Specifies the socket connection that is used to send the data. Click the link to navigate to
the socket connection test element.
Think Time (ms)
Specify the programmatically-calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Manipulate data from custom code
Select this option to process the receive data with a custom Java™ class. Type the name of
a custom Java™ class that is located in your workspace or click Generate Code to create a
new Java™ class template. Click View Code to open the class in the Java™ editor.
Data
Specify the data that is sent through the connection. Bytes are expressed as 7-bit
alphanumeric characters or hexadecimal bytes preceded with "\x". Bytes displays the
number of bytes sent as data through the connection.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
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Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket receive details
In the test editor, socket receive elements represent the reception of data from the server.
Connection
Specifies the socket connection that is used to receive the data. Click the link to navigate to
the socket connection test element.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Response Timeout
The maximum delay to receive the first byte of the response. If no data is received before
the end of the response timeout delay, the receive action produces an error in the test log.
The response timeout counter starts when the receive action starts after the think time; the
counter is interrupted when the first byte is received.
End Policy
This specifies when to stop receiving data and to move on to the next test element.
Data
Specify the data that is received through the connection. Bytes are expressed as 7-bit
alphanumeric characters or two-digit hexadecimal bytes preceded with \x. Additionally, \r
and \n respectively stand for carriage-return and line-feed, while \\ represents the backslash
character.
End Policy
This specifies when to stop receiving data and to move on to the next test element.
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• Detects inactivity: The receive action stops when no bytes are received from the
connection after a delay specified in Inactivity threshold (in milliseconds). After this
delay, the remote computer has finished sending the response and is considered
inactive. This is the default setting.
• Receives exact number of bytes: The receive action stops when the recorded number
of bytes is received. Specify a Timeout (in seconds) after which the receive action
produces an error in the test log, if the correct number of bytes is not received. If
Link data size is enabled, the receive action expects the number of bytes displayed in
the Data area. If Link data size is disabled, the receive action expects the number of
bytes displayed in Bytes.
• Receives until end of stream: The receive action stops when the connection is closed
by the remote computer. If Accepts empty response is selected, then the reception of
a single byte is not required and the Response Timeout is ignored. Specify a Timeout
(in seconds) after which the receive action produces an error in the test log, if the
correct number of bytes is not received.
• Matches a string: The receive action stops when a specified sequence of bytes is
received. Specify a Timeout (in seconds) after which the receive action produces an
error in the test log, if the correct number of bytes is not received.
• Recognizes a regular expression: The receive action stops when a sequence of bytes
that matches a regular expression is received. Specify a Timeout (in seconds) after
which the receive action produces an error in the test log, if the correct number of
bytes is not received.
For end policies that have a Timeout setting, this setting specifies a delay (in seconds) after
which the receive action produces an error in the test log if the end policy criteria is not met.
The timeout counter starts when the first byte is received.
Except when the Receives until end of stream policy is in force, receive actions produce an
error in the test log when the connection is closed by the remote computer.
Data
Specify the data that is received through the connection. Bytes are expressed as 7-bit
alphanumeric characters or two-digit hexadecimal bytes preceded with \x. Additionally, \r
and \n respectively stand for carriage-return and line-feed, while \\ represents the backslash
character.
Link data size
When Receives exact number of bytes is selected as the End Policy, if Link
data size is enabled, the receive action expects the number of bytes displayed
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in the Data area. If the option is disabled, the receive action expects the
number of bytes displayed in Bytes.
Bytes
When Link data size is disabled, this specifies the number of bytes expected
as data through the connection.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Terminal screen details
In the test editor, terminal screen elements are located inside a TN3270 test and represent the display of
the terminal screen.
Connection
Specifies the socket connection that is used to receive the data. Click the link to navigate to
the socket connection test element.
Response Timeout
The maximum delay to receive the first byte of the response. If no data is received before
the end of the response timeout delay, the receive action produces an error in the test log.
The response timeout counter starts when the receive action starts after the think time; the
counter is interrupted when the first byte is received.
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Terminal Screen
This area displays the TN3270 terminal screen as it was received. To create a verification
point on an portion of text from the display, select the text, right-click the selection, and click
Add Verification Point. Click the Add Verification Point to automatically create a verification
from a significant portion of text.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Terminal input details
In the test editor, terminal input elements are located inside a TN3270 test and represent the user input
that is sent to the server.
Connection
Specifies the socket connection that is used to send the data. Click the link to navigate to
the socket connection test element.
Think Time (ms)
Specify the programmatically calculated time delay that is observed before executing the
current test element. Think time is a statistical emulation of the amount of time actual users
spend reading or thinking before performing an action.
Terminal Screen
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Use this area to edit user input on the TN3270 screen as you would on the actual terminal
screen. You can use data correlation on fields that are displayed on the terminal screen.
Input Key
Specifies the key that is pressed to send the current input.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket content verification point details
Content verification points enable you to test that the data received from a connection matches the
expected data.
Content verification points return a Pass status when the received data matches the criteria specified in
the verification point.
Comparison operator
Specify the criteria to use to perform the verification, among the following operators:
Equals
The verification point returns a Pass status if the received data exactly
matches the text or binary content that is specified in the Data area.
Contains
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The verification point returns a Pass status if the text or binary content that is
specified in the Data area occurs at least once in the received data.
Starts with
The verification point returns a Pass status if the text or binary content that is
specified in the Data area occurs at the beginning of the received data.
Ends with
The verification point returns a Pass status if the text or binary content that is
specified in the Data area occurs at the end of the received data.
Differs from
The verification point returns a Pass status if the received data does not
exactly match the text or binary content that is specified in the Data area.
Does not contain
The verification point returns a Pass status if the text or binary content that is
specified in the Data area does not occur at least once in the received data.
Does not start with
The verification point returns a Pass status if the text or binary content that is
specified in the Data area does not occur at the beginning of the received data.
Data
Specify the data that is expected to be received through the connection.
Binary
In this view, edit the expected content as binary data.
Raw ASCII
In this view, edit the expected content as raw ASCII data. Bytes are expressed
as 7-bit alphanumeric characters or two-digit hexadecimal bytes preceded
with \x. Additionally, \r and \n stand for carriage-return and line-feed, while \\
represents the backslash character.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
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Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket size verification point details on page265
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket size verification point details
Size verification points enable you to test that the size of the data received from a connection matches an
expected number of bytes.
Size verification points return a Pass status when the received data matches the criteria specified in the
verification point.
Comparison operator
Specify the criteria that is used to perform the verification with these operators:
• Is
• Is less than
• Is less or equals
• Is more than
• Is more than or equal to
• Is not
Value (bytes)
Specify the size criteria for the verification point.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
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Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket custom verification point details on page266
Terminal content verification point details on page267

Socket custom verification point details
Custom verification points enable you to perform advanced checks through a user-defined custom Java™
class.
Custom verification points return a Pass status when the custom class returns a Pass status after
performing a verification written in Java™ code.
Class name
Specify the name of a Java™ class located in your workspace. The class must use the
Rational® Performance Tester API. See Executing test execution with custom code on page
for more information.
Generate Code
Click this button to automatically create a Java™ class using the API template. You can
extend this Java™ class to perform any advanced verification on the received data.
View Code
Click this button to open the class in the Java™ editor.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256

266

Chapter 1. Reference Guide

Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Terminal content verification point details on page267

Terminal content verification point details
With terminal content verification points, you can test whether the text that is displayed on the terminal
screen matches the expected text during a TN3270 test.
Comparison operator
Specify the criteria to use to perform the verification, among the following operators:
Equals at location
The verification point returns a Pass status if the terminal screen displays the
expected text string starting at the point that isspecified byLine and Column.
Differs at location
The verification point returns a Pass status if the terminal screen does not
display the expected text string at the point that isspecified byLine and
Column.
Contains on line
The verification point returns a Pass status if the terminal screen displays the
expected text string anywhere on the area that isspecified inLine.
Contains in line range
The verification point returns a Pass status if the terminal screen displays the
expected text string anywhere inbetween the area that isspecified byFirst line
and Last line.
Does not contain in line range
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The verification point returns a Pass status if the terminal screen does not
display the expected text string anywhere inbetween the area that isspecified
byFirst line and Last line.
Matches regular expression at location
The verification point returns a Pass status if the terminal screen displays a
text string that matches the specified Java regular expression starting at the
point that isspecified byLine and Column.
Does not match regular expression at location
The verification point returns a Pass status if the terminal screen displays a
text string that does not match the specified Java regular expression starting
at the pointspecified byLine and Column.
Text
Specifies the expected text string or regular expression.

Related information
Socket test details on page253
Socket connection details on page254
Socket close details on page255
Socket-secure upgrade details on page256
Socket send details on page257
Socket receive details on page259
Terminal screen details on page261
Terminal input details on page262
Socket content verification point details on page263
Socket size verification point details on page265
Socket custom verification point details on page266

VU Schedule editor reference
Most VU Schedule editor settings apply either to the entire schedule or to individual user groups.
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Schedule properties
When you open a schedule, you can set its properties.

User Load page
Right-click in the table, and select Add to add a stage. To modify a stage, select the row, and then clickEdit
or click the user icon in the first column.
Users
Enter the total number of users to be active in the stage (not the number of users to add or
subtract to those currently running).
Run for specified period of time
Enter the length of time (and the time units) for the stage to run. When the specified number
of users is achieved, the users will run for up to this time. When the time expires, the users
continue to run if they are required for the next stage; otherwise, they are stopped gracefully.
Click Show Advanced to set further options to prepare the system under test before the users actually
enter the stage:
Change Rate
Enter a number to set a delay between adding or removing each user, rather than adding
them or subtracting them all at once. Staggering users avoids overloading the system,
which can cause connection timeouts. The User Load Preview shows this delay in black.
Settle Time
A system under test might react to a sudden change in user population. With a defined
settle time, which starts when the target number of users is reached, the system under test
can settle into a steady state so that it can accurately reflect the user population. The User
Load Preview shows this time in black.
Time limit for a user to respond to a stop request
Optionally enter a value. When a virtual user is asked to stop, it completes its current action
(such as an HTTP request) and then finishes. If a virtual user has not finished within the
specified time limit, the user is forced to finish.
User Load Preview
Previews the user population stages over time. The red line segments indicate that the total
number of users has been achieved for the state.

Think Time page
Use the recorded think time
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Select to play back a test at the same rate that it was recorded. This option has no effect on
the think time.
Specify a fixed think time
Each user's think time is exactly the same value: the value that you specify. Although this
does not emulate users accurately, it is useful if you want to play a test back quickly.
Increase/decrease the think time by a percentage
Type a percentage in Think time scale. Each user's think time is multiplied by that
percentage. A value of 100 causes no change in think times. A value of 200 doubles the
think times, so the schedule plays back half as fast as it was recorded. A value of 50
reduces the think times by half, so the schedule plays back twice as fast. A value of 0
indicates no delays.
Vary the think time by a random percentage
Each user's think time is randomly generated within the upper and lower bounds of the
percentages that you supply. The percentage is based on the recorded think time. For
example, if you enter 10 in Lower limit and enter 90 in Upper limit, the think times will be
between 10 percent and 90 percent of the original recorded think time. The random time is
uniformly distributed within this range.
Maximum think time
Setting a maximum think time is useful with tests that emulate actual think times. By setting
a maximum, you do not have to search for and edit each long think time within a test.
Numerous factors can generate long think times, for example, you might be interrupted
while recording. To restore the original think times, clear this check box.

Resource Monitoring page
Enable resource monitoring
Select to activate resource monitoring. The available data sources are captured from these
sources:
• Apache HTTP Server Managed Beans
• Apache Tomcat Managed Beans
• IBM® Tivoli® monitoring agents
• IBM® DB2® snapshot monitors
• The IBM® WebSphere® Performance Monitoring Infrastructure
• JBoss Application Server Managed Beans
• Java™ Virtual Machine Managed Beans
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• Oracle Database
• Oracle WebLogic Server Managed Beans
• SAP NetWeaver Managed Beans
• the UNIX™ rstatd monitor
• Simple Network Management Protocol (SNMP) agents
• Windows™ Performance Monitor
Resource monitoring data can provide a more complete view of a system to aid in problem
determination.
Ignore invalid resources when executing the schedule
Select this setting to suppress any error messages that invalid resources cause, such as
unreachable hosts or invalid host names. If you select this option, you must view logs to see
error messages.

Statistics page
Statistics log level
These options are listed in order of the increasing amount of data that they collect for the
test log.
None
Collects minimal statistical data. Use this option to run a schedule quickly for
testing purposes.
Schedule Actions
Reports the number of active and completed users in the run.
Primary Test Actions
For HTTP tests, this option reports page-related actions (attempts, hits, and
verification points). For SAP tests, this option reports information on SAP
screens.
Secondary Test Actions
For HTTP tests, this option reports information that is related to page
elements. This option does not apply to SAP tests.
All
Provides statistics for all actions.
Statistics sample interval
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Sets the sampling interval for reports. When you run a schedule, the reports show such
information as response time during a specific interval, the frequency of requests being
transferred during an interval, and the average response trend during an interval. You set this
sampling interval here.
Note: In Rational® Performance Tester V9.1.1 and later, during a test or schedule
run, the Elapsed Time value is updated every 5 seconds irrespective of a value set in the
Statistics sample interval field. You can view the Elapsed Time value that is changing in the
Run Summary section on the Performance Summary tab of the report.
Only store All Hosts statistics
Select this option unless you are running a performance test over different WANs, and you
are interested in seeing the data from each remote computer.

Variable Initialization
Use this page to initialize variables at the schedule level. When you initialize variables at the schedule
level, all the user groups in the schedule use the variable initial values, except those for which a specific
value is defined.
Add
Add a variable and initialize a value. The Used by column displays the test name that uses
the corresponding variable. A warning icon is displayed for a variable that overrides the
value specified at the schedule level or user group level and uses the value defined at the
test level with the visibility set to This test only. Hover the cursor over the warning icon to
view the tests that override the variable initial values.
Export
Export the variables defined at the schedule level to a file.
Use variable initial values file
Select this check box to use the variable values from a file. Click Browse to select an
existing file or click New to create a file.

Performance Requirements page
Enable Requirements
Select to enable the use of performance and functional requirements for this schedule.
Name
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Specifies the name of this set of requirements. This name is used in the Requirements
report. By default, the name is Performance Schedule -schedule_name.
Use Defaults
Click to reset Name to the default value.
Requirement
All the requirements are displayed in the table. Shaded requirements are not defined for this
schedule. To define a requirement, set an Operator and Value.
Expand the Custom section, and then double-click the row to add the counter information
generated by using the custom code to the requirement.
Operator
Click this field to display a list of mathematical operators. Select an operator for this
requirement.
Value
Click this field to set a value for the requirement.
Standard
Select to mark the requirement as standard. If a standard requirement is not met, the
schedule run will have a verdict of fail, and this verdict will roll up to the entire run, like
a verification point failure. Clear to make the requirement supplemental. In general,
supplemental requirements are those that are tracked internally. A supplemental
requirement cannot cause a run to fail, and its results are restricted to one page of the
Requirements report.
Hide Undefined Requirements
Select to see only the requirements that you have defined. This hides the shaded rows.
Clear
Select one or more requirements and click to remove the definition. The requirement is still
available and can be redefined.

Test Log page
The default setting, to log all errors and warnings and primary test actions, fits most purposes. However,
you can log any type of information, from no information to all information from all users, although neither
is typical.
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• To see only errors and warnings, set the first twoWhat to Log check boxes to All; then clear the
third check box, And also show all other types, to avoid logging successful events.
• To check the structure of a schedule, when you are not interested in the test execution results, set
all three What to Log check boxes to Schedule Actions.
Both choices and the default setting limit the size of the test log and reduce the total time to run
the schedule by significantly reducing the test log transfer time at the end of a test.
If you are debugging a test, you might set all three What to Log fields to All or Action Details. These
settings produce large test logs, especially if your tests are long or you are running a large number of
users. Large test logs, in turn, increase the test log transfer time, and might even cause your computer to
run out of disk space.
To reduce transfer times and the likelihood of running out of disk space, sample information from a
very small subset of users; smaller even than the default of 5 users per user group. A fixed sampling
rate samples the same number of virtual users from each group. A percentage sampling rate samples
a percentage of virtual users from each group, but guarantees that at least one user is sampled from a
group.

Response Time Breakdown page
Enable collection of response time data
Select to activate response time breakdown collection. This data shows you the response
time breakdown for each page element.
Detail level
Select Low or Medium to limit the amount of collected data.
Only sample information from a subset of users
If you set the detail level to High or Medium, set a sampling rate to prevent the log from
getting too large.
Fixed number of users
The number that you select is sampled from each user group. Unless you have specific
reasons to collect data from multiple users, select Fixed number of users, and specify one
user per user group.
Percentage of users
The percentage that you select is sampled from each user group, but at least one user is
sampled from each user group.
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Problem Determination page
Problem determination log level
In general, change the problem determination level only when asked to by IBM® Software
Support. However, under certain conditions, you might want to change the problem
determination level. For example, if problems occur when a run reaches a certain number of
users, you might increase the level to Config, which is the most detailed level to use without
consulting IBM® Software Support.
Only sample information from a subset of users
Select this option to set a sampling rate.
Fixed number of users
Specify the number of users to sample from each user group.
Percentage of users
The percentage that you select is sampled from each user group, but at least one user is
sampled from each group.

Related information
Setting user loads on page

User group properties
When you open a user group, you can set these properties.
Group size
Specifies either an absolute number of users, or a percentage of users, which you control
dynamically.

Locations
Run this group on the local computer
Indicates that the user group should be run on your computer.
Run this group at the following locations
Indicates that the user group should be run on one or more remote computers, at the
indicated locations. Typically, you run a user group at a remote location if you are running a
large number of virtual users.
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Options
Use the Options page to override the think time behavior of your schedule for a specific user group and to
specify protocol specific options.
Override think time option
Select this check box to specify a think time behavior for the current user group.
Use the recorded think time
Select to play back a test at the same rate that it was recorded. This option has no effect on
the think time.
Specify a fixed think time
Each user's think time is exactly the same value: the value that you specify. Although this
does not emulate users accurately, it is useful if you want to play a test back quickly.
Increase/decrease the think time by a percentage
Type a percentage in the Think time scale. Each user's think time is multiplied by that
percentage. A value of 100 causes no change in think times. A value of 200 doubles the
think times, so the schedule plays back half as fast as it was recorded. A value of 50
reduces the think times by half, so the schedule plays back twice as fast. A value of 0
indicates no delays.
Vary the think time by a random percentage
Each user's think time is randomly generated within the upper and lower bounds of the
percentages that you supply. The percentage is based on the recorded think time. For
example, if you select a Lower limit of 10 and an Upper limit of 90, the think times will be
between 10 percent and 90 percent of the original recorded think time. The random time is
uniformly distributed within this range.
Limit think times to a maximum value
Setting a maximum think time is useful with tests that emulate actual think times. By setting
a maximum, you do not have to search for and edit each long think time within a test, if, for
example, you are interrupted during recording. No think time used will be greater than the
maximum limit you set, even if you have chosen to vary the think time by a percentage that
would exceed this maximum. To restore the original think times, clear this box.
Protocol-specific options
Click Edit options to set protocol-specific options for all tests in the user group. These
settings override the protocol-specific options of the schedule.
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Variable Initialization
Use this page to initialize variables at the user group level. When you initialize variables at the user group
level, all the tests in the user group use the variables. If the same variable is defined at the schedule level,
precedence is given to the variable at the user group level.
Add
Add a variable and initialize a value. The Used by column displays the test name that uses
the corresponding variable. A warning icon is displayed for a variable that override the value
specified at the schedule level or user group level and uses the value defined at the test level
with the visibility set to This test only. Hover the cursor over the warning icon to view the
tests that overrides the variable initial values.
Export
Export the variables defined at the user group level to a file.
Use variable initial values file
Select this check box to use the variable values from a file. Click Browse to select an
existing file or click New to create a file.

Related information
User group overview on page

Generic service client references
Read these reference topics for Generic service client.

Generic service client call details
In the generic service client, service calls contain the content and the transport information for the call.
The contents are made of the SOAP envelope. The transport information refers to the information that is
required to send and receive and answer depending on the selected protocol.

Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form
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This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.
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Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
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URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
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SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Request Stack
Use this page to specify the stack that applies security and addressing parameters and algorithms to
service requests before they are sent. Stacks are a set of algorithms that are executed in a given order.
Use the WSDL security editor to define a stack for each WSDL. The stack will be applied to all requests
that use the WSDL.
Override stack
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By default, you edit a stack which attached to a specific WSDL file in the WSDL security
editor. Select this option to specify a different security algorithm stack only for the current
service request.
Show response stack
The Request Stack page contains algorithms that are applied only to outgoing service
requests. Select Show response stack to add a Response Stack page. The Response Stack
page allows you to edit security and addressing parameters and algorithms that are applied
to incoming responses.
Security Algorithm Details
Click Add, Insert, or Remove to add or remove security algorithms in the stack. Click Up
and Down to change the order of a selected algorithm in the security stack. The following
security algorithms can be added to the security stack:
Static XML Headers
Use this algorithm to add the XML headers that are required for web service
standard calls. On the Header bar, click Add ( ) to create the default
XML header structure for WS-Addressing, WS-ReliableMessaging or WSCoordination requests, or click More for other standards.
You can enable or disable XML elements in the Header section and specify the
correct values for each XML element. Checks are performed to ensure that the
XML headers are valid.
Note: The Static XML Headers algorithm is available only in IBM®
Security AppScan®. To add static XML headers to calls in other products,
expand the Headers section on the Message tab of the request.
Time Stamp
The time stamp security algorithm adds time stamp information to the XML
document in the response. For details on security algorithms, refer to the web
service security specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
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Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Expiration delay
Specify the delay after which the time stamp expires.
Millisecond precision
Select this option to produce a time stamp that uses millisecond
precision instead of the default (1/100th second).
User name token
The user name token security algorithm adds a user name token to the XML
document in the message. For details on security algorithms, refer to the web
service security specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Name
Type the name of the user.
Password
Type the password of the user.
Password type
Specify the password type for the security algorithm as defined
in the Web Services Security UsernameToken profile.
Use nonce
Select this check box to add the Nonce element to the User
Name Token XML code. In most cases, the Nonce ID is required.
Use created
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Select this check box to add current timestamp to the Created
XML element in the User Name Token XML.
XML Encryption
The XML encryption security algorithm specifies how the XML document is
encrypted. For details on security algorithms, refer to the web service security
specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Identifier type
Select the type of key identifier to be used for the encryption.
The following key identifiers are available, as defined in the Web
Services Security (WSS) specification X509 profile and the OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• SKI_KEY_IDENTIFIER
• EMBEDDED_KEYNAME
• THUMBPRINT_IDENTIFIER
• ENCRYPTED_KEY_SHA1_IDENTIFIER
User XPath part selection
This enables you to specify an XPath query that describes parts
of the XML document that can be subjects of the algorithm. By
default, the body is the subject.
Key
Select the key used for the encryption. The details of each key
vary.
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• x509 key: This specifies the name and password of the
x509 key and the keystore where it is located.
• Raw key: This specifies the name and the byte value of
your SecretKey in hexadecimal.
• Encrypted key: This specifies a reference to an encrypted
key that was previously defined in the security stack. Click
Insert a new encrypted key to create a new encrypted key
definition block.
Encoding Algorithm Name
Specify the encryption method to be used as defined in the XML
Encryption Syntax and Processing specification.
Key Encoding Algorithm
Specify the standard algorithm for encoding the key as defined in
the XML Encryption Syntax and Processing specification.
XML Signature
The XML signature security algorithm specifies how the XML document is
signed. For details on security algorithms, refer to the web service security
specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Security token
Select the type of key identifier to be used for the signature. The
following key identifiers are available, as defined in the the Web
Service Security (WSS) specification X509 profile and OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
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• SKI_KEY_IDENTIFIER
• KEY_VALUE
• USER_NAME_TOKEN
• CUSTOM_SYMM_SIGNATURE
In addition, the following identifiers are available when the
signature is based on a UsernameToken profile:
• USER_NAME_TOKEN
• CUSTOM_SYMM_SIGNATURE
User XPath part selection
Specify an XPath query that describes parts of the XML
document that can be the subjects of the algorithm. By default,
the body is the subject. Click the XPath Helper button to build the
Xpath expression.
Key
Select the key used for the encryption. The details of each key
vary.
• x509 key: This key specifies the name and password of
the x509 key and the keystore where it is located.
• User name token key: This specifies a user name and
password for the signature.
• Encrypted key: This specifies a reference to an encrypted
key that was previously defined in the security stack. Click
Insert a new encrypted key to create a new encrypted key
definition block.
Signature algorithm name
Specify the signature method algorithm as described in the XML
Signature Syntax and Processing specification.
Canonicalization
Specify the canonicalization method to be used as described in
the XML Signature Syntax and Processing specification.
Digest algorithm method
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Specify which digest method to be used based on the algorithm
method used on the server side.
Inclusive namespaces
Specify whether the canonicalization is exclusive as described in
the Exclusive XML Canonicalization specification.
Encrypted Key
This block defines an encrypted key that can be used in an XML signature or
XML encryption block. The encrypted key block must be before a block that
uses the encrypted key.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Key name
Specify the name of the encrypted key.
Identifier type
Select the type of key identifier to be used for the key. The
following key identifiers are available, as defined in the the Web
Service Security (WSS) specification X509 profile and OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• THUMBPRINT_IDENTIFIER
• SKI_KEY_IDENTIFIER
Key size
Specify the size of the key in bits.
Key encoding algorithm name
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Specify the algorithm to be used for encoding the key.
Keystore
Select a keystore or click Edit Security to define a new keystore
or to manage the existing keystores.
Name
Select a key contained in the specified keystore.
Password
Type the password for the selected key name.
Custom Security Algorithm
If you want to use a Java™ class as a custom security algorithm, then use this
stack element to apply the custom algorithm to the service.
Java™ Project
If you have not implemented a custom Java™ class, select Java
Project, type a name for the new project, and click Generate to
create a new Java™ class with the default structure for custom
security implementations.
Note: If you are using IBM® Security AppScan®, this field is
not available.
Implementation class
Specify the name of the class that implements the custom
security algorithm. Click Browse Class to select an existing
Java™ class from the workspace.
Properties
Use this table to send any specific properties and associated
values to the custom security algorithm.
WS-Addressing Algorithm
Use this block if your service uses either WS-Addressing 2004/08 or the WSAddressing 1.0 Core standard.
Namespace
Specify the namespace for either WS-Addressing 2004/08 or
WS-Addressing 1.0 Core.

288

Chapter 1. Reference Guide

Action if request uses WS-Addressing
Select the action to complete if WS-Addressing is already in the
request.
Replace anonymous address in Reply-to with:
Select this option to generate the specified address in the Replyto header instead of an anonymous address.
Remove WS-Addressing from response
Select this option to strip any WS-Addressing headers from the
response.
WS-Policy Algorithm
Use this block if your service requires a security policy file compliant with the
WS-Policy specification.
Use policy included in WSDL (WS-PolicyAttachment)
Select this option to use the security policy configuration
that is attached to the WSDL as in the WS-PolicyAttachment
specification.
Policy
If you are not using the WS-PolicyAttachment specification,
specify the XML policy file. Click Browse to add a policy file from
the workspace or to import a policy file.
Signature configuration
Select this option to specify a keystore for any signature that is
specified in the policy. Click Edit Security to add a keystore from
the workspace or to import a keystore.
Encryption configuration
Select this option to specify a keystore for any encryption that is
specified in the policy. Click Edit Security to add a keystore from
the workspace or to import a keystore.
Decryption configuration
Select this option to specify a keystore for any decryption that is
specified in the policy. Click Edit Security to add a keystore from
the workspace or to import a keystore.
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Retrieve token from security token server (WS-Trust and WSSecureConversation)
Select this option, and click Configure to specify a Security
Token Server (STS) to use with the policy.
Additional properties
Use this table to specify settings for the advanced properties or
specific implementations of the WS-Security specification. Click
Add to add a property name and to set a value.

Response Stack
Use this page to specify the stack that applies security and addressing parameters to responses after
they are received. Stacks are a set of algorithms that are executed in a given order. Use the WSDL security
editor to define a stack for each WSDL. The stack will be applied to all requests that use the WSDL.
Override stack
By default, you edit the security algorithm stack attached to a specific WSDL file in the
WSDL Security Editor. Select this option to specify a different security algorithm stack only
for the current response.
Show response stack
Clear the Show response stack option to hide the Response Stack page.
Security Algorithm Details
Click Add, Insert, or Remove to add or remove security algorithms in the stack. Click Up
and Down to change the order of a selected algorithm in the security stack. The following
security algorithms can be added to the security stack:
XML Encryption
The XML encryption security algorithm specifies how the XML document is
encrypted. For details on security algorithms, refer to the web service security
specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
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Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Identifier type
Select the type of key identifier to be used for the encryption.
The following key identifiers are available, as defined in the Web
Services Security (WSS) specification X509 profile and the OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• SKI_KEY_IDENTIFIER
• EMBEDDED_KEYNAME
• THUMBPRINT_IDENTIFIER
• ENCRYPTED_KEY_SHA1_IDENTIFIER
User XPath part selection
This enables you to specify an XPath query that describes parts
of the XML document that can be subjects of the algorithm. By
default, the body is the subject.
Key
Select the key used for the encryption. The details of each key
vary.
• x509 key: This specifies the name and password of the
x509 key and the keystore where it is located.
• Raw key: This specifies the name and the byte value of
your SecretKey in hexadecimal.
• Encrypted key: This specifies a reference to an encrypted
key that was previously defined in the security stack. Click
Insert a new encrypted key to create a new encrypted key
definition block.
Encoding Algorithm Name
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Specify the encryption method to be used as defined in the XML
Encryption Syntax and Processing specification.
Key Encoding Algorithm
Specify the standard algorithm for encoding the key as defined in
the XML Encryption Syntax and Processing specification.
Encrypted Key
This block defines an encrypted key that can be used in an XML signature or
XML encryption block. The encrypted key block must be before a block that
uses the encrypted key.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Key name
Specify the name of the encrypted key.
Identifier type
Select the type of key identifier to be used for the key. The
following key identifiers are available, as defined in the the Web
Service Security (WSS) specification X509 profile and OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• THUMBPRINT_IDENTIFIER
• SKI_KEY_IDENTIFIER
Key size
Specify the size of the key in bits.
Key encoding algorithm name
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Specify the algorithm to be used for encoding the key.
Keystore
Select a keystore or click Edit Security to define a new keystore
or to manage the existing keystores.
Name
Select a key contained in the specified keystore.
Password
Type the password for the selected key name.
Custom Security Algorithm
If you want to use a Java™ class as a custom security algorithm, then use this
stack element to apply the custom algorithm to the service.
Java™ Project
If you have not implemented a custom Java™ class, select Java
Project, type a name for the new project, and click Generate to
create a new Java™ class with the default structure for custom
security implementations.
Note: If you are using IBM® Security AppScan®, this field is
not available.
Implementation class
Specify the name of the class that implements the custom
security algorithm. Click Browse Class to select an existing
Java™ class from the workspace.
Properties
Use this table to send any specific properties and associated
values to the custom security algorithm.

Generic service client binary call details
In the generic service client, binary calls are specialized calls for sending binary messages. The transport
information refers to the information that is required to send and receive and answer depending on the
selected protocol.
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Message
Update node name automatically
Select this option to automatically rename the request in the Test Contents view.
Do not wait for response
Select this option to skip directly to the next request in the test after the current request is
sent.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
Update Response
Click this button to invoke the request with the current settings and to use the response to
create a binary response element or to update the existing response element.
Source
This page presents the binary contents of the request and provides access to data
correlation. The same contents are presented in Binary and Raw ASCII views.
Attachments
This page lists the MIME or DIME attachments that are attached to the request. The
contents of this view conform to the Multipurpose Internet Mail Extensions (MIME) or
Direct Internet Message Encapsulation (DIME) specification. You can use this page to add
workbench resources as MIME or DIME attachments and change properties.
Transport
This page covers the transport protocol used to send the request. The transport protocol
can be either HTTP, Java™ Message Service (JMS), or WebSphere® MQ. You can create
several configurations for each protocol so that you can easily switch protocols or variants
of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is
available.
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Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
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URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
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SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Generic service client text call details
In the generic service client, text calls are specialized calls for sending text messages. The transport
information refers to the information that is required to send and receive and answer depending on the
selected protocol.
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Message
Update node name automatically
Select this option to automatically rename the request in the Test Contents view.
Do not wait for response
Select this option to skip directly to the next request in the test after the current request is
sent.
Time Out (ms)
This is the timeout value in milliseconds. If no response is received after the specified time,
an error is produced.
Think Time (ms)
This specifies the programmatically calculated time delay that is observed for each user
when this test is run with multiple virtual users. Think time is a statistical emulation of the
amount of time actual users spend reading or thinking before performing an action.
Update Response
Click this button to invoke the request with the current settings and to use the response to
create a binary response element or to update the existing response element.
Source
This page presents the binary contents of the request and provides access to data
correlation. The same contents are presented in Binary and Raw ASCII views.
Attachments
This page lists the MIME or DIME attachments that are attached to the request. The
contents of this view conform to the Multipurpose Internet Mail Extensions (MIME) or
Direct Internet Message Encapsulation (DIME) specification. You can use this page to add
workbench resources as MIME or DIME attachments and change properties.
Transport
This page covers the transport protocol used to send the request. The transport protocol
can be either HTTP, Java™ Message Service (JMS), or WebSphere® MQ. You can create
several configurations for each protocol so that you can easily switch protocols or variants
of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is
available.
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Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Transport
This page covers the transport settings used to send the request. The transport protocol settings apply
to a transport configuration, which can be either HTTP, Java™ Message Service (JMS), WebSphere® MQ,
or Microsoft .NET. You can create several configurations for each protocol so that you can easily switch
protocols or variants of protocols.
Note: If you are using IBM® Security AppScan®,only the HTTP transport protocol is available.
HTTP
Select HTTP to use the HTTP transport for the request. At the request level, you can update
a URL or SOAP action and the reference to the global configuration of a test.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. HTTP transport configurations contain proxy and authentication
settings that can be reused.
URL
Specify the URL end point of the service request.
Rest mode
Use this check box to split the REST URL so that it is easy to understand the
different parts of REST URL. When you use this option, the main section of
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URL is placed in the URL field, the resource part is placed in the Resource field,
and the parameters are placed in the Parameters field. Use the Add button to
manually add more parameters.
Method
Specify the HTTP method to be used to invoke the service request.
Headers
Specify the names and values of any custom HTTP headers that are required
by the service. Click Add, Edit or Remove to modify the headers list.
Cookies
Specify the names and values of any cookies that are required by the service.
Click Add, Edit or Remove to modify the cookies list.
JMS
Select JMS to use the Java™ Messaging Service transport for the request. This
page enables you to add string properties that are attached to the request for a JMS
configuration. These will be sent as message properties through JMS.
Protocol configuration
Click Change to specify a predefined transport configuration or to create
a configuration. JMS transport configurations contain generic end point,
reception point, and adapter settings that can be reused.
Properties
Specify the names and values of any string properties that are required by
the request for the current JMS transport configuration. These are sent as
message properties through JMS. Click Add, Edit or Remove to modify the
properties list.
WebSphere® MQ
Select MQ to use the IBM® WebSphere® MQ transport for the request. This page enables
you to specify the SOAP action and override the settings for the WebSphere® MQ
configuration selected at the test level.
Protocol configuration
Click Change to specify a predefined transport configuration or to create a
configuration. WebSphere® MQ transport configurations contain generic
queue, header, and SSL settings that can be reused.
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SOAP Action
Specifies the SOAP action to be used to invoke the WebSphere® MQ request.
Override MQ protocol configuration values
Select this option to configure the fields of the WebSphere® MQ message. You
can replace a subset of an MQ message descriptor with a custom format for
use with other server types, specifically when using an XML message request.
Customize message header
Select this option to specify custom headers for the transport for
the SOAP over MQ feature that is provided by WebSphere® MQ.
This feature uses a predetermined MQ message format (RFH2),
therefore, when selected, other Message Descriptor options are
disabled.
Message descriptor
These settings replace the message descriptor and header
settings of the MQ protocol configuration. Refer to WebSphere®
MQ documentation for information about message descriptors.
Microsoft™ .NET
Select Microsoft .NET to use the Microsoft .NET Framework transport for requests based
on Windows™ Communication Foundation (WCF). This page enables you to override the
settings for the Microsoft™ .NET configuration selected at the test level.
Item
Click Add to specify the name and value of the WCF actions that are required
by the service. This table is automatically generated when you import a
Microsoft .NET WSDL file. Refer to the Microsoft™ .NET WCF documentation
for more information.

Generic service client message return details
In the generic service client, message returns are generated after a service call is successfully invoked.
Message returns display the content returned by the service.
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Message
This page shows the XML content of the request and provides access to data correlation. The same
content is presented in three different ways.
Form
This view provides a simplified view of the message that focuses on editing the values of
the XML content. Use the Schema menu to enable assistance with editing XML content so
that the XML is valid and complies with the XSD specification.
In the Form view, add the XML headers that are required for standard web service calls. On
the Header bar, click Add ( ) to create the default XML header structure for WS-Addressing,
WS-ReliableMessaging or WS-Coordination requests, or click More for other standards. You
can enable or disable XML header elements and specify the correct values for each XML
element. Checks are performed to ensure that the XML content is valid.
Note: To add XML headers to calls in IBM® Security AppScan®, add a Static XML
Headers algorithm on the Request Stack tab of the request.
Tree
This view provides a hierarchical view of the XML structure of the message, including
elements, namespaces, and the associated values. You can use Add, Insert, Remove, Up,
and Down to edit the XML elements and namespaces in the tree.
Use Skip if Empty column to select the empty XML elements that you want to skip. This
column is visible only if you selected the Display the 'Skip if Empty' column in XML tree
viewer check box in Window > Preferences > Test > Test editor > Service test.
Click Filter to hide or show namespace, attribute, or text nodes, depending on your
requirements.
Click Allow only valid modifications to enable smart editing, based on a specified XML
schema document (XSD). To specify a set of XSD documents for the workbench, in the test
navigator, right-click the project and select Properties and Schema Catalog. Disable Allow
only valid modifications if you do not have an XSD or if you want to bypass the schema.
You can right-click an XML element to convert it to an XML fragment. This enables you to
perform data correlation (use datasets and create references) on the entire XML fragment
instead of only on the value.
Source
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This view displays the source XML content of the message or plain text content. To format
XML content, click Format XML text. To wrap XML content into a single line, click Pack XML
text to single line. Similar controls are available for JSON content.
Important: In the Source view, do not edit the tags that start with SoaTag. If you delete or
change these tags, any references and substitutions in the test will be broken. You cannot
recreate these tags after you delete them.

Attachments
This page lists the MIME or DIME attachments that are attached to the request. The contents of this view
conform to the Multipurpose Internet Mail Extensions (MIME) or Direct Internet Message Encapsulation
(DIME) specification. You can use this page to add workbench resources as MIME or DIME attachments
and change properties.
The Content ID is the identifier that the request uses to refer to the attachments. The method for using
this identifier depends on your server requirements.
MIME or DIME
Select whether the attachment conforms to the Multipurpose Internet Mail Extensions
(MIME) or Direct Internet Message Encapsulation (DIME) specification
Use MTOM transmission mechanism
By default, the request uses SOAP Messages with Attachments (SwA) to handle
attachments. Select this option to handle attachments with the SOAP Message
Transmission Optimization Mechanism (MTOM).

Response Properties
This page lists the names and values of properties of the response.

WSDL security editor reference
With the Web Service Description Language (WSDL) security editor you can create and edit security
configurations for a WSDL file.

Keystores
In this page, you can edit the keystores that are used for the WSDL file. The keystore contains the public
and private keys that are required for the specified security protocol.
Defined Keystores
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Click Add or Remove to add or remove keystore files from the workbench.
Keystore Details
This specifies the location and file name of the selected keystore. Click Browse to select a
different file.
Name
This specifies the name of the keystore. This name is used throughout the test
instead of the file name.
File
Click Browse to specify a keystore file containing a valid server certificate. The
following formats are supported:
• KS
• JKS
• JCEKS
• PKCS12 (p12 or PFX)
• PEM
Password
If the keystore file is encrypted, type the required password.

Security Stacks
In this page you can edit the security algorithm stacks that the security protocol uses. Security stacks are
a set of algorithms that are executed in a given order.
Security Stacks
Click Add, Remove, or Rename to add, remove, or rename the security stacks that are
associated with the WSDL file.
Security Algorithm Details
Click Add, Insert, or Remove to add or remove security algorithms in the stack. Click Up
and Down to change the order of a selected algorithm in the security stack. The following
security algorithms can be added to the security stack:
Time Stamp
The time stamp security algorithm adds time stamp information to the XML
document in the response. For details on security algorithms, refer to the web
service security specification.
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Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Expiration delay
Specify the delay after which the time stamp expires.
Millisecond precision
Select this option to produce a time stamp that uses millisecond
precision instead of the default (1/100th second).
User name token
The user name token security algorithm adds a user name token to the XML
document in the message. For details on security algorithms, refer to the web
service security specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Name
Type the name of the user.
Password
Type the password of the user.
Password type
Specify the password type for the security algorithm as defined
in the Web Services Security UsernameToken profile.
Use nonce
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Select this check box to add the Nonce element to the User
Name Token XML code. In most cases, the Nonce ID is required.
Use created
Select this check box to add current timestamp to the Created
XML element in the User Name Token XML.
XML Encryption
The XML encryption security algorithm specifies how the XML document is
encrypted. For details on security algorithms, refer to the web service security
specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Identifier type
Select the type of key identifier to be used for the encryption.
The following key identifiers are available, as defined in the Web
Services Security (WSS) specification X509 profile and the OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• SKI_KEY_IDENTIFIER
• EMBEDDED_KEYNAME
• THUMBPRINT_IDENTIFIER
• ENCRYPTED_KEY_SHA1_IDENTIFIER
User XPath part selection
This enables you to specify an XPath query that describes parts
of the XML document that can be subjects of the algorithm. By
default, the body is the subject.
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Key
Select the key used for the encryption. The details of each key
vary.
• x509 key: This specifies the name and password of the
x509 key and the keystore where it is located.
• Raw key: This specifies the name and the byte value of
your SecretKey in hexadecimal.
• Encrypted key: This specifies a reference to an encrypted
key that was previously defined in the security stack. Click
Insert a new encrypted key to create a new encrypted key
definition block.
Encoding Algorithm Name
Specify the encryption method to be used as defined in the XML
Encryption Syntax and Processing specification.
Key Encoding Algorithm
Specify the standard algorithm for encoding the key as defined in
the XML Encryption Syntax and Processing specification.
XML Signature
The XML signature security algorithm specifies how the XML document is
signed. For details on security algorithms, refer to the web service security
specification.
Actor / Role name
Specify the name of the recipient of the algorithm header
element, if required.
Must understand
Select whether it is mandatory that the algorithm header is
processed by the recipient, if required. The recipient is either the
Actor name or the server.
Security token
Select the type of key identifier to be used for the signature. The
following key identifiers are available, as defined in the the Web
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Service Security (WSS) specification X509 profile and OASIS
WSS 1.1 specification:
• ISSUER_SERIAL
• BST_DIRECT_REFERENCE
• X509_KEY_IDENTIFIER
• SKI_KEY_IDENTIFIER
• KEY_VALUE
• USER_NAME_TOKEN
• CUSTOM_SYMM_SIGNATURE
In addition, the following identifiers are available when the
signature is based on a UsernameToken profile:
• USER_NAME_TOKEN
• CUSTOM_SYMM_SIGNATURE
User XPath part selection
Specify an XPath query that describes parts of the XML
document that can be the subjects of the algorithm. By default,
the body is the subject. Click the XPath Helper button to build the
Xpath expression.
Key
Select the key used for the encryption. The details of each key
vary.
• x509 key: This key specifies the name and password of
the x509 key and the keystore where it is located.
• User name token key: This specifies a user name and
password for the signature.
• Encrypted key: This specifies a reference to an encrypted
key that was previously defined in the security stack. Click
Insert a new encrypted key to create a new encrypted key
definition block.
Signature algorithm name
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Specify the signature method algorithm as described in the XML
Signature Syntax and Processing specification.
Canonicalization
Specify the canonicalization method to be used as described in
the XML Signature Syntax and Processing specification.
Digest algorithm method
Specify which digest method to be used based on the algorithm
method used on the server side.
Inclusive namespaces
Specify whether the canonicalization is exclusive as described in
the Exclusive XML Canonicalization specification.
Custom Security Algorithm
If you want to use a Java™ class as a custom security algorithm, then use this
stack element to apply the custom algorithm to the service.
Java™ Project
If you have not implemented a custom Java™ class, select Java
Project, type a name for the new project, and click Generate to
create a new Java™ class with the default structure for custom
security implementations.
Note: If you are using IBM® Security AppScan®, this field is
not available.
Implementation class
Specify the name of the class that implements the custom
security algorithm. Click Browse Class to select an existing
Java™ class from the workspace.
Properties
Use this table to send any specific properties and associated
values to the custom security algorithm.
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publication at any time without notice.
Any references in this information to non-IBM® websites are provided for convenience only and do not in
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This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM®, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform
for which the sample programs are written. These examples have not been thoroughly tested under
all conditions. IBM®, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM® shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work must include a copyright
notice as follows:
© (your company name) (year).
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2000, 2017.

Trademarks
IBM®, the IBM® logo, and ibm.com® are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM® or other companies. A current list of IBM® trademarks is available on the web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM® website.

Personal use
You may reproduce these publications for your personal, noncommercial use provided that all proprietary
notices are preserved. You may not distribute, display or make derivative work of these publications, or
any portion thereof, without the express consent of IBM®.

Commercial use
You may reproduce, distribute and display these publications solely within your enterprise provided that all
proprietary notices are preserved. You may not make derivative works of these publications, or reproduce,

312

Chapter 2. Notices

distribute or display these publications or any portion thereof outside your enterprise, without the express
consent of IBM®.

Rights
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identifiable information, specific information about this offering use of cookies is set forth below.
This Software Offering does not use cookies or other technologies to collect personally identifiable
information.
If the configurations deployed for this Software Offering provide you as customer the ability to collect
personally identifiable information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
notice and consent.
For more information about the use of various technologies, including cookies, for these purposes,
see IBM's Privacy Policy at http://www.ibm.com/privacy and IBM's Online Privacy Statement at http://
www.ibm.com/privacy/details in the section entitled Cookies, Web Beacons and Other Technologies,
and the IBM Software Products and Software-as-a-Service Privacy Statement at http://www.ibm.com/
software/info/product-privacy.
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